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Chapter 1   New Features in NanoScope 
Software
1.1 New Features in NanoScope v8.10 Software

• MultiMode microscope support. See the MultiMode V Instruction Manual NanoScope 
Software v 8, Bruker p/n 004-1033-000 for details.

• ScanAsyst™ mode. Refer to your BioScope Catalyst, Dimension Icon or MultiMode 8 
Instruction Manual for details.

• PeakForce™ QNM™ mode. Refer to the PeakForce QNM User Guide, Bruker p/n 004-
1036-000, for details.

• Peak Force Tapping™ mode.

• NanoScope Data Analysis package.

• Adaptive XY scanning.

• Revised GUI.

• AutoScale function. See Page 108.

1.2 New Features in NanoScope v8.00 Software

• New workflow-oriented GUI.

• Dimension Icon and Dimension Icon-PI microscope support.

• BioScope Catalyst microscope support.

• NanoScope V-PI Controller support.

• Crash protection.

• Workspaces created before NanoScope version 8.00 can not be opened in NanoScope 
version 8.00. See Older Workspaces Unsupported in NanoScope v7.30 and later: 
Section 2.4.2.
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1.3 New Features in NanoScope v7.30 Software

• Harmonic Force Microscopy (HarmoniX)—optional. See the HarmoniX User Guide, 
Bruker p/n 004-1024-000 for details.

• Offline Modify command Clean Image function. See Clean Image: Section 7.2.

• Offline Modify command Guassian function. See Gaussian: Section 7.6.

• Dimension Heater/Cooler Support. See Support Note 441, Dimension Heater/Cooler.

• Closed Loop Force Volume. See Page 146.

• 5K x 5K image is available on all 8 channels.

• Starting with NanoScope 7.30, older workspaces are not supported. See Older 
Workspaces Unsupported in NanoScope v7.30 and later: Section 2.4.2.

• Dark Lift. See Application Modules NanoScope Software Version 7, Rev. B or later, 
Bruker p/n 004-1020-000.

1.4 New Features in NanoScope v7.20r1sr1 Software

• EnviroScope STM and Electrochemistry support. See the EnviroScope Using a 
NanoScope V Controller Instruction Manual, Bruker part number 004-1008-000 and the 
Electrochemical SPM NanoScope Software v7 manual, Bruker part number 004-1016-
000.

• TR TUNA. See the Applications Modules NanoScope Software v7 manual, Bruker part 
number 004-1020-000.

• Piezo Response improvements. See Piezoresponse Atomic Force Microscopy Using a 
NanoScope V Controller User Guide, Bruker part number 013-444-000 and the   
NanoScope V Controller Manual, Bruker part number 004-992-000, Revision E or later.

• MultiMode Closed Loop XYZ. See MultiMode Closed Loop Scanner, Bruker Support 
Note 013-431-000.

• Many other smaller features and bugs fixed. See the Research 7.20 Release Notes.
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1.5 New Features in NanoScope v7.20r1 Software

1.5.1 Newly Supported Hardware

NanoScope v7.20r1 supports additional hardware. This includes:

• EnviroScope using a NanoScope V Controller.

• BioScope (SZ) using a NanoScope V Controller.

• MS10 dedicated STM.

• Serial communication for the Universal Bipotentiostat

See the appropriate manuals, EnviroScope Manual, BioScope SZ Instruction Manual, Scanning 
Tunneling Microscope Operation Manual and Universal Bipotentiostat for details.

1.5.2 Additional New Features

Additional new features, described in the NanoScope v7.20 release notes. These include:

• Pulse Counting

• Improved Width Offline function

• Spectrum 2D

• Nanoindentation

• Piezo response imaging. See the NanoScope V Controller Manual for information about 
this mode.

• Torsion TUNA (Tunneling Atomic Force Microscopy) imaging. See the Applications 
Modules NanoScope Software v7 Manual and Support Note 416, Revision H or later, 
TRmode NanoScope Version 7 for information about this mode.

• Offline feature ROUGHNESS revised.
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1.6 New Features in NanoScope v7.10 Software

1.6.1 Newly Supported Hardware

NanoScope v7.10 supports additional hardware. This includes:

• Dimension 5000 microscope.

See the appropriate manual, Dimension 5000 using a NanoScope V Controller Instruction Manual 
for details.

1.6.2 Additional New Features

Additional new features, described in the NanoScope v7.10 release notes. These include:

• Recipes

• CROP AND SPLIT Offline View replaces ZOOM

• XY to Z Coupling with Ramp mode

• TIFF Export

1.7 New Features in NanoScope v7.00 Software

1.7.1 Newly Supported Hardware

NanoScope v7.0 supports new hardware. This includes:

• NanoScope V Controller.

• BioScope II.

See the appropriate manuals, NanoScope V Controller Manual, and BioScope II User Manual for 
details.

1.7.2 Windows XP Support

NanoScope v7.0 runs on Windows XP.
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1.7.3 Additional New Features

Additional new features, described in the NanoScope v7.0 release notes and the NanoScope V 
Controller Manual, are included in this manual. These include:

• Eight channel support.

• High resolution imaging.

• Signal Access Software.

• Surface Potential Detection

• Generic Lock-In

• High Speed Data Capture

• Force Volume.
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Chapter 2   Getting Started with 
NanoScope v8.10 Software
The focus of this manual is the NanoScope software version 8. It is a reference to the tasks related 
to your NanoScope system. The material provides an overview (i.e., theory and applications), 
procedures, interface definitions and optimization tips.

Refer to the following sections to begin to understand the NanoScope software:

• Conventions and Definitions: Section 2.1

• Installing the NanoScope Software: Section 2.2

• Getting to Know NanoScope Software: Section 2.3

• NanoScope Version 8 Workspaces Section 2.4

• Quick Guide to an Image: Section 2.5

• Technical Support at Bruker: Section 2.6
Rev. D NanoScope Software 8.10 User Guide 7



Getting Started with NanoScope v8.10 Software
Conventions and Definitions

8

2.1 Conventions and Definitions

• In the interest of clarity, certain nomenclature is preferred. An SPM probe is comprised 
of a tip affixed to a cantilever mounted on a substrate, which is inserted in a probe 
holder.

• Three font styles distinguish among contexts. For example:
Window or Menu Item / BUTTON OR PARAMETER NAME is set to VALUE. 

• NSV is used to refer to a NanoScope V Controller. NSV-PI is used to refer to a 
NanoScope V-PI Controller.

2.2 Installing the NanoScope Software

2.2.1 System Requirements

The 8.0 version of NanoScope software requires the following:

• A minimum computer configuration of a Quad Core 2.4GHz CPU or a Dual Core 
2.0GHz CPU (NanoScope V-PI Controller)

• 4GB RAM

• GeForce 8600GT or 9400GT 512MB video card

2.2.2 Before You Install

1. If you are upgrading from a previous version of NanoScope, ensure you are starting with a 
working version. The settings from the working version will be used for the new version.

2. Note that some of the installation screen views may not appear, or may appear slightly 
different, depending on your particular system configuration.

3. Ensure you are logged in as Administrator on the local workstation.

CAUTION: Contact Bruker Technical Support (see Contact Information Section 
2.6.2) before attempting to increase the RAM of your system. Failure 
to do so could cause irreparable damage to your system.

CAUTION: Ensure you have backed up all critical data onto external media before 
installing the NanoScope 8.00 software.
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2.2.3 NanoScope 8.00 Installation

Note: Most systems are configured on the microscopes prior to delivery.

1. Insert the NanoScope 8.00 CD-ROM in your CD drive, open the CD-ROM files, open the 
v8.00 folder, and select the Setup.exe icon. NanoScope V-PI users will need to append the 
argument “- InstallNSVLite” to the install command.

If you do not have Administrator privileges on your workstation, a WARNING will appear on the 
screen and installation will discontinue (see Figure 2.2a).

Figure 2.2a   Administrator Warning

2. If you have an existing instance of NanoScope software, the message shown in Figure 2.2b 
will appear. Check the appropriate radio button and click NEXT.

Figure 2.2b   Welcome to NanoScope 8 Dialog Box
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3. The Welcome to the InstallShield Wizard for NanoScope 8.10 dialog box will open (see 
Figure 2.2c). Click NEXT.

Figure 2.2c   Welcome to NanoScope 8 Dialog Box

4. After accepting the license agreement, the Installation Type dialog box will open (see 
Figure 2.2d). Click NEXT.

Figure 2.2d   Installation Type Dialog Box

5. Select STANDARD and click NEXT.
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Installing the NanoScope Software
6. Install Shield then checks your system and, if needed, makes recommendations. See Figure 
2.2e.

Figure 2.2e   System Information and Recommendations Dialog Box

7. Click NEXT.

8. After choosing a destination location (see Figure 2.2f), click NEXT.

Figure 2.2f   Destination Location Dialog Box
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9. Select the features you wish to install (see Figure 2.2g) and click NEXT.

Figure 2.2g   Select Features Dialog Box

10. The Ready to Install dialog box will display:

Figure 2.2h   Ready to Install Dialog Box
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11. Click INSTALL. Installation of the NanoScope V8.00 software will then continue. A progress 
box, shown in Figure 2.2i, appears:

Figure 2.2i   Progress Dialog Box 

12. Click Yes to import setting, including calibration files from an existing NanoScope software 
installation. See Figure 2.2j.

Figure 2.2j   Import settings dialog box
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13. When the NanoScope V8.10 installation is complete, the dialog box shown in Figure 2.2k 
will appear.

Figure 2.2k   Installation Complete Dialog Box

14. Click FINISH to complete the installation.
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2.3 Getting to Know NanoScope Software

Start the NanoScope software by double-clicking on the desktop shortcut labeled NanoScope 8.10.

2.3.1 Software Interface

NanoScope version 8 software is organized by experiment type. Click EXPERIMENT > SELECT 
EXPERIMENT or the SELECT EXPERIMENT icon in the top left of the NanoScope software window. 
This opens the Select Experiment window, shown in Figure 2.3a.

Figure 2.3a   The Select Experiment, Contact Mode, window
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The Select Experiment window forms the basis of the NanoScope version 8 user experience. Your 
experiment choice configures the Scan Parameters and, if necessary, the Ramp Parameters 
needed to run that experiment. This was done to simplify and make NanoScope software more 
intuitive and easier to use. That said, all functions from versions 6 and 7 remain accessible.

In addition to the Scan Parameters List and the Ramp Parameters List, Select Experiment also 
configures the Workflow Toolbar. The workflow toolbar, shown in Figure 2.3f, guides you 
through the experiment.

NanoScope software contains two modes of operation: Realtime (i.e., all operations related to 
controlling the microscope) and Image Processing or Offline (i.e., analysis and manipulation of 
captured images). In previous versions of NanoScope software, these modes were separate work 
environments. With versions 6, 7 and 8, both work environments have been combined.
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2.3.2 The Select Experiment Window

Use of the Select Experiment window, shown in Figure 2.3b, is described below.

Figure 2.3b   The Select Experiment, TappingMode, window

The Experiment Category Window

Highlight the Experiment Category that you wish to select in this window.

The Experiment Group Window

Highlight the Experiment Group that you wish to select in this window.
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The Experiment Window

Highlight the Experiment that you wish to select in this window.

Description

A brief experiment Description is shown in this window.

Load Experiment

Click LOAD EXPERIMENT to begin real-time microscope operation.

Open Previous

Your previous experiment is saved in the Previous Experiment window. Click OPEN to start that 
experiment.

Change Microscope

Click CHANGE MICROSCOPE to open the Microscope Select window, discussed in Section 2.5.1, 
that allows you to select a new microscope or new microscope features.

Cancel

Click CANCEL to close the Select Experiment window and continue to use the existing Scan and 
Ramp Parameters.

2.3.3 Single Monitor and Dual Monitor GUIs

NanoScope version 8 software supports, depending on the microscope, one large (30 in., 2560 x 
1600 pixels) single monitor (Dimension Icon and BioScope Catalyst) or two smaller (19 in., 1280 x 
1024 pixels) dual monitors (Dimension Icon-PI). The larger area of the single monitor allows for a 
fixed window configuration, shown in Figure 2.3c. Because of reduced screen area, the image 
window in the dual monitor GUI, shown in Figure 2.3d, is smaller and displays at most two 
channels simultaneously. All windows in the dual monitor GUI may be resized or closed using 
standard Windows icons.
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2.3.4 The Main Screen Elements

Figure 2.3c   NanoScope Version 8 Screen Elements—single monitor

Workflow Toolbar The left pane in the NanoScope window. The Workflow Toolbar sequentially 
organizes the steps (work) needed to perform your experiment.

Client Window A central window for viewing all Realtime and offline graphical displays, 
input parameters, results parameters and graphs.

Menu Bar A group of items for executing commands or viewing files.

Toolbar A group of icons for executing commands or viewing dialog boxes to config-
ure input parameters.

Scan Parameter List A list of the available scan parameters.

Status Bar A read only list that displays the stage X, Y, Z coordinates and enabled func-
tions (e.g., Capture: On).

RealTime Status Window A dockable window in the client window displaying information about the Z 
piezo position.

Browse Window A dockable window in the client window for browsing files. Available in list 
or thumbnail format. 

Image Window Windows that graphically display the 2D scan results.

Image Thumbnails Highlight a thumbnail to view that channel in the selected image window.

Scope Window Windows that display a real-time plot of the channel signal.

Video Window Displays the video camera image.

Engage Status Window Window that prominently displays the engage status

Menu Bar

Toolbar

Workflow
Toolbar

Status Bar

Browse Window
RealTime Status Window

Scan Parameters
List

Image Windows
Client WindowScope WindowsImage Thumbnails
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Figure 2.3d   NanoScope Version 8 Screen Elements—dual monitor
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2.3.5 Menu Bar Items

The initial menu bar includes: File, Experiment and Help to begin the process of initializing and 
opening files in the client window. Once an experiment (workspace) is open, an expanded toolbar 
exists for running and configuring the microscope to scan or process images.

The menu items include:

• File—Accesses menu selections for opening, saving and printing files and documents.

• Experiment—Accesses menu selections allowing you to select and save experiments.

• Microscope—Accesses menu selections to administer commands during data 
collection.

• Scan—Re-starts the scan from the chosen location.

• Capture—Accesses menu selections that allow you to capture (save) images.

• Stage—Accesses menu selections that control stage movement.

• Calibrate—Accesses menu items for calibrating various settings.

• Tools—Accesses menu items for selecting various settings.

• Help—Accesses menu items for initializing and displaying the help screen, Technical 
Support contact information, probe purchase information and NanoScope information 
about your system.

2.3.6 Toolbar Items

The NanoScope version 8 toolbar, shown in Figure 2.3e, is described in Table 2.3a, Table 2.3b, 
Table 2.3c Table 2.3d, Table 2.3f and Table 2.3g.

Figure 2.3e   The NanoScope 8 Toolbar—single monitor
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Table 2.3a   NanoScope version 8.00 Toolbar menu

Note: The availability of some functions depends on the microscope model. E.g. 
High Speed Data Capture, ScanAsyst and HarmoniX are not available on the 
Dimension Icon-PI. MIRO, is available on only the BioScope V and BioScope 
Catalyst.

Select Experiment
SELECT EXPERIMENT configures the Scan and Ramp Param-
eters needed to run an experiment. SELECT EXPERIMENT also 
configures the Workflow Toolbar.

Open Opens NanoScope files.

Save Experiment Saves the NanoScope Workspace.

MIRO
Opens the (optional) MIRO (Microscope Image Registration and 
Overlay) package. See the MIRO User Guide, Bruker p/n 004-1027-
000 for more information.

Simple Mode Makes only essential scan or ramp parameters visible, making oper-
ation simpler for Dimension SPM users.

Expanded Mode Increases the number of visible scan, ramp and channel parameters 
for more advanced applications.

Video Turns the video (camera) window on and off.

Real Time Status Turns the real time status window on and off.

Point and Shoot Opens the Point and Shoot window. See Section 3.1.4 and Sec-
tion 3.8.4 for more information.

High Speed Data Capture Opens the High Speed Data Capture window. See Section 3.8 for 
more information.

Thermal Tune Opens the Thermal Tune window. See the NanoScope V Control-
ler Manual, Bruker p/n 004-992-000.

HarmoniX Opens the HarmoniX window. See the HarmoniX User Guide, 
Bruker p/n 004-1024-000 for more information.
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Table 2.3b   NanoScope version 8 single monitor scan layout toolbar icons

Table 2.3c   NanoScope version 8 scan controls toolbar icons

Thumbnails Only Shows 8 thumbnails only.

Two Channels Down Displays 8 thumbnails and two channels, arranged vertically.

Four Channels Displays 8 thumbnails and four channels.

One Channel Displays 8 thumbnails and one, large, channel.

Two Channels Across Displays 8 thumbnails and two channels, arranged horizontally.

AutoScale
Automatically scales the vertical axis. Refer to AutoScale, page 
108 for details.

Frame Up
The Frame Up command restarts the Realtime scan at the bottom 

of the frame. It is an easy way to begin to view an entire Realtime 
frame from the bottom. By clicking on this button, the Realtime 
scan restarts and moves up at the bottom of the frame. This allows 
you to go directly to the start of the frame and not have to wait for 
the previous frame to end.

Frame Down
The Frame Down command restarts the Realtime scan at the top of 

the frame. This allows you to go directly to the start of the frame 
and not have to wait for the previous frame to end.

Frame Reverse Reverses the vertical scan direction from the existing location.

Skip to Line Restarts the scan at a user-specified line.
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Table 2.3d   NanoScope version 8.00 single monitor ramp display toolbar menu

Table 2.3e   NanoScope version 8.00 ramp controls toolbar menu

Note: For both Continuous Approach and Single Approach, if Start mode = 
MOTOR STEP, the motor is stepped towards the surface, not the Z piezo.

See Force Curves Section 3.3 for more information about ramp functions.

Plots Only Displays the ramp plots.

Plots and Controls Displays the ramp plots and ramp controls tabs.

Ramp Single Lowers and raises the probe tip once by a distance equal to the Z 
scan size, the halts.

Ramp Continuous
The tip is continuously lowered and raised by a distance equal to the 
Z scan size. This is the normal, default motion during Force Cali-
brate.

Stop Halts all tip movement.

Single Approach
The tip is lowered to the surface and raised in a single, controlled 
step. This process is halted if the surface is encountered by the tip, 
causing deflection exceeding the Step threshold amount. The result-
ing force curve is displayed.

Continuous Approach
The tip lowers to the surface and raises in a controlled series of 
steps, then indexed by the Z step size (see Scan Mode panel) dis-
tance. This process continues downward until the tip encounters the 
surface. When tip deflection exceeds the Threshold Step amount, 
Continuous Approach halts and the resulting force curve displays.

Auto Ramp Begins auto ramping as defined by the parameters specified in the 
Auto Panel.

Update Sensitivity Updates the cantilever Deflection Sensitivity.
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Table 2.3f   NanoScope version 8.00 Capture Toolbar menu

Table 2.3g   NanoScope version 8.00 Browse Toolbar menu

Capture
The CAPTURE command directs the software to save the next com-
plete,uninterrupted frame to a file. A second click will force the 
software to save the next interrupted frame (i.e. - parameter 
changed).

Continuous Capture Continuously saves every fram until WITHDRAW or 
ABORT CAPTURE is selected.

Capture Now Immediately saves the current uninterrupted image before the frame 
is complete.

Abort Capture The ABORT CAPTURE command stops the capture process.

Capture Last Saves the last complete frame prior to the current frame.

Date and Time Stamp Sets the capture filename automatically using a date and time for-
mat.

Select Capture Directory Specifies the capture directory.

Show/Hide Browse Displays the Browse window, shown in Figure 2.3c. See Chapter 
4 for more information.
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2.3.7 The Workflow Toolbar

The Workflow Toolbar, shown in Figure 2.3f, provides you with the steps, sequentially ordered, to 
run your experiment.

Figure 2.3f   The Workflow Toolbar. Single monitor (left) and dual monitor (right)

Workflow Toolbar items are briefly described in Table 2.3h. Active function names are 
highlighted in the Workflow Toolbar.

Parent node

Child node
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Table 2.3h   NanoScope Workflow Toolbar menu

Experiment The name of the type of experiment that you have selected. The 
icon displayed is a function of the experiment chosen.

Align Opens the Align window, described in Section 2.5.2.

Navigate Opens the Navigate window, described in Section 3.1.2.

Tune Opens the Tune window, described in Section 3.1.5.

Engage The Engage command brings the tip into contact with the sample 
surface and starts the Realtime imaging process.

Scan Scans the probe tip over the sample, producing an image. Addi-
tional information can be found in Section 3.1.

Ramp
Opens the Ramp Parameter List, the ramp plots window and, if 
requested, the ramp controls window. Additional information can be 
found in Ramp Panel Section 3.3.3.

Force Volume
Opens the Force Volume Parameter List and the Force Volume 
GUI. Additional information can be found in Force Volume Sec-
tion 3.4.

Withdraw The Withdraw command stops the scanning process and withdraws 
the tip from the surface.

Generic Sweep Opens the Generic Sweep window, described in Section 3.7.2.
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Nodes

The NanoScope dual monitor GUI retains the concept of nodes introduced in NanoScope 6. A top 
level node is known as the parent node and each node underneath is known as a child node (see 
Figure 2.3f). Parent nodes are usually the name for the microscope mode (e.g., Scan) or a file name 
of an image within the workspace. Parent nodes are the higher level nodes for auto programs. Child 
nodes, also known as “views,” are typically associated with a window that is used to carry out an 
analysis, image processing, or Realtime control function of the software.

Each node may be renamed, deleted and grouped. Node names may be preceded by an icon and/or 
lines indicating the relative positions of nodes in the hierarchy. Table 2.3i lists the available 
NanoScope dual monitor child nodes.

Table 2.3i   NanoScope dual monitor Workflow Toolbar child nodes

Functions Menu

The Functions menu, shown in Figure 2.3g, is accessed by right-clicking on a parent node (i.e., 
Scan, Ramp or a filename). It includes specific elements for viewing multiple windows, renaming 
views, grouping views, and adding and deleting views. This menu also includes the command for 
running an Auto Program (i.e., Run AutoProgram) where the image processing commands may 
be run in a series on multiple images and results may be saved in a data file.

Scan Dual Scans the probe tip over the sample and displays images of 2 chan-
nels. Additional information can be found in Section 3.1.

Scan 8 Channels Scans the probe tip over the sample and displays an image of one 
channel and 8 thumbnails. Additional information can be found in 
Section 3.1.

Scan Parameter List Opens the Scan Parameter List. Additional information can be 
found in Scan and Ramp Parameter Lists: Section 2.3.8 and 
Scan Panel Interface: Section 3.1.9.

Ramp Parameter List
Opens the Ramp Parameter List. Additional information can be 
found in Scan and Ramp Parameter Lists: Section 2.3.8 and 
Ramp Panel Section 3.3.3.

Force Plots
Opens the Force Plots window and starts Force mode. Additional 
information can be found in Ramp Panel Section 3.3.3.

Force Volume Parameters
Opens the Force Volume Parameter List. Additional information 
can be found in Force Volume Section 3.4.
NanoScope Software 8.10 User Guide Rev. D



Getting Started with NanoScope v8.10 Software
Getting to Know NanoScope Software
Figure 2.3g   Functions Menu

 Menu Items

Add View Accesses a submenu of Realtime or offline commands.

Delete Deletes the currently selected node in the workspace. If changes 
were made, a prompt appears to save the view.

Delete Sub Items Deletes the items listed under the currently selected node in the 
workspace. If changes were made, a prompt appears to save the 
view.

Change Title Allows for the selected view title to be changed.

Show Linked Items

Create Auto Program Allows you to create a new Auto Program based on analysis done 
on a node. 

Edit AP Attributes If the currently selected node is in Auto Program, this parameter 
allows you to edit the Auto Program properties.

Run Auto Program Accesses the Auto Program Results view to run the selected image 
processing commands. 
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Functions Submenu

The Functions submenu allows for adding new views to the workspace in the Add View command 
(see Figure 2.3h).

Figure 2.3h    Functions Submenu

Figure 2.3i   Scan Workspace Functions Submenu

Functions Submenu Items

The Add View submenu includes commands for running the microscope, analyzing and reporting. 
Selecting a command adds the item name and icon as a new child node to the workspace window. 
Click on a node to invoke the view in the client window. 

Depending upon the microscope type and mode (i.e., Realtime and Image Processing), each 
workspace has unique commands in the Add View submenu. For the Realtime functions Add View 
submenu, see Figure 2.3i. For more detailed descriptions about the views, see Chapter 3.
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2.3.8 Scan and Ramp Parameter Lists

The Scan and Ramp Parameter Lists display the user-configurable (depending on options) scan and 
ramp parameters relevant to your experiment type.

Simple Mode

You can adjust the number of parameters shown in the Scan Parameter List using several 
methods.

1. The default SIMPLE MODE, shown in Figure 2.3j, displays the essential parameters needed to 
make an image.

Figure 2.3j   The SIMPLE MODE view of the Scan Parameter List in Contact Mode
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Expanded Mode

1. The EXPANDED MODE view, shown in Figure 2.3k, increases the number of displayed 
parameters, providing access to more advanced options.

Figure 2.3k   The EXPANDED MODE view of the Scan Parameter List in Contact Mode

More advanced Scan Parameter List views are discussed below.

Show All

1. From the Menu bar, click EXPERIMENT > CONFIGURE EXPERIMENT. This opens an 
information window, shown in Figure 2.3l.

Figure 2.3l   The Configure Experiment information window
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2. Click OK to open the Configure Experiment window, shown in Figure 2.3m.

Figure 2.3m   The Configure Experiment Window

3. Check a box in the Add Commands panel to add that command to the Workflow Toolbar.

4. Click OK to accept your choices and close the Configure Experiment window.

5. Right-click in the Scan Parameter List and select SHOW ALL, shown in Figure 2.3n.

Figure 2.3n   Select SHOW ALL items
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This makes all Scan Parameters visible along with two check boxes, the left, green, check box for 
the SIMPLE MODE and the right, red, check box for the EXPANDED MODE. See Figure 2.3o.

Figure 2.3o   Enable Parameters

Without “”
Parameter will
not display

With “”
Parameter will
display
NanoScope Software 8.10 User Guide Rev. D



Getting Started with NanoScope v8.10 Software
Getting to Know NanoScope Software
The checked  parameters display in normal Real-time mode while those parameters without a  
will not display in normal Real-time mode.

Check the parameters that you want displayed and right-click in the Scan Parameter List and 
select SHOW ALL items to hide the unchecked parameters. The panel will once again appear in 
normal Real-time mode.

Configure Lists

1. Right-click in the Scan Parameter List and select CONFIGURE LISTS, shown in Figure 2.3p.

Figure 2.3p   Select SHOW ALL items

Select Configure Lists
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This opens the Panel Lists Configuration window, shown in Figure 2.3q.

Figure 2.3q   The Panel Lists Configuration window

2. Drag an item from the Spare List to either Panel List 1 or Panel List 2 and click OK.

This adds selected items to the Scan Parameter List. 

The SHOW ALL function works in the Panel Lists Configuration window the same way that it 
works in the Scan Parameter List window.
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Show Parameter List 2

A second Scan Parameter List can be made visible by right-clicking in the Scan Parameter List 
window and selecting SHOW PARAMETER LIST 2.

Figure 2.3r   SHOW PARAMETER LIST 2

2.3.9 The RealTime Status Window

The Real Time Status window, show in Figure 2.3s, displays either the photo detector quadrant 
voltages or the Z piezo voltage.

Figure 2.3s   Meter View (left) and Z position indicator (right) in the RealTime Status window.

Select Show Parameter List 2
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2.3.10 Image Windows

Figure 2.3t   A NanoScope Image Window 
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The NanoScope image buttons, shown in Figure 2.3u, are described in Table 2.3j. These buttons 
operate on the scanned data and do not affect the real-time scanning. Realtime scaning can be 
controled with the real-time Zoom and offset buttons, shown in Figure 2.3v.

Figure 2.3u   NanoScope image buttons

Table 2.3j   NanoScope image buttons

Figure 2.3v   Realtime Zoom and Offset buttons

Image Area The SPM image is displayed here.

Image Buttons The image buttons, described below, allow pan, zoom and measurement functions.

Scan Line Indicator An arrow showing the current scan line.

Vertical Scale The vertical scale of the image.

Horizontal Scale The horizontal scale of the image.

Realtime Zoom, Offset Zooms and Offsets the scan. To Unzoom, you must change the Scan Size

Scope Window Displays a real-time plot of the channel signal.

AutoScale Automatically scales the data. Refer to AutoScale, page 108 for details

Plot Controls Provides control of what is plotted in the image area.

Measure Allows you to draw a box to make measurements, translate the image or offset and resize the image.

Pan From a zoomed image, you can pan around to other areas of the original image.

Zoom Allows you to draw a box to zoom in on an image.

Resize Up Resizes the image up to the previous zoom level.

Resize Down Resizes the image down to the previous zoom level.

Measure

Pan

Data Zoom

Resize Up

Resize Down

Zoom Scan Offset Scan
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2.3.11 Cursor Types

Within captured images, it may be necessary to do analysis or modification on a selected area or 
exclude this area from the analysis. Cursors allow for specifying this information.

The cursor types are as follows:

• Lines—Selecting specific data (e.g., lengths of features or sectioning features) along 
the line.

• Boxes—Selecting specific areas on the display for including or excluding data.

• Grid Markers—Horizontal or vertical line cursors within histograms and spectrum 
graphs for choosing data ranges or making measurements. 

Using a Slider Cursor

In a graph or histogram, position the mouse within the blank area between the axis and the edge of 
the graph and drag the slider along the graph to position the cursor. The mouse cursor will change 

to .

Positioning a Line or Box Cursor

• Click and drag the image to draw a line or box cursor. 

• To resize an existing line or box cursor, click and drag on a corner edge or end of the 
object. Cursor will change to  or .

• To move an existing object, click and drag the center of the object to the desired 
location. The cursor will change to .
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2.4 NanoScope Version 8 Workspaces

A NanoScope workspace is a collection of views and parameters in NanoScope software. A 
NanoScope experiment is sometimes referred to as a workspace.

2.4.1 Multiple Users using NanoScope

The NanoScope computer can save multiple user preferences/settings in the computer registry. 
Once a user sets up an account on the computer, several settings are automatically saved for the 
user. These settings include:

• Previous image file type

• Previous directories

• Browse window settings

• Option to disable video while scanning

• Section View results to display

• Location of Abort dialog box

• Review curve settings

• Force Filter settings

• Help settings

• Script directory

• Track ball on

• Default Parameter dialog box location

• Point and Shoot View settings

• Sweep dialog box settings

• Workspace settings

• Image control settings

• Grid control settings

• Meter View control settings

• Color control settings

• Z center control settings
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2.4.2 Older Workspaces Unsupported in NanoScope v7.30 and later

Starting with V7.30 older workspaces will not be supported. See Figure 2.4a.

Figure 2.4a   Older workspaces are not be supported

To import an older NanoScope workspace:

1. Open the older version of Nanoscope.

2. Open the workspace you would like to get parameter values from.

3. Ensure that you are in RealTime Mode.

4. Go to FILE > SAVE AS...

5. You will be prompted to save to a (settings) .bag file.

6. Open the newer version of Nanoscope.

7. Go to Realtime mode.

8. Go to Open...

9. Select settings type, (settings)*.bag files.

10. Select the bag file saved from the older version.

11. You should get the confirmation message shown in Figure 2.4b.

Figure 2.4b   Import confirmed
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2.5 Quick Guide to an Image

The following procedures provide quick steps for using NanoScope 8 software. Follow these steps 
to quickly scan a sample and then capture and analyze an image. Along the way, you’ll see how 
NanoScope 8 software works, learn some useful tricks, and find out how to learn more later.

This section is not intended to teach a new user how to run an AFM, but only to introduce 
experienced users to NanoScope version 8.

2.5.1 Starting the NanoScope Software

After the software installation is complete, you are ready to start the NanoScope software.

1. Start the NanoScope software by double-clicking on the desktop shortcut labeled NanoScope 
8.10.

2. Select Tools > Select Microscope to open the Microscope Select dialog box, shown in 
Figure 2.5a.

Figure 2.5a   Microscope Select Dialog Box
Rev. D NanoScope Software 8.10 User Guide 43



Getting Started with NanoScope v8.10 Software
Quick Guide to an Image

44
In the Microscope Select dialog box:

a. You can add a new set of hardware configuration parameters by clicking NEW, or edit 
the parameters of the selected microscope by clicking EDIT. The parameters include 
things such as the controller and vision system.

b. In the Equipment dialog box, choose the microscope you are using (see Figure 2.5b). If 
you are using a MultiMode AFM, select the scanner you plan to use (SCANNER button). 

Note: Select the ADVANCED button to view all equipment parameters.

Figure 2.5b   Select the appropriate microscope from the Equipment window

Figure 2.5c   Select the DIMENSION ICON-PI from the Equipment window
NanoScope Software 8.10 User Guide Rev. D



Getting Started with NanoScope v8.10 Software
Quick Guide to an Image
3. Click EXPERIMENT > SELECT EXPERIMENT or the SELECT EXPERIMENT icon in the top 
left of the NanoScope software window. This opens the Select Experiment window, shown 
in Figure 2.5d.

Figure 2.5d   The Select Experiment, Contact Mode, window

4. Select the Experiment Category, Experiment Group and Experiment.

5. Click LOAD EXPERIMENT.

6. If you are using a Dimension Series AFM, continue with the steps in Preparing a 
Dimension Series AFM for a Realtime Scan Section 2.5.2.
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2.5.2 Preparing a Dimension Series AFM for a Realtime Scan

Once you’ve created the workflow and scan parameters, prepare the system to scan. This includes 
aligning the laser, adjusting the photo detector, locating the cantilever tip with the optical 
microscope, and focusing the optical microscope on the surface. If you have not yet learned these 
procedures, refer to your Dimension Microscope Manual and/or SPM Training Notebook.

For details on using the Realtime Scan Views, see Chapter 3.

1. Mount the probe into the cantilever holder

2. Mount the cantilever holder onto the end of the scanner head.

3. Click the ALIGN icon in the Workflow Toolbar. This opens the Align window, shown in 
Figure 2.5e.

Figure 2.5e   The Align Window
Video
NanoScope Software 8.10 User Guide Rev. D



Getting Started with NanoScope v8.10 Software
Quick Guide to an Image
Several panels in the Align window help you through the process:

• The Video panel, shown in Figure 2.5e, displays an image of the area around the 
cantilever.

• The Meter panel, shown in Figure 2.5f, displays the signals on the quad photo detector 
and the laser sum signal.

Figure 2.5f   The Meter panel in the Align window

Sum signal
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• The align instruction video, accessable through the Align panel (Fig Figure 2.5g) and 
shown in Figure 2.5h, plays a short instructional movie showing the effects of moving 
the laser and photo detector alignment knobs.

Figure 2.5g   Watch Video Commands in the Align Panel

Figure 2.5h   The align instruction movie window

• The optics panel, shown in Figure 2.5i, has buttons to zoom or unzoom the camera and 
buttons to adjust the sample illumination LED. Zooming out may aid in locating the tip.

Figure 2.5i   The optics panel

ZoomUnzoom Illumination

Capture video image
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• The video panel, shown in Figure 2.5e, displays an image of the area around the 
cantilever.

• The Focus Controls panel, shown in Figure 2.5j focuses the optics on the probe tip and 
thus knows the Z position of the probe tip. This knowledge is needed to successfully 
engage the probe tip onto your sample.

Figure 2.5j   The Focus panel

• The Focus Select panel, shown in Figure 2.5k, tells the system if you are focusing on 
the TIP or the TIP REFLECTION.

Figure 2.5k   The Focus Select panel in the Align window

4. Using the video image as a guide, adjust the laser control knobs on the top of the Dimension 
head to place the laser spot near the probe tip.

5. Adjust the laser control knobs on the side of the Dimension head to center the laser diode on 
the quad photo detector and maximize the sum signal.

6. Click the TIP button in the Focus Select panel and, using either the trackball while holding 
down the bottom-left button or the FOCUS UP and FOCUS DOWN buttons in the Focus 
Optics panel, shown in Figure 2.5j, move the focus up or down. The focus Speed is 
controlled by the sliding bar or by typing a value from 0 to 100.

7.  Select the Tip Reflection button to focus on the tip reflection. This is particularly useful 
when scanning reflective samples.

8. Dimension Icon users may prefer to use the Alignment Station. See the Dimension icon 
Instruction Manual, Bruker p/n 004-1023-000, for details.

When you leave Locate Tip mode, the optics move to a focus position, typically 1mm below 
the tip. To set this distance, select Microscope > Engage Settings > General > Sample 
clearance.

Focus Up

Focus Down

Focus Tip Focus Tip Reflection
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9. Click the NAVIGATE icon in the Workflow Toolbar. This opens the Navigate window, 
shown in Figure 2.5l.

Figure 2.5l   The Navigate Window

10. Focus the optics on the sample surface using either the trackball or the Scan Head arrows, 
shown in Figure 2.5m, in the Navigate View. If you have used the Alignment station, the 
stage will prompt you before moving back to the sample position.

Figure 2.5m   Focus: Z Motor Controls

11. To use the track ball, roll the trackball up or down while holding down the bottom-left 
button. To use the Z Motor arrows, click and hold them down. You can use the speed 
controls in the Z Motor area to adjust the speed. This adjustment raises or lowers the Z stage 
on which the SPM and optics are mounted.

Video
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12. To focus on the sample SURFACE (normal operation) or the TIP REFLECTION (for extremely 
clean samples), change the Focus Select parameter accordingly.

Figure 2.5n   The Navigate Focus Select Panel

Note: For reflective or semi-reflective samples, the tip reflection is easier to bring into 
focus than the surface, especially if the sample is very flat or clean.

13. For samples which are difficult to bring into focus, move to an edge of the sample, which is 
easy to find in the optical image, and bring the top of the edge into focus.

14. Move the X-Y stage to align the desired location on the sample under the crosshairs either by 
using the trackball without holding down any buttons or by using the XY Stage Control 
arrows, shown in Figure 2.5o, in the Navigate View.

Figure 2.5o   XY Stage Controls

15. If you are using TappingMode, click the TUNE icon. Check your parameters in the Auto 
Tune list.

16. Click the Auto Tune button. Notice that the status bar at the bottom of the NanoScope 
software window says “Cantilever Tuning” during automatic tuning. When tuning is 
complete, click Exit in the Cantilever Tune dialog box. Proceed to Section 2.5.3, "Scanning 
and Scan Parameters".

CAUTION: When moving the SPM stage up and down, it is possible to crash 
the tip into the surface. To prevent a crash while focusing on the 
surface, watch the optical image and tip-to-sample proximity. The 
sample should be in focus when the tip is 1mm (1000µm) above 
the surface.

Focus Tip ReflectionFocus Surface
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2.5.3 Scanning and Scan Parameters

Next, you set scan parameters and scan the sample.

1. In the Scan Parameters window, use the following initial parameter settings in the Scan tab. 
These values may already be set; they are handy starting values.

2. To collect 5K points of data per line, set the following parameters in the Scan panel:

Note: You can use the mouse to adjust the value in many parameter fields. Click on 
the value and drag the mouse left to decrease the value or right to increase the 
value.

The Aspect Ratio controls the X:Y ratio of the pixels in the displayed image. Because there is 
an 8:1 ratio between 5120 samples/line and 640 lines, using an Aspect Ratio of 8 causes the 
pixels displayed in the image to be square.

Note: Some microscopes, e.g. Dimension Icon-PI, are limited to 1K (1024) lines and 
1K points per line.

3. For TappingMode, use the following initial parameter settings in the Feedback panel:

4. For Contact mode, use the following initial parameter settings in the Feedback panel:

5. Click the ENGAGE icon in the Workflow Toolbar. Scan lines appear in the Image Windows 
once the tip engages and scanning begins.

6. Check to see whether the trace and retrace lines in the Scope window are tracking each other 
well. They should have a similar shape, but they may not overlap each other horizontally or 

Scan size: 1µm

Aspect Ratio: 1.00

Scan Angle: 0.00 °

Scan Rate: 1Hz

Aspect Ratio: 8.00 (4.00 if Lines is 1024; 1.00 if Lines is 
5120) and you want square pixels

Samples/Line: 5120

Lines: 640, 1280 or 5120

SPM feedback: Amplitude

Integral gain: 0.5

Proportional gain: 5.0

Integral Gain: 2.0

Proportional Gain: 5.0

Deflection Setpoint: 0V (vertical deflection = -2V (before engage)
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vertically. Adjust the Scan Rate, Integral Gain, Proportional Gain, and/or Setpoint (that 
is, Amplitude Setpoint for TappingMode and Deflection Setpoint for Contact Mode) 
parameters. Once the trace and retrace are tracking well, your tip is scanning the sample 
surface.

7. At this point, you may want to adjust the Scan Size, X offset, Y offset, and Scan Angle 
parameters to locate the scan over features of interest. If you increase the Scan Size, 
remember that the Scan Rate should be lowered.

Note: You can zoom in on the scan image by selecting the Zoom button below the 
image. Then, use your mouse to drag a box outline over the area you want to 
zoom in on. Click Offset to offset the center position of your scan.

8. With a large image, it may be useful to zoom in on the scan without changing the Scan Size. 
Select the data ZOOM button above the image. Use your mouse to drag a box outline on the 
image (begin by clicking where you want the center of the box to be). When you release the 
left button, you will be zoomed in (scan size of image display will change) but the scanner 
will remain scanning the original scan size. At this point you can choose to “pan” over to 
other areas of the total scan. Select the PAN button and click and hold the left mouse button 
as you move the mouse. The minus zoom (right) button above the image allows you to go 
back to the original scan and the plus zoom button allows you to go to more zoomed in scans 
(if you have done multiple zooms). You may also choose to physically change the scan size 
or X/Y offsets by using the Zoom or Offset  buttons below the image.
Rev. D NanoScope Software 8.10 User Guide 53



Getting Started with NanoScope v8.10 Software
Quick Guide to an Image

54
2.5.4 Capturing an Image

Once you have adjusted the scan parameters, you can capture a scanned image. Perform these steps 
once a scan you want to capture is in progress. 

1. You can capture a scan in any one of four ways:

• Click the CAPTURE icon in the toolbar.

• Click the CAPTURE NOW icon in the toolbar.

• From the menu bar, select Capture > Capture.

• From the menu bar, select Capture > Capture Now.

The scan will continue. Notice that the status bar at the bottom of the NanoScope window (see 
Figure 2.5p) says “Capture: On.” When the current scan is complete, the image will be stored 
automatically in the Capture Directory with the file name indicated in the status bar.

Figure 2.5p    Status Bar

The file name and directory can be changed by selecting Capture > Capture Filename from 
the menu bar (see Figure 2.5q).

Figure 2.5q   Change Filename

Capture Status
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You may also select the capture filename by clicking the SELECT CAPTURE DIRECTORY icon and/
or the DATE/TIME STAMP, shown in Figure 2.5r, icons on the menu bar.

Figure 2.5r   Date/Time Stamp menu bar menu

Capture Now, and Capture Last save as much of the image buffer as possible including parts of it 
that were generated with different parameters such as gains, setpoints, etc., so some of the 
information in the header may be incorrect for some parts of the saved image.

2. In the Image Browser area (see Figure 2.5s), check to see if you are looking at the Capture 
Directory. If not, select the Capture Directory icon, shown at left, (or click the “...” button 
and select the Capture Directory, which is usually d:\capture). If you don’t see the Image 
Browser, click the SHOW/HIDE BROWSE icon on the toolbar.

Figure 2.5s   NanoScope Image Browse Window
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3. Double-click the image you just captured. The image opens in the Image window, shown in 
Figure 2.5t. Notice that the image filename and an image view are added to your workspace.

Figure 2.5t   NanoScope Image View Window
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4. If you need to change the Contrast, Offset or Color Table, right-click on the color scale of 
the Image window, and change the appropriate values in the Color Scale popup window, 
shown in Figure 2.5u. The Color Table may also be changed by clicking and holding the 
color bar, then dragging the mouse left or right. The Color Table may also be changed by 
using th left/right arrows when the cursor is inside the Table window. See Appendix B for a 
list of color tables.

Figure 2.5u    Color Scale

Note: To rename image files, you can use File > Save As, use Explorer to rename the 
file, or right-click on the image in the image browser and select Move.

2.5.5 Analyzing an Image with Section Analysis

After opening the captured image, you can analyze the image. In this example, the Flatten filter 
and Section analysis views are used.

1. Right-click on the name of the image in your workspace. Choose ADD VIEW > FLATTEN 
from the pop-up menu, select MODIFY > FLATTEN from the menu bar, or click the FLATTEN 
icon on the toolbar.

The Flatten filter can be used to remove image artifacts due to vertical (Z) scanner drift, image 
bow, skips, and anything else that may have resulted in a vertical offset between scan lines. 
Refer to Flatten on page 333 for a detailed description of Flatten.

2. Set the input parameters for the filter. For example, you can choose the order of the 
polynomial to use to fit scan lines.

3. Click EXECUTE.

4. To restore to the original data, click RELOAD. Then change the parameters and click 
EXECUTE again.

5. Right-click on the name of the image in your workspace again. Choose ADD VIEW > 
SECTION from the pop-up menu, select ANALYSIS > Section from the menu bar, or click the 
SECTION icon on the toolbar. Section analysis allows you to easily make depth, height, 
width, and angular measurements.
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Section analysis allows you to easily make depth, height, width, and angular measurements. 
Refer to Section on page 268 for a detailed description of Section.

6. Drag a line across the image. A vertical cross section along that line is shown in the upper 
graph area, shown in Figure 2.5v. The right graph, also shown in Figure 2.5v, shows the 
power spectrum (Fourier Transform) of the cross section.

7. In the lower (Section) graph, drag the two cursors around to make measurements. You can 
grab two or more measurement cursors from the outside of the grid. You will see the cursor 
change to a , at which point you can grab the measurement cursors. The results area at 
the bottom of the view shows various measurements at the marker position.

Note: Section can have three horizontal lines or 3 rotating lines or one rotating box. It 
can have three sets of grid markers on one image cursor or one set of grid 
markers on each image cursor.

8. If you would like to make an Average Section, right-click on the image, select ROTATING 
BOX. After drawing the box, you can make it rotate by holding down the shift key while 
grabbing anywhere in the box.
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Figure 2.5v   Section Analysis
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2.5.6 ASCII Export

When transporting the results of using NanoScope software to another computing platform, the 
most generic format is an ASCII text file. The File > Export > ASCII command builds such a file.

1. Select a directory, then an image file within it, from the file browsing window at the right of 
the NanoScope main window. Right-click in the thumbnail image to open the menu shown 
in Figure 2.5w.

Figure 2.5w   The ASCII Export Command
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2. Click Export > ASCII to open the ASCII Export dialog box, shown in Figure 2.5x.

Figure 2.5x   The ASCII Export Dialog Box

3. Select the Units in which to record the data in the new file by checking the appropriate 
boxes. DISPLAY exports the image data in the displayed units, e.g. Height is exported in 
metric (nm), Phase in degrees, Frequency in Hz... NATIVE exports the data in raw (unscaled) 
Volts. LSB exports the data in bits.

4.  You can also export image HEADER, RAMP, or TIME information by selecting those check 
boxes.

5. Click Save As..., designate a directory path and filename, and click SAVE.

Figure 2.5y shows the start of an exported ASCII image file saved without a header.

Figure 2.5y   Sample ASCII Image File
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2.5.7 High Resolution Imaging

Your controller can collect data at a maximum resolution of 5120 x 5120 points per image for all 8 
simultaneous channels. This increase makes re-imaging at higher resolution unnecessary in most 

situations.1

Note: Images with more than 1 million data points require that the SCAN DATA 
LIMITS parameter in the Equipment panel be set to SYSTEM MAXIMUMS:

1. Click the TOOLS drop-down menu, then SELECT MICROSCOPE, shown in Figure 2.5z, to 
specify your SPM.

Figure 2.5z   Microscope Select

1.This feature is not available on the NanoScope V-PI.
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2. Click EDIT in the Microscope Select panel to open the Equipment panel, shown in Figure 
2.5aa.

Figure 2.5aa   System Component Designation

3. Click ADVANCED and set the SCAN DATA LIMITS parameter to SYSTEM MAXIMUMS. See 
Figure 2.5ab.

Figure 2.5ab   Set the SCAN DATA LIMITS to SYSTEM MAXIMUMS for images with more than 1 M data points. 

4. Click OK to close the Equipment panel. Click OK to close the Microscope Select panel. 
The NanoScope software will close all open RealTime and Offline panels before re-entering 
RealTime.
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2.6 Technical Support at Bruker

Your satisfaction and productivity regarding Bruker products and documentation are absolutely 
essential.

2.6.1 Technical Support

Click Help > TECHNICAL SUPPORT for Bruker SPM technical support contact information.

Phone: 1-800-873-9750 (or 805-967-1400), Option 4, then Option 5.

e-mail: spmhelp@bruker.com.

2.6.2 Contact Information

Mailing Address

Technical Documents, Technical Support or Bug Reports at Bruker
Bruker Corporation
112 Robin Hill Rd.
Santa Barbara, CA 93117

E-mail: help@bruker.com

Voice Phone

(805) 967-1400, (800) 873-9750

Fax

(805) 967-7717

World Wide Web

http://www.bruker.com
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The RealTime Views control the Real time collection of data. Each part of the screen is an integral 
part of the scanning process. For more information on controlling views and the workspace, refer to 
Chapter 2.

For general procedures in setting the parameters and data definitions, refer to the following 
sections:

• Views for Scanning Section 3.1

• Tips on Using Realtime Section 3.2

• Force Curves Section 3.3

• Force Volume Section 3.4

• Piezoresponse Force Microscopy Section 3.5

• Surface Potential Detection Section 3.6

• NanoScope V Controller Lock-In Section 3.7

• High Speed Data Capture Section 3.8

• Pulse Counting Section 3.9

Note: If you have never used an AFM before, refer to your microscope manual or 
contact Bruker for training.
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3.1 Views for Scanning

The general interface views associated with configuring parameters for scanning include:

• Align View Section 3.1.1

• Navigate View Section 3.1.2

• Real Time Status Section 3.1.3

• Point and Shoot View Section 3.1.4

• Cantilever Tune Section 3.1.5

• Electric Tune Section 3.1.6

• Scan Interface Section 3.1.7

• Scope Trace Plot Section 3.1.8

• Scan Panel Interface Section 3.1.9

• Channels Interface Section 3.1.10

• Feedback Interface Section 3.1.11

• Interleave Mode Section 3.1.12

• Other Panel Section 3.1.14
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3.1.1 Align View

Use the Align commands to align the laser and photodetector on the cantilever probe of your 
Dimension or other scanning probe microscope equipped with a vision system. To access the Align 
view, click the ALIGN icon the Workflow Toolbar.

The Align window, shown in Figure 3.1a, has several panels described below.

Figure 3.1a   The Align Window

1. The Video panel, shown in Figure 3.1a, displays an image of the area around the cantilever.

Video
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2. The Meter panel, shown in Figure 3.1b, displays the signals on the quad photo detector and 
the laser sum signal.

Figure 3.1b   The Meter panel in the Align window

3. The align instruction video, shown in Figure 3.1c, plays a short instructional movie showing 
the effects of moving the laser and photo detector alignment knobs.

Refer to your microscope instruction manual for details regarding adjustment of the laser spot and 
photodetector.

Figure 3.1c   The align instruction movie window

Sum signal
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• The optics panel, shown in Figure 3.1d, has buttons to zoom or unzoom the camera and 
buttons to adjust the sample illumination LED. Zooming out may aid in locating the tip.

Figure 3.1d   The optics panel

• The Focus Controls panel, shown in Figure 3.1e focuses the optics on the probe tip and 
thus knows the Z position of the probe tip. This knowledge is needed to successfully 
engage the probe tip onto your sample.

Figure 3.1e   The Focus panel

4. The Focus Select panel, shown in Figure 3.1f, tells the system if you are focusing on the tip 
or the tip reflection.

Figure 3.1f   The Focus Select panel

5. The Alignment Station panel, shown in Figure 3.1g, moves the stage to position the head 
over a mirrored surface mounted to the Dimension Icon stage. In many cases finding the laser 
reflection is easier if a mirrored surface replaces the sample.

Figure 3.1g   The Alignment Station panel

ZoomUnzoom Illumination

Capture video image

Focus Up

Focus Down

Focus Tip Focus Tip Reflection
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3.1.2 Navigate View

Use the Navigate View to position the tip, locate a surface position for referencing Z height and 
move the stage for scanning the sample surface. To access the Navigate view, click the NAVIGATE 
icon the Workflow Toolbar.

The Navigate window, shown in Figure 3.1h, has several panels described below.

Figure 3.1h   The Navigate Window

1. The Video panel, shown in Figure 3.1h, displays an image of the area around the cantilever.

Video
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2. The Focus Z Motor panel, shown in Figure 3.1i, moves the head vertically while you focus 
the optics on the sample surface. You may also use the trackball to accomplish this task. 
Refer to the your microscope Instruction Guide for details. To use the Z Motor arrows, click 
and hold them down. Use the Speed controls in the Z Motor area to adjust the speed of the 
head movement. Slider, numeric and min/max controls are available.

Figure 3.1i   Focus: Z Motor Controls

3. The X-Y Stage Control panel, shown in Figure 3.1j, moves the stage to align the desired 
location on the sample under the crosshairs by using the XY Stage arrows. Adjust the stage 
movement speed with the Speed controls. Slider, numeric and min/max controls are 
available.

Figure 3.1j   XY Stage Controls
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4. The Focus Select panel, shown in Figure 3.1k, tells the NanoScope software what you focus 
on, the sample SURFACE (normal operation) or the TIP REFLECTION (for extremely clean 
samples). Change the Focus Select parameter accordingly.

Figure 3.1k   The Navigate Focus Select Panel

5. The Load Sample function first lifts the SPM head then indexes the stage to a 
preprogramming location (usually front-center) where samples may be rapidly reloaded.

6. This raises the head to the Load/Unload height (see SPM Parameters, page 74 ) and the 
stage indexes to the front-center position.

7. The Unload Sample function moves the sample back to the analysis position

8. The Move To X/Y function enables you to move quickly to a defined X-Y coordinate. If the 
origin has not been preset using the Stage > Set References panel, the stage automatically 
defaults to the last origin that was previously used. All subsequent X-Y moves are done from 
the origin. Select the Move To (X, Y)... panel under the Stage pop-down menu. The screen 
presents a panel with four fields (see Figure 3.1l). Enter the X and Y coordinates of the 
desired move to position, then click OK.

Note: The first two fields define absolute moves relative to the currently set origin 
(0,0). The third and fourth fields define relative moves from the current 
position.

Figure 3.1l   Move To Prompt

Focus Tip ReflectionFocus Surface
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9. The Zoom panel, shown in Figure 3.1m, digitally zooms (i.e. crops) in on the image.

Figure 3.1m   The Zoom panel

10. The Illumination panel, shown in Figure 3.1n, adjusts the brightness of the sample 
illumination LED. Slider, numeric and min/max controls are available.

Figure 3.1n   The Illumination panel

11. The Video Capture function, shown in Figure 3.1o, saves the current video image to a bmp 
file.

Figure 3.1o   The Video Capture panel

Zoom OutZoom In
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Using the Navigate View

Access the Navigate View at any time when the stage movement or focus surface and locate tip 
settings are necessary.

Note: Some microscope options, such as Engage and Withdraw, are unavailable 
when the Navigate View is active. You must select another view, such as the 
Scan View, to enable these options.

SPM Parameters

To access the stage parameters panel, select MICROSCOPE > ENGAGE SETTINGS > GENERAL to 
open the Engage Stage-Motor Settings window, shown in Figure 3.1p.

Figure 3.1p   Default SPM Parameters

• Sample Clearance

• SPM Safety

• SPM Engage Step

• Load/Unload Height

• SPM exclusion limit

• Sew tip

• Trigger safety

CAUTION: If Locate Tip is not accomplished before Focus Surface, there is a 
danger of crashing the tip during Engage.
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3.1.3 Real Time Status

Meter View

The Meter View shown in Figure 3.1q, is activated by clicking the REALTIME STATUS icon in the 
NanoScope toolbar. This displays the photodetector signal, RMS amplitude, horizontal and vertical 
deflection signals, and the signal sum when you are not engaged.

• Photodetector Signal—Red dot that corresponds to the positioning of the laser on the 
photodetector.

• Signal Sum—Horizontal meter that displays the sum of the voltage response from the 
laser in all 4 sections of the photodetector.

• Vertical Deflection—Corresponds to the voltage for vertical displacement of the laser 
signal. Should be “0” for centering.

• Horizontal Deflection—Corresponds to the voltage for the horizontal displacement of 
the laser signal. Should be “0” for centering.

• RMS Amplitude—Root mean square (RMS) signal measured at the detector 
(TappingMode only).

Z position indicator

The Z position indicator and the step motor control, shown on the right in Figure 3.1q, are 
displayed when the probe is engaged.

Figure 3.1q   Meter View (left) and Z position indicator (right) in the RealTime Status window.
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3.1.4 Point and Shoot View

The Point and Shoot View allows you to select specific points on an image (see Figure 3.1r). Use 
Point and Shoot to capture an image and/or collect a force curve for every point you designate. 

When you click a point on an image, a crosshair (+) marks the location. You can designate 
individual points, or use the tools in the Point and Shoot View to assign multiple points 
simultaneously. 

Figure 3.1r   Point and Shoot View
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Controls and Parameters

Image/Scan Allows you to switch to Image/Scan mode. Use Image/
Scan mode to adjust scan parameters in any scan view.

Ramp/Force Curve Allows you to switch to Ramp/Force Curve mode. Use 
Ramp/Force Curve mode to adjust the ramp settings. You 
can select points on an image, ramp each point, and create 
a force curve for each point.

Image Channel Select the channel to use for the image.

Ramp Channel Select the channel to use for the ramp display.

Multiple Shoot Number of force curves collected at each point, 100 max.

Capture Image Click this button to capture an image and save it in the 
Capture Directory. After the capture the software switches 
to Ramp/Force Curve mode.

Ramp Only Click this button to ramp a variable determined from the 
force curve menu at each point.

Ramp and Capture Click this button to ramp each point, capture the ramp/
force curve, and save it in the Capture Directory.

Point Parameters Image Cursor Mode Settings:

Mark Only—Select points of interest on the image.

M/Ramp—Select points of interest. Software will auto-
matically ramp each point.

M/R/Capture—Select points of interest. Software will 
automatically ramp each point and capture a ramp/force 
curve.

Line Parameters Draw a line to select specific points on an image.

Point Number—Number of points in the line.

Spacing—The distance in nm between each point. All 
points are equidistant.

Clear Path—This button clears the current line and asso-
ciated points.

Convert to Points—Places a + in the location of each 
point in the line. The line disappears.
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Two options are available for moving, in XY, from one point to another:

1. XY move on surface: OFF - Move with tip at home (lift) height.

2. XY move on surface: ENABLED - Move on surface with Z feedback on See Figure 3.1s.

Figure 3.1s   Ramp Parameters > Mode > XY move on surface

Box Parameters Draw a box in the area you want to place a group of points. 
You can use the parameters below to create a grid of 
points.

Row Number—Designates the number of rows of points 
in the grid.

Column Number—Designates the number of columns of 
points in the grid.

Row Space (nm)—Designates the distance in nm between 
each row of the box.

Col Space (nm)—Designates the distance in nm between 
each column of the box.

Clear Path—This button clears the current box and asso-
ciated points.

Convert to Points—Places a + in the location of each 
point in the grid. The box disappears.

Clear All Marks Removes all user-defined marks from the Point and Shoot 
image.

Save Marked List... Save the marks on the image as Path Files (*.psm).

Load Marked List... Opens and loads a previously saved Path File (*.psm) 
which contains marks on a Point and Shoot image. 
Note: If there are points on the image prior to selecting this 
option, when this button is selected the saved marks will 
appear in addition to the previous marks.
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3.1.5 Cantilever Tune

The Cantilever Tune command allows determination of the cantilever resonant frequency and the 
setting of the operating point for TappingMode feedback (see Figure 3.1t). Cantilever Tune 
sweeps the cantilever drive frequency over a selectable range, then displays plots of the cantilever 
amplitude and phase versus drive frequency. This command is enabled only when the Microscope 
mode parameter in the Other panel of the Scan Parameter List is set to TAPPING. On Small 
Sample MultiMode SPMs, verify that the switch located on the base is toggled to TM AFM before 
selecting the Cantilever Tune command. 

Note: The sweep channel is determined by the data selection in the Channel 1, 
Channel 2, or Channel 3 control panels.
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Figure 3.1t shows how the maximum amplitude is attained in air at the cantilever natural 
resonance. Figure 3.1u shows the amplitude is reduced when it is in contact with the sample 
surface.

Figure 3.1t   Tapping Cantilever in Mid-air

Figure 3.1u   Tapping Cantilever on Sample Surface

In TappingMode, the optical lever technique reflects a laser beam off the back of the oscillating 
cantilever, thence to a segmented photodiode. The differential signal between the top and bottom 
photodiode segments provides a sensitive measure of cantilever deflection. As the sample is 
scanned, analog circuitry determines the RMS value of the rapidly changing cantilever deflection 
signal. The RMS value of the cantilever deflection signal corresponds to the amplitude of the 
cantilever oscillation. Changes in amplitude of the cantilever oscillation are controlled by the 
feedback system to track the sample surface.

Laser

Cantilever
Resonant
Deflection 

Tapping Piezo

Photodiode
Detector

Photodiode
Detector

Laser

Cantilever
Resonant
Deflection 

Tapping Piezo
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Access the Cantilever Tune dialogue box, shown in Figure 3.1v, by selecting the Tune icon or by 
selecting Cantilever Tune from the Microscope menu.

Figure 3.1v   Cantilever Tune Dialog Box

Auto Tune Button
Mode Box More Button
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Select Cantilever Tune Dialog Box Definitions:

Auto Tune Parameters:

Mode box Toggles the Auto Tune signal from the main to interleave sig-
nals.

Settings:

Main— Displays the set of parameters applied to the main scan 
(see Section 3.1.7).

Interleave—Displays a duplicate set of parameters applied 
only to the interleaved portions of the scan.

Auto Tune Button Executes the automatic tuning procedure: the cantilever is 
excited through a range of frequencies beginning at the Start 
frequency and ending at the End frequency.

Start frequency Starting point of the Auto Tune frequency sweep.

End frequency Ending point of the Auto Tune frequency sweep.

Target amplitude Targeted output signal amplitude at the photodiode detector. This value 
should not be confused with Drive amplitude, which is the amplitude applied 
directly to the cantilever itself (see Drive amplitude).

Range and Settings: 0.00 to 8.00 V

Note: Dimension Series SPMs, nominal = 500mV
          Small Sample MultiMode SPMs, nominal = 500mV

Peak offset Percentage of cantilever’s free-air resonant frequency to be automatically off-
set. Peak offset is used to compensate for changes in resonance before engage-
ment due to the tip’s interaction with the surface after engagement.

Range and Settings: 0 to 50%; typical value = 5%

Minimum Q Q is the value defined by the amount of oscillation it takes for a wave to drop 
to 1/e (e = 2.718) of its amplitude value (i.e. a wave with an amplitude of ten 
would have a Q of 10/e, or 3.6788). Minimum Q establishes a minimum 
“width of peak” value allowed by the AutoTune function. Peaks not meeting 
the Minimum Q may be ignored by setting the Smash width factor.

Smash width factor The width of the area beneath the wave smashed (set to zero) when a peak not 
meeting the Minimum Q requirement is found. 
Note: This parameter does not appear if Minimum Q is 0.
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3.1.6 Electric Tune

Theory

When evaluating Surface Potential, you can now tune the cantilever electrically. Traditional 
cantilever tune oscillates the cantilever via tapping piezo material (see Figure 3.1w). Electric Tune 
sweeps the frequency of the electric field surrounding the cantilever. The force of the electric field 
moves the cantilever. The cantilever amplitude is then plotted in the Generic Sweep dialogue box.

Figure 3.1w   Cantilever Tune Method Comparison

Traditional Cantilever Tune

Electric Field

Electric Field

Piezo Material Oscillates the Cantilever

Electric Tune 

Change the Electric Field Frequency
to Oscillate the Cantilever
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Procedure

1. While evaluating Surface Potential in Realtime mode, select Microscope > Generic Sweep. 
The Generic Sweep dialogue box, shown in Figure 3.1x, will display.

Figure 3.1x   Typical Generic Sweep

2. Select Interleave as the Mode (see Figure 3.1x).

3. In the Generic Sweep dialog box, set the Sweep parameters Input igain and Input pgain to 
0. This disables the Surface Potential feedback loop, which works to keep the cantilever's 
amplitude at zero.
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4. You can adjust several parameters to acquire interesting data:

• Try changing the Data Scale, Drive Phase and Drive Amplitude (see Figure 3.1y).

• Try changing the channel. For example, the Data Type can be changed to Potential 
Input.

• Try sweeping another channel. For example, set the Graph parameter Sweep Output to 
Bias (see Figure 3.1y).

Figure 3.1y   Electric Tune Generic Sweep while adjusting the Drive Amplitude and Drive Phase

Note: Remember to re-enable the Input gains before collecting further Surface 
Potential data.
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3.1.7 Scan Interface

The Scan display includes an image viewer, color bar, scope viewer, vision control viewer (for 
systems configured with vision controls), and numerous parameters to configure Scan data 
collection. Most SPM operators use only a few of these parameters to obtain images. The 
parameters within each panel are also microscope-specific or level-access dependent and may be 
greyed out or hidden, depending on microscope configuration.

Scan Interface:

User-Defined Parameters in the Scan View

Clicking on a parameter and then dragging the mouse back and forth increases or decreases a 
parameter value much like an old analog slider. The significance, range of acceptable values, and 
specific information about control panel parameters are discussed in this section.

Parameters listed in the Scan Parameter List depend on the microscope selected, the Experiment 
type and the experiment Mode. Parameters necessary for one style of microscope are not 
applicable to another. For example, the Drive frequency and Drive Amplitude parameters are 
enabled on the Feedback tab only when the mode is set to TappingMode.

Some users find operating an SPM less confusing if the number of parameters is limited to only the 
most essential ones. For this reason, the Simple Mode contains the minimum number of user 
specified parameters.

Image Window During scanning, the Realtime image of the sample appears along with a 
small blue cursor on the left. The cursor moves along the image vertically to 
show the engaged tip position on the surface. The Measure button at the top 
of the scan allows you to make line measurements. the Zoom and Offset but-
tons below the scan change the scan size and location while the Magnify but-
ton above allows you to “zoom in” to a smaller view, but doesn’t change the 
scan size. The Pan button allows you to pan over to other areas of the total 
scan if you are zoomed in.

Color Bar Sets the color table for viewing height data in the image window. Left-click 
on the color bar and drag the mouse left or right. Right-click to open the 
Color Adjustment dialog box.

Image Parameters Configure options below the image window to select the channel and image 
display values, (e.g. Data type, Line direction, Data scale, and so on).

Vision Window The Vision window displays the video image.
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3.1.8 Scope Trace Plot

The Scope window, shown in Figure 3.1z, displays a plot of the probe position versus channel data 
in an oscilloscope-type format.

Figure 3.1z   Scope Grid

Scope Trace Interface

By right-clicking the Scope grid, you will get a menu of different options, shown in Figure 3.1aa.

Figure 3.1aa   Scope Grid Parameters
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 These menu options allow you to make the following changes:

Color Allows operator to change color of:

• Curve (data)

• Text

• Background

• Grid

• Minor Grid

• Markers

Filter Typically used for a Profiler Scan.

• Type—Allows the user to plot the mean, maximum or 
minimum y-value per x-value.

• Points—Allows user to plot multiple vertical axis (y) values 
at each horizontal axis (x) value. Select 4K, 8K, 16K or 32K 
Points to limit the display to 4, 8, 16 or 32 times 1024 points.

Minor Grid Places a minor grid in the background of the Vision Window.

Scale Allows user to auto scale, set a curve mean, or set their own data range.

X Translate Offsets the curve by placement of vertical cursor on the grid. Grab vertical 
cursor in the space above the grid and pull down onto grid.

Y Translate Offsets the curve by placement of horizontal cursor on the grid. Grab hori-
zontal cursor in the space next to the grid and pull onto grid.

Line Style For each curve, operator can choose, connect, fill down, or point.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard.

Print Prints out the current screen view to a physical printer.

Export Exports data in bitmap, JPEG or XZ data format.

Active Curve Determines which curve you are analyzing.
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3.1.9 Scan Panel Interface

The Scan panel, shown in Figure 3.1ab, includes parameters influencing piezo movement and data 
acquisition, as well as the ability to execute non-square scans. This panel is probably the most 
frequently used panel, as it controls what type of scan to run, how large the scan is, its angle, scan 
rate, and number of samples per scan line.

Figure 3.1ab   Scan Panel Parameters, Contact in Expanded Mode

Scan Panel Parameters

Scan size Determines the size of the scan by controlling the voltage applied to the 
X and Y piezos.

Range or Settings:

• 0 to 440V

• 0 to XXµm (scanner-dependent)

The units of this parameter are volts if the Units parameter (Other 
panel) is set to Volts. The units are linear distance (nm or µm) if the 
Units parameter is set to Metric.

See also, Optimizing the Scan Size Parameter on page 123.

Aspect ratio Controls the width-to-height size ratio of scans. Set the Aspect ratio to 
1.00 for square scans. An Aspect ratio of 2.00 yields scanned images 
having width equal to twice the height. 

Range or Settings: (depends upon the number of scan lines) 1 to 256.
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Figure 3.1ac   Aspect Ratio Example

Figure 3.1ad   Scan Angle Rotated Example.

X offset, Y offset Controls the center position of the scan in the X and Y directions, 
respectively.

Range or Settings: ±220V; ± XXµm (dependent on Scan size and 
scanner).

See also, Optimizing the X Offset, Y Offset Parameter on page 124.

Scan angle Controls the angle of the X (fast) scan relative to the sample.

Range or Settings: 0 to 359° (Any angular value can be entered with 
the keyboard)

Changing this parameter can dramatically affect the quality of 
images due to tip effects (tip side wall angle).

Setting this parameter to a setting besides 0 or 90° may reduce the 
maximum allowable Scan size 10-20 percent due to corner con-
straints (see Figure 3.1ad).

Scan rate The Scan rate sets the number of fast scan lines performed per sec-
ond. When the Scan rates are low, it can take a fairly long time to 
scan an entire frame. For example, with the Scan rate set to 0.5Hz 
and the Number of samples set to 512, it can take over 17 minutes 
to capture a single image.

Range or Settings: 0.1-237Hz, depending on the number of 
Samples/line.

See also, Optimizing the Scan Size and Scan Rate Parameters on page 124.

1.00

4.00

8.00

16.00
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Table 3.1a   File Size/Samples per line

Note: Samples/line should be kept at 512 or higher for high resolution scans. To 
increase the frame rate (rate at which complete images are generated), the 
Lines parameter should be reduced. When the Lines parameter is reduced, file 
sizes in Table 3.1a are reduced accordingly.

Note: Disabling the Slow scan axis and viewing the Scope display is a convenient 
way of setting the Feedback Gain parameters. 

Lines Selects the number of lines to scan in a frame. The Lines parameter 
reduces resolution along the Y axis. It also speeds imaging (or frame 
rate) and reduces the size of the resulting image file. 

Range or Settings: 2 to 1024. The maximum number of lines may be 
limited by the value for Samples/line.

Tip velocity Velocity of the tip (in µm/s) as it scans over the surface.

When Tip Velocity is changed, the Scan Rate adjusts automatically.

Samples/line Selects the number of sample data points per scan line.

When this parameter is changes, the number of scan lines per image 
(Lines) are automatically adjusted to maintain the same ratio 
between the samples/line and lines per image.

Range or Settings: 128 to 16384. This setting influences the mem-
ory size of captured files and image resolution (see Table 3.1a).

Samples/line value
File size (for square 
scans, including 8K 

header)

128 40Kb

256 136Kb

512 520Kb

Slow scan axis Allows the slow scan to be disabled, causing the fast scan to be 
repeated continuously at the same position. This means that the image 
displays the same line continuously. Images may be presented either as 
“true” X-Y renderings of the sample surface (Enabled), or as 
“stretched” single-line scans of length equal to the Scan size (Dis-
abled).

Range or Settings:

• ENABLED—Sample is scanned in the slow scan 
direction. (This is the normal setting of this parameter.)

• DISABLED—No scanning of the sample in the slow 
direction is performed. The fast scan is repeated at the 
same position.
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The advantage of using the Slow Scan Axis > DISABLED parameter is to emphasize one area (line) 
to adjust the SPM parameters. For example, an area of the image that appears fuzzy (suggesting 
SPM parameters are not optimized for the sample). DISABLE the Slow Scan Axis, view the Scope 
trace, and reconfigure scan parameters to optimize the scan. 

Note: Setting the Slow scan axis parameter to DISABLED stops the slow scanning of 
the piezo, but does not stop the movement of the Realtime display in Y. Lines 
are replicated in the Y direction.

3.1.10 Channels Interface

The Channels interface (see Figure 3.1ae) consists of parameters for eight channels. Each channel 
represents a unique scanning image. Up to eight data Channels may be opened by selecting each 
channel and choosing a data type to view simultaneously. Channels are numbered 1, 2, 3... and 
feature their own control panels. When a Data type is selected on a Channel, its image appears. It is 
possible to have up to eight separate images from each scan. For example, a TappingMode scan 
might simultaneously present a Height Sensor image on Channel 1, a TM Deflection image on 
Channel 2, and a Phase image on Channel 3. 

Parameters shown on each Channel control panel vary slightly, depending upon the type of 
microscope selected and operating mode.

You may access the Channel controls through either the panel below the scope trace of each 
channel or the Channel panels in the Scan Parameter List in the EXPANDED MODE. See Figure 
3.1ae.

Figure 3.1ae   The Channels Interfaces: Scan Parameter List, Expanded Mode (top); Scan Interface (below)
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Channel Parameters

Data Type Range or Settings 

Data Type Settings vary, depending upon the microscope selected and operating mode 
as shown in the field descriptions below. The Data Type parameter may 
receive: no data (OFF); sample-height data (HEIGHT); cantilever oscillation 
amplitude data for TappingMode (AMPLITUDE); cantilever deflection data 
(DEFLECTION); STM current data (CURRENT); phase data (PHASE).

     See also, Optimizing the Data Type Parameters on page 125.

Amplitude (TappingMode 
and Force Mode only)

The RMS of the cantilever amplitude signal is displayed and captured.

Current (STM only) Data displayed and captured is the tunneling current generated by the pream-
plifier. (When set to Current, the units of the data are nA.)

TM Deflection Cantilever deflection signal data is displayed and captured. (When set to TM 
Deflection, the units of the data are in distance or volts.)

Height The Z piezo voltage set by the feedback calculation in the Digital Signal Pro-
cessor (DSP) is displayed. (The displayed data comes from the voltage output 
to the Z piezo.) Units are distance (e.g., nm, µm, etc.). Standard imaging of 
topography.

Height Sensor Displays the signal from the Z position sensor in the closed loop head.

Off Channel is turned off.

Phase (MFM, EFM) Phase data from oscillating TappingMode tips, generally used with Magnetic 
Force Microscopy (MFM) and Electrical Force Microscopy (EFM), is dis-
played and captured. This setting appears when the microscope is configured 
with an Extender™ Electronics Module.

Potential (EFM) Surface potential data is displayed. (For detailed information on Surface 
Potential or EFM features, see Support Note 231, Electric Force Microscopy 
on the MultiMode Systems.)

Deflection Cantilever deflection signal data is displayed

Friction Torsional deflection signal data is displayed
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Data scale The Data Scale controls the Z scale corresponding to the full height of the dis-
play and color bar.

Range or Settings:

• 0.0067 to 440V (Data type set to height, Units are set to 
volts).

• XX to XXX µm (Scanner dependent; where Data type is set to 
height, Units set to metric).

• XX to XXX µm (Sensitivity dependent; where the Data type 
is set to deflection or amplitude; Units are set to metric).

• 0.00003815 to 2.5V or 20V (Data type set to amplitude; Units 
set to volts or deflection)

• 0.0031 to 200nA (Data type set to current; Units are set to 
metric).

• 0.0003052V to 20V (Data type set to current; Units are set to 
volts).

See also, Optimizing the Data Scale Parameters on page 125.

Data center Offsets centerline on the color scale by the amount entered.

The Data Center offset does not become a permanent part of the data.

Range or Settings: 

• ± 220V

Line direction Selects the direction of the fast scan data collection that is displayed in the 
image.

The feedback calculation is always performed regardless of the scan direction. 
This parameter simply selects whether the data is collected on the trace or the 
retrace. This parameter selects the relative motion of the tip to the sample.

Range or Settings:

• TRACE—Data is collected when the relative motion of the tip 
is left to right as viewed from the front of the microscope.

• RETRACE—Data is collected when the relative tip motion is 
right to left as viewed from the front of the microscope.

Scan line The scan line controls whether data from the MAIN or INTERLEAVE scan line 
is displayed and captured. 

Range or Settings: MAIN or INTERLEAVE

This parameter is not selectable when the Interleave mode parameter is set to DISABLED. The system is 
locked on the Main scan lines whenever the interleaved mode is turned off.
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3.1.11 Feedback Interface

The Feedback parameters allow for monitoring the signals between the NanoScope Controller and 
the cantilever. These signals adjust the setpoint, oscillation frequency, drive voltage, Z response for 
surface tracking, and output voltages. The purpose of the Feedback controls is to maintain a 
constant setpoint (deflection, amplitude, or current) in the Feedback Loop for tip/sample control 
and tracking optimization. Parameters listed in the Feedback tab depend on the microscope 
selected and the Mode.

Figure 3.1af   Feedback Controls Tab in EXPANDED TappingMode

Realtime Planefit Applies a software leveling plane to each Realtime image, removing up to first-
order tilt. Three types of planefit are available to each Realtime image.

Range or Settings:

• NONE—Only raw, unprocessed data is displayed.

• OFFSET—Takes the Z-axis average of each scan line, then 
subtracts it from every data point in that scan line.

• LINE—Takes the slope and Z-axis average of each scan line and 
subtracts it from each data point in that scan line. This is the 
default mode of operation, and should be used unless there is a 
specific reason to do otherwise.

 Offline Planefit Applies a software “leveling plane” to each captured image for removing up to 
first-order tilt. Three types of planefit are available to each Offline image.

Range or Settings:

• NONE—Only raw, unprocessed data is displayed.

• OFFSET—Captured images have a DC offset removed, but they are 
not fitted to a plane.

• FULL—A best-fit plane which is derived from the data file 
subtracted from the captured image.

See also, Optimizing the Offline Planefit Parameter on page 125.
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Feedback Control Parameters

Z Modulation (Fluid TappingMode 
only)

Allows the user to add the drive oscillation signal to the Z piezo 
voltage. This parameter is used to set up fluid cell oscillation in 
any Dimension system for Fluid TappingMode.

Range or Settings:

• ENABLED—Enables Z modulation. Drive 
oscillation signal (Drive Frequency) is added to Z 
piezo voltage. When enabled, the Z limit must 
be set 420V.

• 0—Disables the Z modulation (i.e., no additional 
signal is added to Z piezo voltage).

The desired Drive Amplitude and Drive Frequency voltages 
(Cantilever Tune) need to be set for Fluid TappingMode opera-
tion.

SPM Feedback Selects the signal to be used for tip feedback according to the 
selected Microscope Mode parameter (Other panel). For Con-
tact AFM, the choice defaults to Deflection; however, for Tap-
pingMode, you may select either the TM Deflection or the 
Amplitude. STM offers two choices of feedback: Linear and 
Log.

Range or Settings:

• TappingMode—Amplitude, TM Deflection- 
Phase (Forcemod only)

• Contact Mode—Deflection only

• STM—Linear, Log

   Linear—The linear difference between the instantaneous tun-
neling current and the Setpoint current is used in the feedback 
calculation.

   Log—The difference between the log of the instantaneous tun-
neling current and the log of the Setpoint current is used in the 
feedback calculation.

     See also, Optimizing the STM Feedback Parameters on page 126.

Input Feedback Controls Frequency Modulation (MFM or EFM) and Surface 
Potential.

Integral Gain Controls the amount of integrated error signal used in the feed-
back calculation.

Range or Settings: 0 to 1024

     See also, Optimizing the Integral and Proportional Gain on page 126.

Gain settings vary, depending upon the scanner used, the sample and scanner sensitivity. See Table 3.1b for 
approximate, nominal values (assumes a Scan rate of  2.5Hz).
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Table 3.1b    Typical Integral Gain Ranges:

Scanner
Contact AFM and 

Forcemod TappingMode STM

Aa

a. For atomic-scale images, scan rate must be increased to approximately 
60 Hz.

4.0 - 20.0 0.4 - 2.0 0.3 - 5.0

Proportional Gain Controls the amount of the proportional error signal used in the 
feedback calculation. The Proportional gain term in the feed-
back calculation has equal gain at all frequencies; therefore, it 
has a dominating effect over the Integral gain for high frequen-
cies (scan rates).

Range or Settings: 0 to 1024

(Typical settings for the Proportional gain parameter are 35-
100% more than Integral gain values).

Setpoint The meaning of this parameter depends on the operating mode of 
the microscope as follows:

Amplitude Setpoint (TappingMode)—defines the amplitude of 
the cantilever oscillation signal to be maintained by the feedback 
loop. (Range: 0.00 to 10.00V)

Deflection Setpoint (Contact Mode)—Controls the deflection-
signal level used as the constant desired voltage in the feedback 
loop. (Range: -12.00 to 12.00 V)

Current Setpoint (STM)—Controls the constant current main-
tained by the feedback loop. (Range: 0.0 to 100.0nA)

Drive Frequency (TappingMode and 
Force Mode only)

Selects the oscillation frequency applied to the piezoelectric 
crystal that vibrates the cantilever.

Range or Settings: 0.00 to 250MHz

The Center Frequency is adjusted with the Cantilever Tune 
command to find the resonance frequency of the cantilever. The 
maximum cantilever oscillation amplitude occurs at its resonant 
frequency. The software sets the Drive Frequency equal to the 
current Center frequency value when the OK button in the Can-
tilever Tune control panel is pressed.

Drive Phase (TappingMode and Force 
Mode only)

Selects the phase of the drive voltage applied to the piezoelectric 
crystal that vibrates the cantilever.
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Drive amplitude (TappingMode and 
Force Mode only)

Selects the amplitude of the drive voltage applied to the piezo-
electric crystal that vibrates the cantilever.

Range or Settings: 0.00 to 20.00V

The Drive Amplitude is also adjusted with the Cantilever Tune 
command. Increasing the Drive Amplitude increases the cantile-
ver-oscillation amplitude. The cantilever-oscillation amplitude is 
increased to an appropriate level with the Cantilever Tune com-
mand. In AutoTune, the Drive Amplitude automatically adjusts 
to get a cantilever oscillation (rms amplitude) equivalent to the 
user’s Target amplitude.

Bias Controls the sign and magnitude of the bias voltage applied to the 
sample.

Range or Settings: -10.00 to 10.00V

When used with STM, typical settings for the Bias voltage 
parameter are 20 to 100mV for conductive samples and up to 
several volts with poorly conducting samples. Positive settings of 
the Bias voltage item correspond to negative current (electrons) 
tunneling from the tip into the sample on heads with the Bias 
applied to the Sample or Tip.

Analog 1, 3, 4 This voltage has no effect on the operation of the standard micro-
scope, but is useful in custom applications.

Range or Settings: -10.00 to 10.00V.

Aux Lockin Directs an external input signal through the auxiliary lock-in 
amplifier.

Drive Phase The phase of the AC bias signal applied to stimulate piezore-
sponse.

Lockin BW The bandwidth of the effective bandpass filter centered on the 
TTL level reference frequency (i.e., the cantilever drive fre-
quency in the NanoScope Controller) used by the main lock-in 
amplifier.

Lateral 16x Gain Increases the lateral gain 16 times. This should be set to 
Disabled for most applications.

Range or Settings: DISABLED, ENABLED
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3.1.12 Interleave Mode

• Interleave—Adds a second, interleaved set of lines to the scan, which can be accessed 
from the Channel panel and captured as data. Invoking Interleave reduces the slow axis 
speed by one-half and doubles the capture time.

• Lift—A variant of Interleave, the Lift option uses the first set of scan lines to detect the 
surface, then lifts the probe above the sample surface on the interleaved set of scan lines 
according to the Lift start height and Lift scan height parameter settings. During the 
Interleaved scan, the tip mimics the surface topography from the previous surface scan 
line (see Figure 3.1ag). 

Figure 3.1ag   Interleave Lift Mode

• Disabled—Turns off the interleave scanning.

Lift scan height Specifies the tip’s height above the sample surface during interleaved scans. 
This parameter is in effect ONLY when the Interleave mode parameter is set 
to Lift (see Figure 3.1ah).

Range or Settings: XXµm (Scanner dependent)

The maximum meaningful value of the parameter depends on the Z voltages 
applied in the Main scan line and the maximum voltage that the system can 
output. The maximum voltage that can be applied to the piezo is ±220V. It 
will be lower if the Z voltage is restricted by the Z limit parameter.
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Figure 3.1ah   Lift Scan Height Illustrated

Figure 3.1ai   Lift Start Height Illustrated

Tips for Using the Lift Start Height Parameter

• This value can be left at zero for TappingMode and STM. It is generally only used for 
Contact AFM to break the tip free of the adhesive force produced by the water layer 
before settling to the final tip height.

The tip will go through this height at the start of every lifted scan line, then proceeds to the lift scan 
height for the rest of the scan line.

Lift start height Specifies the height that the tip is to be lifted above the sample surface at the 
start of each interleaved scan. Generally, this parameter serves to lift the tip 
clear of any contamination layers present on the sample before assuming its 
Lift scan height during interleaved scans. This parameter is in effect ONLY 
when the Interleaved mode parameter is set to Lift. This parameter defines 
an offset from the Z voltage, or height, applied to the piezo on the Main scan 
line.

Range or Settings: XXµm (Scanner dependent)
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Linked Parameters Range or Settings

Several parameters (e.g. Z modulation, SPM Feedback, etc.) are highlighted by dark gray or green 
background. Dark grey indicates that the parameters are coupled with the equivalent values in the 
Feedback panel. By selecting (left-click) the Interleave parameters, the grey field turns green, 
indicating that the Feedback and Interleave parameters are decoupled and the value in those 
parameters will be used as feedback during the interleave scan line.

Figure 3.1aj   The Interleave Panel

Input Igain Integral gain for Frequency modulation. Controls the feedback loop that uses 
phase electronics.

Input Pgain Proportional gain for Frequency modulation. Controls the feedback loop that 
uses phase electronics.
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3.1.13 Limits Panel

The Limits panel, shown in Figure 3.1ak, sets the Z tracking limits.

Figure 3.1ak   The Limits Panel

Z limit Permits attenuation of maximum allowable Z voltage and vertical scan range 
for achieving higher resolution (smaller quantization) in the Z direction.

Range or Settings:

11 to 440V (with Units set to Volts) for the XY Closed loop head
11 to 330V (with Units set to Volts) for the XYZ and Dimension Icon Closed 
loop head

Note: In previous software versions, engaging with Z LIMIT  Z 
max could result in a tip crash and the operator was warned by 
a message on the screen. Engage in versions 7.0 and later is 
always done with Z LIMIT = Z MAX. Therefore the warning is 
no longer needed.

Deflection Limit Use this parameter for attenuating the input voltage signal (appears only 
when performing Contact AFM). Appears as TM Deflection Limit in Tap-
ping mode.

Range or Settings:

•  2.500V to 20.0V for regular imaging

•  24.58V in Force Mode only

Amplitude Range Use this parameter for attenuating the input voltage signal (appears only for 
TappingMode or STM).

Range or Settings:

• 1000, 2000, 3000 or 4000mV for regular imaging
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3.1.14 Other Panel

The Other controls parameters set the type of microscopy, units to use in measuring and other 
parameters specific the to microscope mode (i.e., the parameters that appear in the Other panel will 
vary from one microscope to another).

Figure 3.1al   Other Panel

Parameters in the Other Controls Tab:

Microscope Mode Selects the type of microscopy to be employed. Switching this parameter 
enables/disables other parameters. Also, on MultiMode SPMs, any change 
to the Microscope mode must be accompanied by use of the mode selector 
switch on the microscope’s base.

Range or Settings:

Contact, Tapping or STM

Units Selects whether the units of certain scan parameters are in Volts or in units of 
Metric distance (nm, etc.). Parameters affected include Scan size, X Offset, 
Lift start height and Lift scan height, Y Offset, Data Scale, Z Limit, Z Scan 
Start, Ramp Size, Column Step and Row Step.

Range or Settings:

• Volts—Parameters are in Volts.

• Metric—Parameters are in units of distance (nm, µm, etc.) 
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Engage Setpoint (Tap-
pingMode only)

Allows the user to correct for loss of tracking on engage due to sample dif-
ferences. The automatic Engage procedure establishes the setpoint voltage at 
the smallest possible value that detects the sample surface, resulting in a 
value that protects both the sample surface and the cantilever tip. However, 
this value may not be sufficient for optimal surface tracking on all samples. 
The setpoint voltage determined by the automatic Engage procedure will be 
multiplied by the Engage Setpoint value, increasing or decreasing tapping 
force.

Range or Settings: 

0.5 through 2.0. A value of 1.0 results in no change to the tapping force. Val-
ues less than 1.0 increase the tapping force and values greater than 1.0 
decrease the tapping force. A value of 0.9 is nominal for most samples.

Example of Engage Setpoint

The Engage Setpoint for a particular sample may be empirically deter-
mined. Procedures are as follows:

1. Set the Engage Setpoint to 1.0 and engage on the sample. 

2. After engagement, make note of the Setpoint parameter. 

3. While watching the scan, adjust the Setpoint value until the tip 
tracks the surface correctly. Calculate the following: 

(Setpoint value/Starting Setpoint value) = Engage Setpoint 
(For optimal value, take the average of several engages on a selec-
tion of samples or different areas of the same sample).

Bidirectional Scan When the Bidirectional scan parameter is Enabled, data from both Trace and 
Retrace scans are used to capture frames in half the normal time. Images 
have alternately shifted lines, which cause features to lose some of their lat-
eral definition; however, data may be used for metrological analysis. Use to 
save time while capturing images.

Range or Settings: 

Enabled or Disabled

When Enabled, features shown in images lose some lateral definition, mak-
ing point-to-point measurements inadvisable. Vertical data, however, is unaf-
fected.

Use the Scan line shift parameter to readjust images with the Bidirectional 
scan parameter Enabled. This will shift scan lines relative to one another to 
restore some lateral definition in features.

Scan Line Shift Use the Scan Line Shift parameter to shift trace and retrace lines relative to 
one another by up to 5 pixels in either direction. Units are in pixels and range 
from -5 to +5. Scan line shift is used for readjusting images captured when 
the Bidirectional scan parameter is Enabled.

Range or Settings: -5 to +5

This parameter is generally only for images that have been captured with the 
Bidirectional scan parameter set to Enabled.

Tip Serial Number Saves input in the image header (Ciao Scan List) for users who keep a tip fil-
ing system. This is to keep track of the tips used for certain images.

Serial Number Scanner Calibration file.
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Min. Engage Gain 
(STM only)

Allows user to engage tip in constant height mode. In constant height mode, 
the gains (feedback) is disabled. However, the Min. Engage Gain parameter 
provides for gain during engagement.

Strip Chart Rate Frequency of (Z-position, deflection) data point acquisition.

Range: 1kHz

Typical value: 100Hz

Strip Chart Size Time interval over which (Z-position, deflection) data points are displayed.

Typical value: Tens of seconds.

Note: Although the strip chart collects and displays data over the time inter-
val defined by clicking Start, then later, Stop, this data is not saved for sub-
sequent use until the Capture icon is clicked. If Capture is clicked while 
strip chart data is being taken, what is saved begins at the start of the chart 
(sooner than the icon is clicked).
Rev. D NanoScope Software 8.10 User Guide 105



Realtime Views
Tips on Using Realtime

10
3.2 Tips on Using Realtime

Refer to the following Realtime commands available on the NanoScope software:

• Using the Image Interface Section 3.2.1

• Multiple Channels Section 3.2.2

• Hints to Optimize the Engage Button Section 3.2.3

• Tapping Engage Section 3.2.4

• Scan View Parameters Tips Section 3.2.5

• Channels Parameters Tips Section 3.2.6

• Feedback Parameters Tips Section 3.2.7

• Signal Access Software Section 3.2.8
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3.2.1 Using the Image Interface

There are various commands available for use during a Realtime scan. A description of these 
commands follows.

Figure 3.2a   A NanoScope Realtime Scan Window
Rev. D NanoScope Software 8.10 User Guide 107



Realtime Views
Tips on Using Realtime

10
AutoScale

The AUTOSCALE ON/OFF button, shown in Figure 3.2a, appears below the color bar in both the 
image and thumbnail windows. Auto scaling is performed in selected windows according to user-
defined auto scaling rules. These rules are defined in the Configure AutoScale window, shown in 
Figure 3.2b.

Figure 3.2b   Configure AutoScale

Open the Configure AutoScale window either by clicking TOOLS > CONFIG AUTOSCALE, shown 
in Figure 3.2c, or by right-clicking an AUTOSCALE ON/OFF icon.

Figure 3.2c   Click TOOLS > CONFIG AUTOSCALE
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Channel to Be AutoScaled Panel 

Click the AUTOSCALE ON/OFF icon, shown in Figure 3.2d, at the bottom of the color scale to turn 
AutoScaling ON (green checkmark) or OFF (red X).

Figure 3.2d   AutoScale On/Off

Automatic Trigger Panel 

Ch1 ... Check the channels that you wish to AutoScale.

Engage AutoScales the selected channels after engaging.

Scan Size/Offset Change AutoScales the selected channels after a change in Scan Size or Offset.

End of Frame AutoScales the selected channels at the end of a frame.

Trigger Time Delay After 
the Event (sec)

The delay after a trigger event before AutoScaling is applied.
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Autoset Configuration Panel 

Figure 3.2e   Height image of Hyaluronic Acid

Figure 3.2f   Histogram of image in Figure 3.2e with the Low Clip and High Clip portions circled.

You may force AutoScaling on all selected channels at any time by clicking the AUTOSCALE 
IMAGE DATA SCALE icon, in the NanoScope toolbar.

Range Factor Sets the vertical scale to be Range Factor * (range of data after clipping).

Low Clip (%) The Low Clip function clips a small, user-adjustable, number of pixels to 
accommodate long tails in the bottom of the distribution. See Figure 3.2f.

High Clip (%) The High Clip function clips a small, user-adjustable, number of pixels to 
accommodate long tails in the top of the distribution. See Figure 3.2f.
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Image Buttons

The NanoScope image buttons, shown in Figure 3.2g, are located above the scan window and are 
described in Table 3.2a.

Figure 3.2g   NanoScope image buttons

Table 3.2a   NanoScope image buttons

Measure Allows you to draw a box to make measurements, translate the image or offset and resize the image.

Pan From a zoomed image, you can pan around to other areas of the original image.

Data Zoom Left-click, hold, and drag out a box. Release the mouse button and the image will automatically 
zoom in to the area of the box. The original scan size remains the same.

Resize Up Resizes the image up to the previous zoom level.

Resize Down Resizes the image down to the previous zoom level.

Measure

Pan

Data Zoom

Resize Up

Resize Down
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Zoom and Offset Buttons

Three scan control button are below the Scan window:

• Zoom: Allows you to zoom in on a region of interest. 

• When you select Zoom a bounding box appears on the image display. Left-click on 
the outer edge of the box to resize. 

• Left-click in the center to reposition. 

• Click the Execute button to zoom in. This updates the Scan size and X and Y 
Offset parameters.

• Execute: Executes the Zoom and Offset commands. You must select the Zoom or 
Offset button for the Execute button to appear.

• Offset: Allows you to center the scan at the region of interest. 

• When you select Offset a crosshair displays at the center of the image.

• Left-click and hold the crosshair to reposition it.

• Click the Execute button to center the scan. This updates the X and Y Offset 
parameters.

Right-Clicking on the Image

By right-clicking on the image, you will get a menu that allows you to perform the following tasks:

• Box:

• Draws a box when in Measure mode

• Rotating Line

• Draws a line when in Measure mode

• Copy Clipboard: Copies the image to the Microsoft™ clipboard.

• Tooltip Info Level:

• Basic

• Medium

• Advanced

• None
2 NanoScope Software 8.10 User Guide Rev. D



Realtime Views
Tips on Using Realtime
Right-Clicking on the Color Bar

Right-clicking on the color bar along the right side of the image (see Figure 3.2a) will produce a 
Color Scale button (see Figure 3.2h). Clicking on this Color Scale button will open the Color 
Adjust menu, shown in Figure 3.2i, where you can perform the following image adjustments:

Figure 3.2h   Color Button

a.  You can adjust the color by changing the Contrast or Offset settings.

• Contrast—Number (-10 to +10) designates contrast of colors in displayed image 
(e.g., 0 shows little change, while 10 shows highest contrast).

• Offset—Number (-128 to +128) designates offset of colors in displayed image (e.g., 
120 shows illuminated background on image).

• Table—Number (0 to 24) designates which color table will be used.

b. Clicking the Color Reset button will change all the current readings to the default 
settings.

Figure 3.2i   Color Adjust Menu

c. To change the color table, position the mouse over the color bar on the right side of the 
image. Click and hold the left mouse button, then drag the mouse from left to right to 
scroll through the different color tables or set the table number in the Color Adjust 
window.
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 Using the Mouse Within a Captured Image in Measure Mode

Figure 3.2j   Image Cursor Menu

Using the Grid Display

Measurement cursors for the Scope window are provided to the left and right of the Grid Display. 
You can bring the cursors into the grid by placing the mouse cursor outside of the grid, clicking and 
holding the left mouse button, and dragging them onto the grid. When you place the mouse cursor 
onto a measurement cursor, the cursor will change from a plus sign to a horizontal or vertical 
arrowhead cursor, which indicates you can grab and drag this cursor.

Left-click anywhere in image 
window, drag line out, and 
release

Creates a line of X length, at Xo of angle in the image window.

Place cursor on line Displays length and angle values of line in the image window.

Place cursor on line, click 
and hold left button, and 
drag

Allows you to drag the line anywhere in the image window.

Click and hold on either end 
of line and drag

Changes length and/or the angle of the line.

Right-click Clicking the right mouse button when the cursor is on the line 
accesses the Image Cursor menu (see Figure 3.2j).

• Delete—Deletes the line.

• Flip Direction—Switches the line end to end.

• Show Direction—Adds small arrowhead to the line to 
indicate its direction.

• Set Color— Allows you to change the color of the 
line.

• Clear All—Deletes the line.
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Right-clicking on the grid will bring up the Grid Parameters menu, shown in Figure 3.2k, and 
allow you to make the following changes:

Color Allows operator to change the color of the:

• Curve (data)

• Text

• Background

• Grid

• Minor Grid

• Markers

Filter Typically used for a Profiler Scan.

• Type—Allows the user to plot the mean, maximum or 
minimum y-value per x-value.

• Points —Allows user to plot multiple vertical axis 
(y-)values at each horizontal axis (x-)value. Select 4K, 
8K, 16K or 32K Points to limit the display to 4, 8, 16 
or 32 times 1024 points.

Minor Grid Places a minor grid in the background of the Vision Window.

Scale Allows user to auto scale, set a curve mean, or set their own data 
range

Translate Offsets the curve by the placement of a horizontal cursor on the grid

Line Style For each curve, the operator can choose a connect, fill down, or point 
line.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard

Print Prints out the current screen view to a physical printer

Export Exports data in bitmap, JPEG or XZ data format

Active Curve Determines which curve you are analyzing
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Figure 3.2k   Grid Parameters

Default Configuration Settings

NanoScope software, starting with version 7.10, remembers your customized configurations, both 
RealTime and Offline. You may customize your use of this feature by selecting Tools > Options > 
Default Configuration Settings.This will open the Default Configuration Settings window 
shown in Figure 3.2l.

Figure 3.2l   Default Configuration Settings Window

Default Configuration Settings Buttons

• Do not use Default Configuration Settings—Turns off the Default Configuration 
Settings feature and opens views using factory settings.

• Use configuration settings, do not save new settings when closing views—Uses your 
customized settings but does not save the current settings for future use.

• Save Cursor Settings—Saves the cursor locations. Cursors will appear when you open 
the same view at a later time. This only works well if you open a view with the same 
horizontal and vertical resolution.
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3.2.2 Multiple Channels

It is often helpful to view more than one channel of data simultaneously. The Scan View Layout 
buttons, shown in Figure 3.2m, in the NanoScope toolbar allow you to display one, two or four 
channels simultaneously. The SCAN DUAL and SCAN 8 CHANNELS perform similar functions in the 
dual 19” monitor configuration. See Figure 2.3i.

Figure 3.2m   Single monitor scan layout icons

Image controls are displayed beneath each image. 

The currently displayed channel is highlighted. The image parameters may be set independently for 
all channels including data type and scale, plane fitting and color table. Settings common to all 
channels can be set through the Scan Parameter List.

Typical examples of the use of multiple channels:

• To simultaneously monitor both a TappingMode height image and a phase image of the 
same region.

• To simultaneously collect a topography and MFM image.

Thumbnails Only

Two Channels Down

Four Channels

One Channel

Two Channels Across
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3.2.3 Hints to Optimize the Engage Button

• When used with stepper-motor-engagement microscopes, the tip is lowered under 
program control. While the tip is being engaged, the tip travel distance is shown in the 
status bar. When the surface is detected, the workstation beeps, starts the RealTime 
imaging process, and displays Engaged in the status bar.

• During automatic engagement, the tip will travel a preset distance (200µm for 
Dimension AFMs, 125µm for MultiMode AFMs). If the sample surface is not detected 
in this distance, an error message will be displayed.

• If the tip is on the surface and the Z center voltage indicates that the piezo is near full 
extension or retraction, the tip may be withdrawn and re-engaged to center the Z center 
voltage. Alternatively, the Tip Up and Tip Down subcommands of the Motor command 
can be used to center the Z voltage. If the Z center position indicates that the scanner is 
retracted, click the Tip Up button until Z center is near 0V (0.50V).

• Pressing Ctrl-F will cause a false engage to occur after the SPM safety height is 
recycled for Dimension, causing the Realtime software to start scanning independently 
of whether the surface has been detected or not.

3.2.4 Tapping Engage

The Microscope > Engage Settings > Tapping window is designed to assist users in controlling 
key parameters associated with surface engagement during TappingMode. By using the Tapping 
Engage panel, however, users may minimize engagement times or tapping forces for specific 
conditions (e.g., TappingMode in fluids, etc.).

CAUTION: Adjustment of the Tapping Engage parameters can decrease 
engagement times during TappingMode by speeding the tip’s travel to 
the surface and decreasing the number of test probes. Although this 
may save time, it also endangers the tip. You should always default to 
more conservative settings when in doubt; otherwise, you risk 
breaking tips.
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Tapping Engage Panel

The Tapping Engage panel shown in Figure 3.2n illustrates recommended parameter values for 
most conditions. These settings yield an engagement time of 20 - 40 seconds.

Figure 3.2n   Tapping Engage Window

Setpoint values represent percentages of a setpoint established internally by the software for 
engagement purposes (generally, about 90 percent of the tip’s free-air amplitude). These values 
should not be confused with the Setpoint value indicated on the Feedback panel.

Parameters in the Tapping Engage Panel

Delta setpoint

Amount the setpoint is adjusted during each false engage test.

Note: While in TappingMode, this tests for false engagement and assists in engaging 
the tip on the sample surface. Tests for false engagement help to avoid artifacts 
produced by light scatter, fluid film damping, etc. Therefore, a setting of 0.00 
(no test for false engagement) is not recommended.

Range and Settings:

• ± 0—0.25 (default: 0.02) A value of 0.25 (corresponds to ±25%) is the recommended 
maximum. If set to 0.00, the system will not test for false engagement.
Rev. D NanoScope Software 8.10 User Guide 119



Realtime Views
Tips on Using Realtime

12
Final delta setpoint

Percentage of setpoint value (internally set) to be used after tests for false engagement are 
concluded. This is the amount of temporary “overdrive” used by the system to verify whether the 
sample is, in fact, engaged by the tip. If this test is passed, the setpoint is restored to the last value 
used during false engagement tests.

Range and Settings:

• 0.00—0.50 (corresponding to 0 to 50 percent)

Note: This value is usually set equal to the Delta setpoint. It represents a cumulative 
value which is eventually reached in a series of Delta setpoint increments 
(rather than one, single test). For example, with an engage delta setpoint of 0.02 
and a final delta of 0.10, five extra tests will be run after “engagement” to 
verify that the tip is actually on the surface (0.10 ÷ 0.02 = 5).

Note: If problems persist with false engagement, set the Final delta setpoint to a 
value that is 2-3 times the engage delta setpoint.

Test threshold slope

Slope value obtained by dividing the change in Z piezo voltage by the change in setpoint, which 
ultimately represents an envelope within which engagement is detected.

 Range and Settings:

• 0.11—1000 (default: 100)

Note: Because changes in Z piezo voltage units occur approximately 200 times per 
unit change of setpoint, slope values tend to be between 5—1000.

Note: The higher the slope value, the greater the chance of “false engagement.” 
Lower values are recommended for most applications. Using much lower 
values may reduce tip life.

Test threshold dZ

Similar to Test threshold slope, above. Engage occurs when either Test threshold slope > dZ/dA 
(change in Z with respect to Amplitude - shown as Slope test in Figure 3.2o) or Test threshold dZ 
> dZ. The probe tip tapping amplitude drops markedly when the tip contacts the surface.

Range and Settings:

• 0.0—2000nm (typical value: 25nm)
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Figure 3.2o   Tip Amplitude While Approaching the Sample Surface

Engage min setpoint [%]

Lowest allowable percentage of setpoint value (internally set) used during engagement, 
representing the “last word” in tip-sample force. This value overrides other parameters determining 
setpoint during engagement.

 Range and Settings:

•  10—90. (typical value: 25).

Note: Lower values may endanger the tip and/or sample, as higher tip-sample forces 
will be employed.

Note: Higher values represent lower, more conservative tip-sample forces; however, 
very high values will increase false engagements.

TM engage gain

Integral gain value used during TappingMode engagement. Once the surface is engaged, gain 
values revert to those displayed on the Feedback panel.

Range and Settings:

•  0.0100—10.00 (typical values: 0.5-2)
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Hints for optimizing the TM Engage Gain

• As TM engage gain is increased, the tip’s vertical velocity downward increases. This 
parameter may be used to speed the engagement process and save time; however, if set 
too high, the tip and sample may be damaged.

• During engagement, gain values (Integral and Proportional) displayed on the 
Feedback panel are not utilized. Instead, the software sets its own integral gain based 
on this parameter.

• With normal (non-fluid) samples, higher values tend to accelerate engagement speed at 
the cost of endangering tips and samples. Use of a higher gain may be recommended for 
TappingMode scanning of hard samples in fluid; however, gain should be increased 
cautiously.

• Use of lower gain values will tend to increase engagement times; however, lower values 
are recommended for soft, delicate samples where impact is to be minimized.

Sew tip

Controls use of sewing during the engagement process to detect the surface. Sewing consists of 
moving the tip vertically with the Z piezo while lowering it toward the surface. If the surface 
position is well known, sewing may be triggered to save time.

Range and Settings:

• Yes—Turns sewing on. This is the normal, default mode.

• No—Turns sewing off.

Note: Only used for testing purposes; typically results in a damaged tip.

• Triggered—Turns sewing on when the RMS amplitude reaches the specified Sewing 
trigger value. The Triggered switch is used to protect tips and samples and to decrease 
engagement time.

Sewing trigger [%]

Percentage of oscillation amplitude required to trigger sewing. This parameter is enabled only 
when the Sew tip parameter has been set to Triggered. Default setting is 98; not recommended at 
values less than 90.

Range and Settings:

• 1—100; default setting = 98.

Note: Regardless of setting, this parameter may be overridden by the Trigger safety 
parameter.
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Trigger safety [for Dimension series microscopes only]

Minimum height above sample surface at which sewing is turned on. This parameter overrides the 
SEWING TRIGGER parameter.

Range and Settings:

 0—100 m; typical setting = 20 m

Pre engage setpoint [%]

Used to set the setpoint of the tip prior to engagement by reducing the setpoint relative to the RMS 
amplitude.

Range and Settings

• 30—100; default = 90.

Note: The usable range of this parameter is generally from 85 to 95. This represents 
the starting value for the engagement cycle (see beginning of this section).

3.2.5 Scan View Parameters Tips

Optimizing the Scan Size Parameter

• The Scan Size and offsets can be set by using the Zoom and Offset subcommands in the 
Scan View.

• Non-zero X and Y offsets reduce the maximum Scan size. Each volt of X or Y offset 
reduces the maximum scan size by 2V.

• Having a non-zero Scan Angle will reduce the maximum allowable Scan Size.

• The maximum Scan Size will also decrease as the Scan Rate increases.

CAUTION: To avoid damaging the tip or sample, the Trigger safety should be set 
to a value greater than the height of the tip, or the maximum peak-to-
valley distance of surface features, whichever is greater. This 
parameter consists of a height above the surface as determined during 
the TOOLS/STAGE > FOCUS SURFACE... command.
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Optimizing the X Offset, Y Offset Parameter

• These parameters use the sample as the position reference. Therefore, a more negative 
X Offset value will move a feature in the current image to the left on the Image display 
Similarly, a more negative Y Offset moves a feature in the current image down on the 
Image display.

• Using the left-arrow and right-arrow keys when the cursor is in these parameters will 
decrement and increment these parameters by 10% of the Scan Size.

• Using the Zoom or Offset subcommands automatically changes the value of X and Y 
offsets.

Optimizing the Scan Size and Scan Rate Parameters

• The Scan Size and height of features on the sample will affect the maximum Scan Rate 
that should be used on a given sample. Scan rate should be set to a rate that allows the 
tip to closely track the sample surface in both trace and retrace. In general, larger scans 
and taller features require slower scan rates.
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3.2.6 Channels Parameters Tips

Optimizing the Data Type Parameters

• The system can display up to four simultaneous Realtime images.

• The Data Type parameter does not switch the operating mode of the instrument, it 
simply changes the source of the data displayed. 

Optimizing the Data Scale Parameters

• Data beyond the setting of the Data Scale is clipped for the RealTime display. Captured 
data, however, is not clipped. Independent of the settings of this parameter, the captured 
data will be correct unless it exceeds the maximum vertical range of the scanner.

• Each Data Type retains separate settings for Data Scale.

• Data Center is used to manually offset the trace data when Realtime Planefit is set to 
none.

The conversion of volts to nm or nA, is dependent on the value Sensitivity Detector parameters in 
the Calibrate > Detector panel.

For example, nanometers of cantilever deflection are calculated using the Sensitivity parameter in 
the Force Calibrate panel.

Optimizing Realtime Planefit Parameters

The setting of Realtime Planefit only affects the displayed data. It does not affect the captured data 
The parameters are described below.

• None displays the raw data in the scope window.

• Offset applies a zero order correction to each line of data so that the average height of 
the line is centered in the scope display.

• Line applies a 1st order correction, removing both tilt and offset from each line of data.

Note: If features are not evenly spaced along the scan line, using Realtime Planefit 
Line can result in artificial tilting of the scan line.

Optimizing the Offline Planefit Parameter

• The None option should only be used in special cases. The Offset and Full options 
provide greater dynamic range in the data to reduce round-off and other errors in 
subsequent calculations.

• The Modify > Flatten and Plane Fit commands can also be used to level the data after 
it has been captured.
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3.2.7 Feedback Parameters Tips

Optimizing the STM Feedback Parameters

• Log mode is preferable for most STM samples, because the tip responds in a more 
symmetric manner (i.e., the same going up and coming down). Log mode tends to 
linearize the entire feedback loop since Z  ln(i). The asymmetric response of the 
Linear setting distorts data.

Optimizing the Integral and Proportional Gain

• The Integral Gain is usually the major contributor to the performance of the feedback 
loop due to its “long term” influence. For this reason, it is usually adjusted before 
proportional gain.

• The integral term in the feedback calculation has the highest gain at low frequencies, 
and its effects diminish with increasing frequency.

• A nominal Integral Gain value may be obtained by slowly increasing the value until 
the piezo begins to oscillate, then decreasing the value until oscillation ceases. 
Oscillation effects are best viewed in the Scope window and show up first in error 
signal (i.e deflection or amplitude).

• The Proportional Gain parameter is typically set to 35 to 100% more than the Integral 
Gain value.
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3.2.8 Signal Access Software

Signal Access Software1 allows selected signals to be copied, at 10 micro-second intervals, to the 
Output 1/2 connectors on the front of the NanoScope V Controller. To use this feature:

1. Select the Output 1 and/or Output 2 Data Type in the Other panel of the Scan Parameter 
List in EXPANDED MODE. See Figure 3.2p. INPUT allows selected input signals to be copied 
to the Output 1/2 connectors. OUTPUT allows selected output signals to be copied to the 
Output 1/2 connectors.

2. Select, using the OUTPUT 1/2 DATA field, the signal that you wish to be copied.

Figure 3.2p   Select OUTPUT 1 DATA TYPE 

1.This feature is optional on the NanoScope V-PI.
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3.3 Force Curves

Force Curves ramp tip-sample separation while holding the X, Y position constant in the center of 
the previous scan. The scanner’s vertical position is plotted versus either the cantilever deflection 
(Contact AFM), or the amplitude of the cantilever oscillation (TappingMode). Alternatively, the 
cantilever deflection or oscillation amplitude can be plotted relative to a user-designated input 
signal.

3.3.1 Force Curves Procedure

Ramp Settings

To obtain force curves, it is necessary to first engage in Scan Mode using one of the Scan Views 
(see Preparing a Dimension Series AFM for a Realtime Scan Section 2.5.2), then switch to 
RAMP mode. If you want to calibrate deflection sensitivity, use a hard sample in the following 
procedure.

1. Activate RAMP, mode by clicking the RAMP icon in the Workflow Toolbar. This causes the 
system to stop scanning, and the probe to position above the center of the previous image.

Note: See Ramp Parameter List Section 3.3.2 - Feedback Panel Section 3.3.7 for a 
discussion of the Ramp Parameter List Parameters. When in Ramp mode, a 
ramp- specific menu also displays, the Ramp menu. See Ramp Menu Section 
3.3.8 for more information.

2. Enter the following parameter settings in the designated panels of the Ramp Parameter 
List:

a. In the Ramp panel select:

Parameter Setting

Ramp output Z

Ramp size 1.00µm

Z scan start 0nm

Scan Rate 1.00Hz

Number of samples 512
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b. In the Channel 1 panel select:

Gather Force Curves

1. Click the RAMP CONTINUOUS icon on the NanoScope toolbar or select Ramp > Ramp 
Continuous, from the menu bar.

2. While watching the Ramp Plot and the Real Time Status bar graph (see Figure 3.3a), 
increase the Z Scan Start parameter to move the tip closer to the sample.

Figure 3.3a   Bar Graph

Parameter Setting

Data Type Deflection Error

X Data Type Z

Display Mode Deflection Error vs. Z
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3. When the force curve suddenly rises, the tip has reached the surface (see Figure 3.3b).

Figure 3.3b   Force Curve

4. Click the Capture icon to save the force curve. Make note of the file name shown in the 
status bar (lower right corner of the window).

Calibrate Deflection Sensitivity

It is often necessary to calibrate the deflection sensitivity of a force curve. The deflection 
sensitivity depends upon several factors, such as the position of the laser spot on the cantilever, so it 
needs to be calibrated each time you change the probe. Use the following procedure to determine 
the deflection sensitivity:

1. Move two cursors onto the Deflection vs. Z plot (see Figure 3.3c).

2. Arrange the cursors so that they surround the contact (steepest) portion of the graph 
(see Figure 3.3c).

Figure 3.3c   Force Curve Cursors
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3. Click the UPDATE SENSITIVITY icon in the NanoScope toolbar or select Ramp > Update 
Sensitivity. The software will automatically calculate the deflection sensitivity and open the 
Set Realtime Channel Sensitivities window (see Figure 3.3d).

Figure 3.3d   Deflection Sensitivity Dialog Box

4. Click OK to accept this deflection sensitivity in the dialogue box that displays, and it will 
automatically be entered into the Deflection Sensitivity parameter in the Channels panel to 
the right of the plot (see Figure 3.3c).

5. Replace the hard sample with the sample you wish to analyze. The deflection sensitivity will 
remain applicable as long as the position of the laser spot on the cantilever does not change.

3.3.2 Ramp Parameter List

When you open Ramp function, the Ramp Parameter List box displays (see Figure 3.3e). All 
force curve parameters can be set in the Ramp Parameter List. The Ramp Parameter List is 
sectioned into seven panels. The parameters in each panel are defined in the following sections:

• Ramp Panel on page 133

• Mode Panel on page 135

• Auto Panel on page 137

• Channel (1, 2 or 3) Panels on page 137

• Feedback Panel on page 138
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Figure 3.3e   Ramp Parameter List
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3.3.3 Ramp Panel

Ramp Output: Specifies the Ramp Channel.

Ramp size: Specifies the range of the Ramp Channel. Visible only if the Ramp Channel parameter 
is set to Z. Settings depend on the specified units.

Z scan start: Visible only if the Ramp Channel parameter is set to Z and TRIGGER MODE is OFF. 
Z scan start is the bottom position of the Z-axis scan as represented on the Real Time status bar. 
When the Ramp node is first accessed during imaging, this value is automatically set to the Z 
Center Position.

• Range and Settings: The range of this parameter depends on the scanner. The units of 
this parameter are volts or nanometers, depending on the setting of the Units parameter.

Note: The value of this parameter will need to be increased to move the sample closer 
to the cantilever in the case where there is no deflection of the cantilever for a 
displacement of the sample.

Note: While the user is ramping Z in Ramp Mode, some feedback parameters are 
inactive.

Scan Rate: The Scan Rate sets the ramping rate. Changing this value effects the Forward and 
Reverse Velocities.

Forward Velocity: Forward Velocity of the tip (in µm/s) as it approaches the surface. Increasing 
this value increases the Scan Rate.

Reverse Velocity: Reverse Velocity of the tip (in µm/s) as it retracts from the surface.

X Offset: Controls the position of the range in the X direction.

Y Offset: Controls the position of the range in the Y direction.

Number of samples: Number of data points collected during each upward (retraction) and 
downward (extension) travel cycle of the piezo. The Number of samples parameter sets the pixel 
density of the force curve. This parameter does not change the Z scan size.

• Range or Settings: 16 to 19,968 data points displayed per extension and retraction cycle.
Rev. D NanoScope Software 8.10 User Guide 133



Realtime Views
Force Curves

13
Spring Constant: Records the spring constant of the cantilever that is currently being used. This 
parameter is input by the user and is recorded along with each force plot captured. It is used for 
Offline analysis of the force plot. It is not critical to set the Spring constant in Realtime, since it 
can be altered in the Offline analysis of the captured force plot. The Spring constant is necessary to 
display a graph of force vs. separation if UNITS is set to FORCE.

Plot Units: Switches parameters in the control panels between units of Volts (V), Metric (nm or 
µm), or Force (nN). Changing this parameter also changes the setting of the Units parameter on the 
Scan Parameter panel.

• Range or Settings: Volts (V), Metric (nm) or Force (nN)

Display Mode: The portion of a tip’s vertical motion to be plotted on the force graph.

• Range or Settings:

• Extend—Plots only the extension portion of the tip’s vertical travel.

• Retract—Plots only the retraction portion of the tip’s vertical travel.

• Both—Plots both the extension and retraction portions of the tip’s vertical travel.

• If a channel other than Z is chosen, Display mode will not be available in Offline 
view.

X Rotate: Allows the user to move the tip laterally, in the X direction, during indentation. This is 
useful since the cantilever is at an angle relative to the surface. One purpose of X Rotate is to 
prevent the cantilever from plowing the surface laterally, typically along the X direction, while it 
indents in the sample surface in the Z direction. Plowing can occur due to cantilever bending during 
indentation or due to X movement caused by coupling of the Z and X axes of the piezo scanner. 
When indenting in the Z direction, the X Rotate parameter allows the user to add movement to 
scanner in the X direction. X Rotate causes movement of the scanner opposite to the direction in 
which the cantilever points. Without X Rotate control, the tip may be prone to pitch forward during 
indentation. Normally, it is set to about 22.0º.

• Range or Settings: 0 to 50º; most effective values are between 15 and 25º.
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3.3.4 Mode Panel

Trigger Mode: Limits the amount of force exerted by the tip upon the sample. It is possible to 
operate the trigger independent of drift (Relative) or at some arbitrarily fixed point (Absolute) 
depending on the trigger settings.

Data Type: Channels may be assigned for triggering to any input signal available including: 
Deflection, Amplitude, Phase or Friction data.

Trig threshold: The value of the cantilever deflection, as measured by the photodetector, desired 
for the indentation or scratch. The Trigger threshold defines the maximum force applied to the 
sample corresponding to the upper right-most point on the force plot.

• Range or Settings: -10V to +10V, depending on the Deflection Limit. Try 0.5V to 1.0V.

Trig direction: Determines the direction of the trigger and allows for a Positive, Negative, or 
Absolute trigger slope. In this way, the trigger may be configured to activate on either the positive 
or negative direction of the force curve.

Figure 3.3f   Trigger Direction

Start Mode: Start mode allows you to switch between the various force modes without returning to 
image mode. 

• Range or Settings:

• CALIBRATE—Produces standard force plots. Includes the ability to continuously 
cycle the tip up and down.

• STEP—Produces standard force plots, with added control to step the tip towards the 
surface.

• MOTOR STEP—Tip is stepped towards surface using the motor.

• INDENT—Starts optional nanoindentation mode. Available only in TappingMode.

Negative Trigger Direction Positive Trigger Direction

Z position - 0.10 μm/div Z position - 0.10 μm/div
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End Mode: Determines the location of the tip when the microscope is returned to Image mode. 
Choices include Extended, Retracted, or Surface.

Z Step Size: The change in tip height per step when using force step.

Auto Start: When enabled, autostarts ramping when entering from Image mode. If off, you must 
start ramping by clicking the Continuous or Single icon, or by selecting the proper menu selection 
under the Ramp menu.

Surface Delay: Specifies a delay when the tip reaches the point closest to the sample.

• Range or Settings: 0 to 200 seconds

Retracted Delay: Similar to Surface delay, this value specifies the duration of the delay when the 
piezo is at the top of the cycle (farthest away from the sample).

• Range or Settings: 0 to 200 seconds

Strip Chart Rate: Frequency of (Z-position, deflection) data point acquisition for strip chart (only 
available for Picoforce and NanoMan).

• Range: 0.01Hz to 1kHz. Typical value: 100Hz.

Strip Chart Size: Time interval over which (Z-position, deflection) data points are displayed in the 
strip chart.

• Range: 10 to 360,000,000 sec. Typical value: 100 sec.

Note: Although the strip chart collects and displays data over the time interval 
defined by clicking Start, then later, Stop, this data is not saved for subsequent 
use until the Capture icon (shown) is clicked. If Capture is clicked while strip 
chart data is being taken, what is saved begins at the start of the chart (sooner 
than the icon is clicked).
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3.3.5 Auto Panel

The Auto Panel parameters are only applicable when Autoramping.

Columns: Number of points in the Y axis.

Rows: Number of points in the X axis.

Column step: Offset distance between points in the X direction.

Row step: Offset distance between points in the Y direction.

Threshold step: The trigger point at which the deflection or the current activates the position 
change.

Capture: State is either ENABLED or OFF. When ENABLED, the software records and stores the 
ramp data for each data point in the matrix of rows and columns.

3.3.6 Channel (1, 2 or 3) Panels

Data Type: Channels may be assigned to any input signal available including: DEFLECTION 
ERROR, AMPLITUDE, PHASE, FRICTION and so on. Any channel may be switched to OFF, 
however, at least one channel is always on.

X Data Type: Type of data that the channel data is being compared to. This data displays on the X-
axis of the scope grid.

Data Scale: Voltage range for the vertical axis of the force curve plot. 

Note: This can be overridden by selecting AutoScale ON for the plot.

Data Center: Offsets centerline of scan by the amount entered. 

Note: The Data center offset does not become a permanent part of the data.

• Range or Settings: Depends upon the input signal, generally ± one-half of data scale 
maximum.

Deflection Sensitivity: Defines the conversion factor from cantilever deflection signal voltage to 
nanometers of cantilever displacement (in nm/V) using data in the contact region of a force plot.

Plot Invert: Inverts data along the Y-axis, effectively turning valleys into mounds and vice versa.

Average Points: Averages multiple points to smooth the curve.

Effective BW: A display (you cannot input a value to it) representing the sampling frequency with 
display averaging taken into account:

                     Effective BW = (force plot sampling rate)/(Ave. Points)
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Phase Offset: Shift horizontal position of plot to compensate for averaging of endpoint data.

Note: The numerical values of the two Phase Offset parameters can be ignored; set 
them to whatever values minimize the apparent hysteresis. Particularly when 
Forward Velocity and Reverse Velocity are unequal, the same numerical 
value for each Phase Offset may not correspond to an identical displacement 
on each axis.

Display Mode: The data types to be plotted on the force graph. E.g. Amplitude vs. Z.

3.3.7 Feedback Panel

Only the Force Curve-applicable menu parameters are described below:

Deflection Setpoint: Defines the deflection signal, and therefore the tip-sample force, maintained 
by the feedback loop.

• Range or Settings: ± 12.0V maximum

3.3.8 Ramp Menu

While the microscope is engaged and in Realtime mode, opening the Ramp parameters will 
display the Ramp Menu, shown in Figure 3.3g.

Figure 3.3g   Ramp Menu

Ramp Menu Definitions

Ramp Continuous: The tip is continuously lowered and raised by a distance equal to the Ramp 
size. This is the normal, default motion during Ramp Calibrate. “Raising” and “lowering” are 
relative to your system (e.g., On Dimension Series SPMs, the tip is raised and lowered to the 
surface; however, other SPMs raise and lower the sample beneath the tip).

Ramp Single: Lowers and raises tip once by a distance equal to the Z scan size, then halts.

External Trigger: (Not available)
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Stop: Halts all tip movement.

Retract: The Z-axis piezo retracts to its limit in preparation for Approach Continuous. This 
command does not initiate motor movements.

Continuous Approach: The tip lowers to the surface and raises in a controlled series of steps, then 
indexed by the Z step size (see Scan Mode panel) distance. This process continues downward until 
the tip encounters the surface. When tip deflection exceeds the Threshold Step amount, 
Continuous Approach halts and the resulting force curve displays.

Approach Single: The tip is lowered to the surface and raised in a single, controlled step. This 
process is halted if the surface is encountered by the tip, causing deflection exceeding the Step 
threshold amount. The resulting force curve is displayed.

Note: For both Approach Continuous and Approach Single, if Start mode = 
MOTOR STEP, the motor is stepped towards the surface, not the Z piezo.

Auto ramp: Begins auto ramping as defined by the parameters specified in the Auto Panel.

3.4 Force Volume

3.4.1 Introduction

NanoScope Force Volume (FV) imaging with the atomic force microscope (AFM) combines force 
measurement with topographic imaging. Typical AFM images depict the topography of a surface 
by measuring the action of a feedback loop to maintain a constant tip/sample interaction as the tip is 
scanned across the surface. The force volume data set combines nearly simultaneously measured 
topographic and force information into a single data set allowing the microscopist to test for 
correlations between forces and surface features.

A single force curve records the force imposed on the tip as it approaches and retracts from a point 
on the sample surface (see Figure 3.4a, top). Force volume imaging associates each (X,Y) position 
with a force curve in Z for some selected range. By plotting these values along X and Y 
coordinates, you may view stratified layers of force at various Z-axis heights above the sample 
surface. The value at a point (X,Y,Z) in the volume is the deflection (force) of the cantilever at that 
position in space (see Figure 3.4a, bottom).

A force volume data set can be used to map in two or three dimensions the interaction forces 
between a sample and the AFM probe tip. Possible applications include studies of elasticity, 
adhesion, electrostatics and magnetics. Force volume imaging enables the measurement of forces at 
various Z-positions and at thousands of (X,Y) positions during a single image scan.
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Figure 3.4a    Force Curve with Both Extending and Retracting Traces (top)

Force Volume Array of (Identical in this Case) Force Curves (bottom)

X

Z
Y

Towards sample

Away from sample

Sample
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3.4.2 Varieties of Force Volume Imaging

The matrix below summarizes each of the major imaging types.

The type of force image captured from a surface depends on how the SPM is set up. For example:

• If an magnetic force microscopy (MFM) image is being captured, force volume imaging 
(phase) allows the detection of long-range magnetic forces otherwise difficult to detect.

• For ordinary contact AFM, the use of force volume imaging (deflection) allows the user 
to see otherwise invisible electrostatic forces.

Signal Type Contact AFM TappingMode

Amplitude 
Deflection  
Friction 
Phase 

CAUTION: It is the responsibility of the microscopist to carefully define all 
force volume experiments. There are at least ten types of force 
volume imaging, including numerous combinations of triggers, 
drive frequency and amplitude, Z-axis direction, offset, etc. The 
utility of each image is subject to the interpretations and controls of 
the experimenter. This document does not cover all possible force 
volume types; therefore, discussion is limited to a general 
description of controls and an example in contact AFM. 
Experimentation is encouraged.
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3.4.3 A Force Volume Imaging “Jump Start”

This section provides an overview of force volume imaging for the casual reader or the experienced 
experimenter eager to get started. Force volume images require preliminary use of the Force 
Measurement function.

 The basic procedure for generating a force volume image follows.

1. Click the SELECT EXPERIMENT icon. This opens the Select Experiment window, shown in 
Figure 3.5a.

Figure 3.4b   The FORCE VOLUME Select Experiment window

2. Select Force Imaging in the Experiment Category panel.
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3. Select Force Volume in the Experiment panel and click START EXPERIMENT.

4. Create a height image of the surface of interest. This assigns values to image parameters, 
including image size.

5. Switch to RAMP mode and generate a standard force curve featuring both contact and non-
contact tip/sample interactions. Set SENSITIVITY as described in your SPM Instruction 
Manual and set the Deflection Limit to 24.58V. Set Z scan rate, Z scan size, and a 
RELATIVE Trigger with a Trig threshold of approximately 40 nm. Ensure that triggering is 
functioning properly before proceeding.

6. Switch back to Scan mode by clicking on the SCAN icon in the Workflow Toolbar.

7. Switch to Force Volume mode by clicking the Force Volume icon in the Workflow 
Toolbar. This opens the Force Volume window, shown in Figure 3.4c, and the Scan and 
Force Volume Parameter Lists, shown in Figure 3.4e.

8. Verify the force plot parameters are still in effect in all control panels. Set the number of 
Samples per line to 16, the number of samples per force plot (Number of samples = 512), 
and the number of force plots (Force per line = 16) and start collecting data. Don't forget to 
capture the image.

Force volume mode displays the data in three separate, but interdependent, regions (see Figure 3.4c 
and Figure 3.4d). The top image displays height. The large middle image displays the force volume 
image. It is a horizontal (parallel to the sample surface) slice through the volume at a distance Z 
display above the piezo position at the deflection trigger. The girded region in the lower right 
corner of the screen displays force curves as they are collected. The position of the cross hairs 
determines the slice presented in the force volume region. The position of the horizontal cursor on 
the deflection axis of the force curves determines the offset of the scale bar in the force volume 
image. The position of the vertical cursor sets Z Display.
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Figure 3.4c    The Single Monitor Force Volume Interface
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Figure 3.4d    The Dual Monitor Force Volume Interface
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Figure 3.4e       Force Volume Parameter Windows

While collecting data in this mode, it is possible to change the slice displayed and its offset without 
affecting the raw data. This is helpful in determining whether or not the parameters have been set 
correctly. Only data collected after the cursors are moved is displayed with the new Data Center 
and Z Display.

With NanoScope 7.30 and later software, you can turn Z Closed Loop ON and OFF without 
withdrawing the probe from the sample. With this change, Z Limit and Z Range are no longer 
coupled.

Force volume data can be evaluated offline like other images, and, additionally, with specialized 
analysis options. Different slices can be chosen by sliding the vertical red line along the Z axis of 
the force plot region, clicking on and dragging the line with the mouse. Force curves can be 
displayed by clicking on appropriate pixels in either the image or volume region. See Force 
Volume Display and Interpretation, page 164 for more detail.
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3.4.4 Sample Preparation

Samples intended for force volume imaging require no special preparation. Force volume imaging 
can be done in both air and fluid environments.

Refer to Support Note 290, Fluid Operation: Overview for Contact and TappingMode with a 
MultiMode Microscope or Electrochemical SPM (part number 004-125-000), Support Note 410, 
Direct Drive Fluid Cantilever Holder, the Dimension or MultiMode V Instruction Manuals for fluid 
cell preparation details.

Interpretable force volume images depend on an appropriate probe selection. A stiff cantilever may 
provide better control when measuring strong forces and is less prone to entrapment by surface 
tension; however, a stiff cantilever does not respond to small forces. A flexible cantilever is more 
sensitive to small forces and is less harmful to delicate samples. Too pliant a probe, in responding to 
myriad small forces, generates noise, and may jump to contact if large attractive forces act. Refer to 
the Bruker website, http://www.bruker.com, for an illustrated survey of probe options.

3.4.5 Force Volume Procedures

Tip Movement

The force volume data set height image is collected in a slightly different manner than one taken in 
Image Mode. In Image Mode, the tip is scanned along a line in the XY plane, deflecting to and from 
the surface as it encounters features. The heights of features are determined by the piezoelectric 
actuator moving the probe to minimize the error between the setpoint and tip deflection. In Force 
Volume Mode, the piezoelectric actuator closes the distance between sample and tip until a (trigger) 
threshold tip deflection is reached. The piezo position at the deflection trigger is recorded as the 
height of the feature. Tip deflection or another signal type during this approach is recorded as the 
extending portion of a force curve. Once the height measurement has been made, the piezoelectric 
actuator retracts one Z SCAN SIZE and the AFM records the retracting portion of the force curve. 
The forces measured reflect the Z component of the sum of forces acting on the tip at that location. 
This process is then repeated at the next XY position in the area.

CAUTION: Be careful not to allow liquid to leak onto the (expensive) 
piezoelectric actuating scanner tube; it can be damaged in a high 
voltage short circuit and require replacement.
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Force volume imaging always includes executing tip motions as follows:

• The tip is lowered and pressed against the sample surface until the cantilever is 
deflected to the Trig[ger] threshold value. If the surface is not contacted within one Z 
scan size distance, the tip is extended one additional Z scan size (for a total distance of 
two times the Z scan size), then retracted one Z scan size. This means that the tip is 
incrementally lowered (or “ratcheted”) one Z scan size for each extension-retraction 
cycle until the surface is contacted, or the Z piezoelectric actuator reaches its maximum 
extension at 220 volts.

• Once the tip contacts the surface and deflection attains the Trig[ger] threshold value, 
sample height is recorded for that Z-axis threshold. A force curve is recorded for the 
(X,Y) coordinates after the piezoelectric actuator retracts. The tip is lifted clear of the 
surface and translated to the next sample (X,Y) coordinates. The entire process is then 
repeated.

Note: In NanoScope version 7 and later, the ramp data is collected in the trace 
direction and the system then moves the tip rapidly back to the start of the 
line.

Note: In NanoScope version 5.xx and earlier, the time required to add one scan line 
to the height image is twice that calculated by multiplying Z SCAN RATE for 
the force curves by the number of pixels in the image. This is because the 
microscope collects both trace and retrace curves along each line in the XY 
plane. Only data from one or the other scan direction can be saved. 

General Force Volume Procedure

The general sequence for obtaining a force volume image consists of the following:

1. Obtain a height, deflection, amplitude or phase image of the sample in Image Mode. On the 
Channel panel, select the same Data type intended for force calibrating and for triggering.

Note: A trigger is required to obtain a height image during force volume imaging.

2. Obtain a Force Plot of the sample surface (any portion of the surface suffices). Using the 
force plot, determine the sample’s general force characteristics and set the following 
parameters: Setpoint, Z range, Z scan size, Z scan start, and Trigger mode.

Note: While not required, using Image and Force Plot Modes to set parameters can 
quicken the set-up process. Making parameter adjustments in Force Volume 
Mode can take longer since the SPM responds to the new settings only when 
it begins scanning a new line.

3. Return to Image Mode.

4. Obtain a Force Volume image by clicking the Force Volume icon in the Workflow 
Toolbar. Set the following parameters in the Force Volume Parameters panel: Z scan rate, 
FV scan rate, Number of samples, Force per line, Samples per line, Display mode, 
Sample period.
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5. Fine tune Image Channel parameters to obtain a height image. Based upon the experimental 
design, set parameters in the FV (Force Volume) Channel and Force Channel panels.

6. Capture the Force Volume image.

Note: This takes longer than a normal image capture—the force volume image may 
consist of up to 512 samples taken 512 times per line at the Z scan rate.

7. Interpret the Force Volume image using Offline commands.

Detailed Force Volume Procedure

Contact AFM Mode produces the best understood force volume images. The forces encountered, 
both attractive and repulsive, include electrostatic, van der Waals, surface tension, capillary, ligand/
receptor, and magnetic interactions. Alternative modes of force volume imaging (tapping, phase, 
etc.) are harder to interpret and are not discussed here.

Refer to Support Note 228, Force Measurements, for detail on generating force curves. A force 
volume procedure follows.

1. Select a sample and mount it on the AFM. Initially, the sample should be familiar enough to 
obtain a recognizable image easily (e.g. a silicon calibration reference). 

2. Click the SELECT EXPERIMENT icon. This opens the Select Experiment window, shown in 
Figure 3.5a.

3. Select Force Imaging in the Experiment Category panel.

4. Select Force Volume in the Experiment panel and click START EXPERIMENT. This will set 
the Microscope Mode to CONTACT.

After engaging the surface, adjust the Setpoint so the tip exerts minimal force on the sample. 
Reduce the Setpoint until the tip retracts, then raise it slowly until there is just enough tip-sample 
contact to obtain an image. Optimize the Channel 1 parameters for a good image: set Data Type to 
HEIGHT and Realtime Planefit to LINE. The image collected by Channel 1 is displayed as the 
height image in the force volume display.

If the sample is weakly adsorbed to the substrate or there is some other reason for minimal tip-
sample contact before collecting the volume (i.e.: to avoid contamination of or damage to the tip), it 
is possible to collect force volume data skipping the contact image step. First, before engaging, set 
Image > Scan Size to 0. Then engage normally, or false engage if it is absolutely necessary not to 
contact the surface. Once engaged, lower the Setpoint until the tip is retracted from the surface. The 
rest of the procedure is essentially the same.

5. Create a force plot of the surface.

To obtain a force plot of the surface, click the RAMP icon. Set the (Ramp) Scan Rate to the 
recommended default of 4 HZ. (In fluid, higher rates can induce hydrodynamic forces on the tip.)
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Using the data scale from your image, set the RAMP SIZE to a number larger than the roughness of 
your sample.

Click the SINGLE RAMP icon on the NanoScope task bar. 

Set the SENSITIVITY parameter using the mouse to draw a line on the force curve parallel to its 
slope in the contact region (see Figure 3.4f). This parameter must be well-determined for 
quantitative force readings.

Figure 3.4f   Calibrating Deflection as Displacement- single monitor view shown. Dual monitor view is similar.

• Click and hold on either side of the plot area to get a cursor line. 

• Drag this cursor line onto the plot to mark one part of the contact portion of the force 
curve.

• Get and drag a second cursor onto another part of the contact portion of the force curve.

• Right click to choose the trace or retrace curve (Active curve 1 or 2).

• Then under the FORCE tab, select DEFL. SENS.

6. Adjust the Z Scan parameters until a good force curve is obtained, that is, one such that a 
significant portion of the curve contains the transition from noncontact to contact. For 
example, if measuring an interaction force with a decay length of 10 nm, have a Z scan size 
on the order of 50 NM.
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Make sure the piezoelectric actuator is centered in the Z direction. This gives it ample room to 
move in response to surface features. 

7. Return to Image Mode by clicking on the SCAN icon in the Workflow Toolbar. (You cannot 
switch directly from RAMP to FORCE VOLUME.)

Once a good force curve is obtained, return to Scan Mode.

8. Obtain a force volume image of the surface.

To obtain a force volume image, click the FORCE VOLUME icon in the Workflow Toolbar.

Note: The screen appears similar to the one shown in Figure 3.4g, except that most 
of the image regions are blank at first. (A minimum of several minutes are 
required to obtain complete images.)
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Figure 3.4g   A Force Volume Image - single monitor view shown. Dual monitor view is similar to Figure 3.4d.

Figure 3.4g shows the following:

• Top Image: The image at the top of the screen is a height image similar to the one 
shown in Real-time/Image mode; however, it may appear more pixelated. 

• FV Image: The large image in the middle plots force as a function of Z distance. 

Note: The resolution of the force plot varies depending upon various parameter 
settings.
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• The force plot at the bottom of the panel displays a series of superimposed force plots 
for each scan line.

There are six Force Volume panels in the Force Volume Parameters window, shown in Figure 
3.4h, which control sampling and scanning for the force volume image and force curve. They are 
organized by function:

• Image Scan - Real-time parameters for the height image shown in the Image Scan (top) 
panel of the Force Volume Parameters window, such as Scan Size, X- and Y Offset, 
Scan Angle, and Scan Rate.

• Image Channel - more Real-time parameters affecting the height image.

• Z Scan - parameters affecting vertical movement of the probe, including Z scan start, -
size and -rate.

• Feedback - parameters controlling Setpoint, and where probe travel is to be reversed 
(triggered): Trigger mode, -threshold and -channel.

• FV Channel - force volume channel controls affecting the force volume image in the 
upper-right corner of the window, including FV scale, Force per line, Z direction and -
display, and Data Center.

• Force Channel - parameters affecting the force plots.
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Figure 3.4h   Force Volume Parameters Window

9. Set Z Scan parameters.

The Z Scan panel groups basic sampling and scanning parameters for the force volume image and 
force curve.

The following parameters are often carried over from the force plot settings: Z scan start, Ramp 
size and Scan Rate.

The Display Mode parameter in the Z Scan panel can be set to display in the force plots region the 
EXTEND portion of the force curves, the RETRACT portion, or BOTH.

10. Set the resolution of the height, FV, and force plot images.

Remember that you are constructing a “map” of many separate force plots across the sample surface; 
therefore, there is a lot of data to sort. Depending upon settings, capturing a detailed force volume 
image can require hours.

Note: While the size of the area imaged by the AFM is ultimately limited by the 
characteristics of the piezoelectric actuator, the resolution of the data is limited 
by the computer hardware and software. The total amount of data for any 
given force volume image file is limited to a maximum of 128 megabytes 
(MB). This places restrictions on the resolution of the force curves, and the 
force volume image.
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There are three parameters in three distinct control panels in Force Volume Mode which affect the 
resolution of the data: Number of samples, Force per line and Samples per line.

The Number of samples parameter in the Force Channel control panel sets the number of points 
collected in each force curve. This is the number of slices in the force volume image, that is, the Z 
resolution of the force volume image. This parameter does not affect the speed of the scan but does 
affect file size. A good default setting is 32.

The Force per line parameter in the FV Channel control panel sets the number of force curves 
collected and stored along each scan line of the sample and significantly affects the scan speed. 
This parameter is, effectively, the XY resolution of the force volume image. A setting that 
sufficiently resolves force-defined features, yet minimizes collection time, is desirable. A good 
default value is 64.

These two parameters are interdependent, due to the 128 MB limit:

    FORCE PER LINE)2  (4 NUMBER OF SAMPLES)  128 MB

The above requirements restrict the maximum number of force curves per line in the volume to 64.

The Samples per line parameter in the Image Channel control panel sets the number of pixels in 
each scan line of the height image.

Note: For each pixel in the height image, a force curve is collected. Increasing the 
value of Samples per line, therefore, increases the scanning time needed to 
collect the entire volume. This parameter directly affects the XY resolution 
of the height image only. A setting of 128 provides sufficient detail to 
resolve many small features while helping to reduce capture time.

When Samples per line is greater than Force per line, at each XY position in the height image, the 
NanoScope moves the probe toward the sample until the Trig Threshold is reached and then 
retracts - the same motion as a force curve. However only one force curve, the first one taken in a 
pixel’s area of the force volume image, is displayed in the force volume image. For example, with 
512 Samples per line and Force per line set at 64, then there are 16 pixels (44) in the height 
image that correspond to one pixel in the force volume image. While the piezoelectric actuator and 
the tip go through the motions of a force curve at each of those sixteen pixels, only the first force 
curve is used in the force volume pixel.

The size limit on the data file enforces a trade-off between XY resolution and Z resolution. To 
know whether a tip sticks to the surface at different locations, low Z resolution (Number of 
samples) in favor of high XY resolution (Samples per line and Force per line) is sufficient. If a 
detailed examination of the interaction forces between tip and sample is desired, then high Z 
resolution is needed. Saving the Scan Mode height image (step 1) can compensate for low XY 
resolution in the force volume image.

Setting Number of samples, Force per line, and Samples per line to 16, 16, 512, respectively, 
are good starting values.

Resolution and scan speed are the major determinants of the time required to collect a complete 
force volume image. Figure 3.4i illustrates the effect that Samples per line and Z scan rate 
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parameters have on imaging time. The times were calculated assuming the maximum number of 
force curves per line (Force per line) for each Samples per line.

Figure 3.4i   Image Scan Time versus Samples per line and Z scan rate.

Doubling the lateral resolution roughly quadruples the capture time, while doubling the scan rate 
halves the capture time.

11. Adjust Feedback parameters.

Feedback panel parameters carry over from the force plot settings; however, changes may be 
required to protect the tip and optimize the force volume image.

For silicon nitride tips, the Setpoint may be adjusted to within plus or minus several volts of the 
microscope noncontact free-deflection signal value. For crystalline silicon TappingMode tips, the 
Setpoint should normally be increased no more than 1-3 volts below the RMS amplitude voltage; 
this helps protect the tip.

In Force Volume imaging, triggers are used to set the direction reversal point of the Z-axis 
piezoelectric actuator during both height and force measurements. The Data Type parameter 
registers which data channel acts as the trigger. Usually, this is the same as the Data Type located 
on the Force Channel panel. The Trigger Mode determines the type of trigger to be employed, 
RELATIVE, or ABSOLUTE. The trigger may also be turned OFF.

A relative trigger measures the trigger threshold relative to the non-contact voltage deflection value 
and compensates for drift. An absolute trigger measures the trigger threshold relative to the 
Setpoint. In most cases, a relative trigger is preferable, as it offers better protection to the tip and 
sample by limiting the total force on the surface independent of setpoint and drift.
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The Trig threshold parameter limits forces on the sample and the tip by “clipping” the Ramp size. 
For example, when using a relative trigger of 25 NM and a Ramp size of 500 NM, if the tip were to 
come into contact with the surface after extending only 300 nm of the scan size, the tip would halt 
its movement after 25 nm more extension (for a total of 325 nm) before retracting. Thus, tip-sample 
forces are constrained, and the force curve is defined for a controlled interval of tip-sample 
interaction.

During the execution of a force curve with a trigger on, the piezoelectric actuator extends 
continuously, bringing the surface towards the tip until the tip is deflected to the Trig threshold 
value. Once deflecting to the TRIG THRESHOLD value, the piezoelectric actuator retracts one Z 
scan size distance - it does not retract to the position defined by Z scan start. Thus, the collection 
of the next force curve begins at a piezo position one Z SCAN SIZE value lower than the piezo 
position at the Trig threshold value. Keep this in mind when setting the Z scan start and Z scan 
size parameters if a relative trigger is used.

Note: This discussion assumes that Sensitivity has been properly set and that the 
detector range has not been exceeded. Otherwise, the Trig threshold value 
does not correspond to the true deflection value.

In Force Volume imaging, triggers are used to set the turnaround point of the Z-axis piezoelectric 
actuator. The Trigger mode determines the type of trigger to be employed. Two types are offered: 
RELATIVE and ABSOLUTE, or the trigger may be turned OFF.

Note: If the Trigger mode is turned OFF, no height image is displayed.

The Data type determines which data channel is to act as the trigger. (Normally, this is the same as 
Force Channel/Data type.)

A relative trigger measures the trigger threshold with respect to the free-air deflection voltage value 
and compensates for drift. An absolute trigger sets the threshold with respect to the Setpoint. 
Normally, a relative trigger is the preferable default, as it offers better protection to the tip and 
sample, limiting the total force on the surface independent of setpoint.

Note: When using a relative trigger threshold, be certain Ramp size (in the Z Scan 
panel) is sufficiently large to deflect the cantilever to the Trig[ger] threshold 
value and lift the tip clear of the surface. This ensures the tip is not ratcheted 
into the surface and dragged laterally through surface material during XY 
indexing.

To limit forces on the sample and tip, Ramp size may be clipped to within some Trig threshold 
value. For example, a tip which is being oscillated along the Z-axis with a Z SCAN SIZE of 500 NM 
may have its Trig threshold set to -25.0 NM. When using a RELATIVE type Trigger mode, if the 
tip encounters the sample surface after extending 300 nm, it halts its Z-axis extension at 325 nm, 
then reverses (retracts). Thus, tip-sample forces are limited and the force curve is defined for a 
controlled interval of tip-sample interaction.

Note: This example assumes the Sensitivity parameter has been properly set (see 
step #2 above) and that the detector’s range has not been exceeded.

12. Adjust Force Channel parameters.
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The Force Channel panel features parameters for the force plots region at the bottom right of the 
Force Volume display window. In most ways the force plots region is exactly like a Force Plot 
graph.

The available settings for the Data Type parameter depend on the type of imaging being done. 
Also available are Amplitude, Deflection, Potential, and Thermal. Set the Data type 
accordingly. For Contact Mode force volume imaging, select DEFLECTION ERROR, for instance.

When beginning a force volume scan, set Z display to its maximum to locate the force plots. (The 
force curves resemble a thin line.) Z display is the range of deflection values plotted in the force 
curves region. Slowly decrease Z display until the force plot fills most of the graph area.

The Center plot parameter determines where the force plots are graphed relative to the current 
Setpoint. When Center plot is OFF, the center horizontal line of the graph is positioned at the 
probe SETPOINT value and deflection is measured from there. When Center plot is ENABLED, the 
central horizontal line is positioned at the tip noncontact voltage (i.e., the voltage when the tip is 
just clear of the surface - in the noncontact portion of the curve) from which the deflection is 
measured.

13. Adjust FV Channel parameters.

Parameters in the FV Channel panel control the type and range of forces viewed in the force 
volume image. In addition, the FV scale parameter also affects the viewable range of data captured 
during force volume imaging. These parameters affect the real-time display of the force volume 
image only. The deflection at (X,Y), and Z-position data of each force curve (extending and 
retracting) are saved to disk.

The Z direction parameter determines which portion of the Real-time force curve cycle, EXTEND 
or RETRACT, is shown in the force volume image. For example, if the force of interest is material 
elasticity, the Extend portion of the curve is selected. If adhesion forces are probed, then the Retract 
portion is usually used.

The FV scale parameter sets the range of values represented by the force volume image. Because 
the force volume image is generated line by line and the effects of changing FV scale are not 
displayed until the next line of data is taken, several adjustments of this parameter may be needed 
before it is optimized.

The Data Center parameter adds (or subtracts) a constant value to (or from) the data signal 
(DEFLECTION ERROR in the case of Contact Mode force volume imaging). This is used to center 
the force volume data within the FV scale bar. For most applications, the value should coincide 
with a value on one of the force curves. This is most easily accomplished by positioning the cursor 
on a force curve. This centers the force volume image within the color bar of the specified Z 
display. Data Center can be set in two ways. The first is to simply enter the desired value in the 
control panel. The second is to use the cursors. Drag a vertical cursor from the left or right side of 
the plot region. Drag a horizontal cursor from the top or bottom of the plot region. Position the 
cursor vertically at the desired offset and click the left mouse button (see Figure 3.4j). In a slice, the 
pixels are colored based on their distribution within the range defined by FV scale and the Data 
Center. Modifying these parameters during data collection affects the display only. The raw 
deflection and piezoelectric actuator position data are saved.
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Figure 3.4j   Data center and Z display are Controlled by Cross-hairs

The Z display parameter determines which slice of the force volume is displayed in the force 
volume image region. Like Data Center, the Z display can be set in two ways. The first is to enter 
the desired Z value of the slice in the control panel. The second is to use the mouse to change the 
horizontal position (that is, the Z position) of the cursor in the force plot region. For example, a Z 
display of 30 NM causes the force volume image region to depict forces on the tip when it is at a Z 
position of 30 nm above the piezoelectric actuator position at the Trig threshold. The Z display 
parameter may be thought of as defining bands of force at fixed distances from the sample surface.

The Z display and Data Center parameters work in unison to define which portion of the 
superimposed force curves is plotted in the Force Curves panel of the force volume image. These 
parameters are also simultaneously represented as a green cursor on the force plot graph. Both Z 
display and Data Center may be changed by positioning the cursor with the mouse, or vice versa 
(i.e., the cursor is repositioned automatically whenever these parameters are changed.) The 
relationship of each parameter to the cursor is shown in Figure 3.4k.
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Figure 3.4k   Z Display and Data center in Relation to Cursor

14. Collect the force volume data set.

Once all parameters have been properly set, begin collecting force volume data by clicking the 
CONTINUOUS RAMPING icon (shown). Use the FRAME UP (DOWN) to start the scan at the bottom 
(top) of the image and force volume image regions.

15. Capture the force volume data set.

Completed images are saved to disk by clicking the CAPTURE icon (shown). 

Note: If parameters are changed during a scan, the capture is interrupted. To force 
the capture, click the CAPTURE icon a second time. The more recent 
parameter value entries are saved with the image.

If you forgot to capture an image, and the next image is not yet complete, click CTRL-B to Back 
Capture the image. You can also select CAPTURE > CAPTURE LAST. Back capturing in Force 
Volume Mode captures whatever image was collected before the last change of frame direction, 
that is, in the slow-scan direction.

Use of CAPTURE LAST can reduce the time required to gather data when only a non-square, 
rectangular subarea of the image is relevant (see Figure 3.4l; panels 1-4 show a scan in progress). 
Begin scanning an image from the top, for example, of the image region. In panel one, a new frame 
(dark) is scanned from top to bottom. When the strip of interest has been scanned, click on the 
FRAME DOWN icon (the scan is finished in panel 2). When the new image is beginning, enter 
CTRL-B to capture the strip. The slow-scan direction reverses in panel 3 and a new frame is begun 
(dark speckled). In panel four, the upward scan from panel 3 is interrupted and a new upward scan 
(light speckled) begins. The lower panels show what part of the scan is saved if the back capture is 
pressed in step 3 versus in step 4, after the new upward scan begins.

 Z 
di

sp
la

y

Data center

 Free-air
Deflection

Setpoint
0 NanoScope Software 8.10 User Guide Rev. D



Realtime Views
Force Volume
Figure 3.4l   CAPTURE LAST Assists Collecting Non-Square Force Volume Data (see text for discussion)

Another trick to imaging only strips of interest is to set Trig threshold to zero and the Z scan rate 
to a high value (i.e.: 20 HZ) and begin a scan. When the tip is positioned near the beginning of the 
strip of interest, reset Trig threshold and Z scan rate to their appropriate values and capture the 
image.

3.4.6 Force Volume Troubleshooting

Mechanical complications or poor choices of settings for both operational and display parameters 
can frustrate force volume data acquisition. Some common situations and their resolution follow.

A Force Volume Image is Uniform

If a force volume image is uniform at all Z display values (that is, all slices), check the various 
display parameters first. The settings may be too high or too low. For example, if FV scale is much 
smaller (or larger) than the actual range of cantilever deflections at any Z position, then all the 
pixels at the Z position will be to the low (or high) end of the scale. The same effect occurs if Data 
Center fails to bring the measured forces into the VOLUME SCALE range. Adjust FV scale and 
Data Center until the variation in forces is displayed.

If FV Channel/Z display is set too high, force curves appear as flat lines; if it is too low, the 
majority of force curves display flattened against one or the other extreme of Z position.

Check the color bar. If the contrast is too high, only the extremes of deflection show up in the force 
volume image. Changing the Color Table in Image Mode can reduce contrast (different color tables 
have different default contrast levels).

If Sensitivity was not set properly in Force Plot Mode, then force plot scaling is inaccurate.
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If a trigger is being used, make sure it is enabled, and vary Trig threshold to assure that the 
threshold deflection is large enough. If it is too low, only the noncontact portion of the curve is 
measured. For example, a 320 µm cantilever with a spring constant of 0.01N/m oscillates with an 
amplitude of roughly 3 nm at room temperature. These oscillations and a 2 nm Trig threshold 
initiate the trigger almost immediately after beginning a scan.

All the interesting forces may be mapped to a single pixel of Z data; that is, the Z resolution is too 
low for the forces of interest. Trade off XY resolution (i.e., Force per line or Samples per line or 
both) for Z resolution (Number of samples) to alleviate the problem.

If no adjustment to display parameters creates a nonuniform image, perhaps there is no force 
variability in the scan area. Adjust Z scan start and Ramp size in the Z Scan panel to scan the 
regions of interest within the force curves. It may be necessary to return to Force Plot Mode to do 
this. If the probe cantilever is too stiff to respond to the forces present, replace it with a more pliant 
cantilever or use a higher Trig threshold.

Drift

Although drift is a symptom that has a number of causes, it appears in Force Volume in two 
characteristic ways. The force curves, over time, can drift vertically or horizontally in the force 
plots region. The shades of the force volume image drift to one end of the color bar, as do the pixel 
values in the height image. Horizontal, or substrate, drift is due to the substrate or Z piezoelectric 
actuator drifting. Vertical, or cantilever, drift can result from DC electrical drift in the probe, 
thermal fluctuations, bubbles attached to the cantilever in fluid or slipping of the O-ring in a fluid 
cell - to name a few sources. Even small rates of drift can distort a force volume image during the 
hours needed to collect such a data set.

If the drift rate is low, it can be ignored during data collection and subtracted out offline by a 
horizontal or vertical cursor and selecting X or Y TRANSLATE. A relative trigger keeps the 
magnitude of probe deflections within a fixed range.

If the drift is slow to moderate (relative to the time scale of the entire collection process), adjust FV 
Channel/Z display upwards to keep the curves from drifting out of view. Reset the SETPOINT and 
collect the image. Set Force Channel/Center Plot to ENABLE to zero the force curves as they are 
taken.

If the drift is fast, check the hardware for mechanical causes. Ensure that the probe is secure in its 
holder. Thermal fluctuations near and within a probe can cause fast drift. Flexible cantilevers make 
good thermometers and respond to the slight temperature increases due to laser heating. To 
minimize thermal drift, bring sample, fluid (if any), probe and probe holder into thermal 
equilibrium (i.e., the same temperature) at the start of imaging.

Note: NanoScope AFMs take 90 minutes from when the machine is turned on to 
achieve thermal equilibrium.

If the force curves appear nonsensical, the extending and retracting portions reading maximum 
force along their entire length, FV scan rate may be set too low for the NanoScope DSP board. A 
FV scan rate of 6 HZ ensures smooth signal averaging. Too low a FV scan rate and the force 
curves will appear discretized.
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If imaging in fluid, bubbles in the fluid cell or adsorbed to the cantilever can result in fast drift rates. 
Bubbles can be removed by injecting more solution into the fluid cell and forcing the bubbles out of 
the cell through a tube. If the O-ring was subjected to torque in making a seal, it can relax and slide 
across the sample surface. This is remedied by minimizing lateral movement of the O-ring during 
set-up, or by not using an O-ring at all (though, then the probe is more sensitive to air currents and 
thermal variation).

As a last resort, if fast drift cannot be removed from the system, reset the setpoint (Feedback > 
Setpoint) during data collection to keep the force curves “in bounds”. Capture must be forced 
(click on the Capture icon twice in quick succession) to save the image. Another way to 
compensate for fast drift during imaging is to track the drift with the photodetector adjustment 
screws during the retrace portion of a line scan. The banding in the resulting height and force 
volume images can be removed offline by setting Center plot to Enabled.

Excessive Adhesion

Excessive adhesion of the tip to the sample results in the absence of the noncontact portion of the 
force curves as well as, in some cases, a downward curvature in the extending portion of the curve 
towards and meeting the retracting curve at the end of the noncontact region (see Figure 3.4m). 
This is caused by the inability of the tip to leave the surface as it is retracted. This can damage the 
sample during the repositioning of the tip to the next XY location. Adjust Z scan start and Z scan 
size in the Z Scan Controls panel to ensure that the tip is lifted clear of the surface during 
retraction. Check that most piezoelectric actuator motion occurs near its center position. Adjust 
Trig threshold if the tip is being pushed so far into the sample that adhesive forces on the tip are 
unnecessarily large.

Figure 3.4m   Example of Excessive Adhesion

CAUTION: Not using an O-ring is not recommended by Bruker. Leaks are hard 
to avoid and can quickly lead to expensive damage to the high 
voltage piezoelectric scanner tube.
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Hydrodynamic Drag

Occurring only in fluid cells, hydrodynamic drag appears as a vertical separation between the 
noncontact portions of the extending and retracting curves on the force plot. The magnitude of the 
separation is dependent on the rate of the scan; reduce Z Scan/Scan Rate until the curves are 
co-linear in the noncontact region.

3.4.7 Force Volume Display and Interpretation

Display Options During Imaging

Perform analysis in real-time by adjusting display parameters during imaging. For instance, Z display 
chooses the slice of the volume to be displayed in the force volume image region. Lines scanned after 
changing Z display correspond to the new slice. Lines scanned before the change correspond to the 
previous slice.

Adjusting FV scale and Data center allow the user to zoom in on particular features of a force 
volume image. Set these parameters to mask all but the range of forces of interest. See Detailed 
Force Volume Procedure, page 149, step 13.

Adjust the Image Controls/Z range scale to modify the height image. Z direction determines 
whether the trace or retrace scan line are collected.

If any of these parameters are modified while scanning, force image capture (by double-clicking 
the Capture icon) to save the data, including the final parameter set.

Post-Data Collection Image Analysis

NanoScope Offline analysis software processes force volume images in much the same way as it 
handles topographical images and force plots. There are also tools specific to the interpretation of 
force volume images.

When a force volume image is selected from the Offline directory, it is displayed much as it 
appears during data collection. The three regions - height image, force volume image, and force 
plots - are in their respective corners. Both the topographic and the force volume images appear as 
they did during collection.

Scales and Offsets

Scaling and offset options for each data type are available in the offline parameter list in the lower 
left of the Force Volume view.

The first Data scale parameter sets the scale of the height image. The Z scale sets the deflection 
scale for the force curve.

FV scale defines the range of deflection values to be displayed in the force volume image.
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Setting Center plot to ENABLE centers all the retracting force curves noncontact portions to the 
center horizontal line in the force plots region, effectively subtracting out any DC drift from the 
data. (The extending curves also are shifted, but they maintain their position relative to the 
retracting curve.) All deflection values are then measured relative to the center horizontal line. This 
allows for clear comparisons to be made among force curves in the data set and is recommended 
before further analysis.

Z direction toggles the force volume image between displays of the EXTEND (e.g., to study 
elasticity) or RETRACT (e.g., to study adhesion) portions of force curves.

Viewing Slices

You may inspect each slice in a volume (see Figure 3.4n).

Figure 3.4n    Force Volume Slices - Block Height Represents Deflection.

To display a force volume slice at a particular Z position, drag a cursor from the left or eight edge of 
the force plot region. Clicking on consecutive pixels in the force plots region (with the MULTIPLE 
radio button selected) displays consecutive slices in sequence (see Figure 3.4n, Figure 3.4q). Note 
that multiple force curves, measured at points A, B, and C in the height image, can be displayed 
simultaneously offline.
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Figure 3.4o   Force Volume: multi-layered polyethylene. Single monitor view shown.
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Figure 3.4p   Force Volume: multi-layered polyethylene. Dual monitor view shown.

Save images of slices for later use through the EXPORT menu. The images can be modified in third 
party graphics software (e.g., IDL, NIH image, Canvas, etc.). For example, slices selected in Figure 
3.4o or Figure 3.4p are displayed as a montage in Figure 3.4q.
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Figure 3.4q   Figure 3.4o Retracting Slices: Adhesion vs. Z Position 

1 2

3 4
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Viewing Force Curves

Display individual force curves by first opening the file from the appropriate capture directory and 
then selecting Force Curve Mode > SINGLE. Click the left mouse button on a specific pixel in 
either the height image or the force volume image to display the associated force curve in the force 
plots region (see Figure 3.4o). Note that the pixels in the height image and the force volume image 
are marked with white crosses. The Z value of the slice is displayed in the force volume image as a 
vertical cursor at that particular Z value.

Individual force curves can be analyzed separately from the height and volume data; select SAVE 
CURVES and the standard force curve analysis view is saved and can be opened from the Browse 
window. Once modified and analyzed, select File/SAVE to save the image and modified force 
curve.

Selecting Force Curve Mode > MULTIPLE to display several force curves in the force plots region. 
Click either the topography or the force volume image to display the associated force curve in the 
force plots region. A white cross labels the (X,Y) position of the force curve in both the topographic 
and force volume images. Superimpose multiple force curves by selecting many pixels (see Figure 
3.4o). Select Force Curve Mode > CLEAR ALL to erase the force plots region.

If multiple force curves are displayed, clicking SAVE CURVES saves each curve as its own standard 
force curve file.

Selecting Images to Analyze

A height image can be analyzed independently of force data by selecting OPEN IMAGE from the 
Force Volume window. The standard image analysis software loads. Once modified and analyzed, 
select File > SAVE to save the image and modified force curve.

Constant Force Surfaces

NanoScope software displays force volume data as a distribution of forces at a given Z position. It 
is also possible to consider the force volume data as a stack of constant force surfaces. Importing 
the force volume image file into a third party software package with array processing and three-
dimensional graphical display capabilities, like IDL, can produce images of these iso-force 
surfaces. Constant force surfaces can be measured directly with the AFM, but force volume data 
facilitates generating many iso-force surfaces. For the bacteriorhodopsin (BR) membrane adsorbed 
to mica shown in Figure 3.4r, the flat lower surface corresponds to a Trig threshold of 20 NM. All 
the Z positions are zero since they are measured relative to the piezo position at Trig threshold. 
The upper surface is a lower force just before tip contact with the membrane; it is effectively a 
topographic image. The iso-force surfaces were calculated and displayed using IDL.
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Figure 3.4r    Iso-Force Surfaces: Bacteriorhodopsin Adsorbed to Mica.

Interpretation

A two dimensional image is specific to a particular Z position of the base of the probe and is a 
mapping from an area of the XY sample plane to the deflection values obtained at each sampled 
point in the area. A three dimensional volume is a collection of images over the same XY area, 
each at a different Z value in a range of probe/sample separations.

To convert deflection data to values of force, the spring constant of the cantilever must be 
determined.

Tip charge density and shape, charge density of the sample, adsorbents on both tip and sample, and 
the elasticity of the sample are among the contributors to tip/sample force. Where possible, include 
reference control samples in your experiment to minimize unexplained variability in your 
interpretation of force volume data.

3.4.8 Force Volume Glossary

Data type: occurs in Image and Force Volume Modes. In Image Mode, Data type identifies the 
type of signal displayed in the image window. In Force Volume Mode, Data type identifies force 
volume imaging type (in the Force Channel panel); the choices depend on SPM (e.g., a 
MultiMode AFM has more options than a standard AFM). This note discusses force volume 
imaging based on the deflection signal. Under the Feedback panel, the Data Type of the FV 
trigger is selectable.

Display Mode: in the Z Scan control panel is set to display in the force plots region the EXTEND 
portion of the force curves, the RETRACT portion, or BOTH.

Force per line: in the FV Channel panel determines the number of force curves collected and 
stored along each scan line and significantly affects the scan speed. This parameter is, effectively, 
the XY resolution of the force volume image.
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Number of samples: in the Force Channel panel sets the number of points collected in each force 
curve. This is also the number of slices in the force volume image, that is, the Z resolution of the 
force volume image. This parameter does not affect the speed of the scan but does affect the file 
size.

Center plot: in the Force Channel control panel determines where the force plots are graphed 
relative to the current setpoint. When Center plot is OFF, the center horizontal line of the graph is 
positioned at the Setpoint value and cantilever deflection is measured from this value. When 
Center plot is Enabled, the central horizontal line is positioned at the tip noncontact voltage (i.e., 
voltage when the tip is clear of the surface - the noncontact portion of the curve) from which the 
deflection is measured.

Samples per line: in the Image Channel control panel sets the number of pixels in each scan line 
of the height image. Total force volume data acquisition time is proportional to Samples per line. 
This parameter directly affects the XY resolution of the height image only.

Deflection Sensitivity: in the Force Channel control panel relates cantilever deflection as 
measured in photodetector output voltage to topographic height.

Data Type: in the Feedback panel determines the data channel to act as the trigger. Usually, this 
has the same value as Force Channel/DATA TYPE.

Trig threshold: in the Feedback control panel is set to the tip deflection magnitude which causes 
the piezoelectric actuator to begin retracting if a trigger is in use. Trig threshold limits forces on 
the sample and tip.

Trigger mode: in the Feedback panel determines the type of trigger to be employed: RELATIVE, 
or ABSOLUTE. A relative trigger measures the trigger threshold relative to the noncontact deflection 
voltage value, so compensates for drift. An absolute trigger measures the trigger threshold with 
respect to Setpoint.

Data Center: in the FV Channel control panel adds/subtracts a constant value to/from the data 
signal (deflection in the case of contact mode force volume imaging). This is used to center the 
force volume data within the FV scale bar.

FV scale: in the FV Channel control panel sets the range of values displayed by the force volume 
image in RealTime. For offline viewing, use FV scale in the Offline Parameters panel in the Force 
Volume view.

Z direction: in the FV Channel control panel determines which portion of the Real-time force 
curve cycle, EXTEND or RETRACT, is shown in the force volume image region. Z direction is also 
found in the Offline Parameters list of a captured force volume.

Z display: in the FV Channel control panel determines which slice of the force volume is 
displayed in the force volume image region. Z display is also found in the Offline Parameters list 
of a captured force volume.

Data Scale: in the Force Channel control panel sets the range of cantilever deflection values 
plotted in the force curves region.
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Scan Rate: in the Z Scan panel sets the rate at which the AFM collects a force curve, both 
extending and retracting portions. Scan Rate and Samples per line determine the time to collect a 
force volume data set.

Ramp size: in the Z Scan panel sets the excursion size for the probe during the extend and retract 
portions of a force curve. When the cantilever deflects an amount equal to Trig threshold, the 
piezoelectric actuator retracts one Ramp size before beginning the next curve.

Z scan start: in the Z Scan panel sets the starting position of the piezoelectric actuator for the first 
force curve only.

3.4.9 Force Volume Sample Parameter Settings

For imaging a relatively smooth (features less than 100 nm tall) surface:

Image Scan Controls:

Scan size:              2 µm
Scan angle:         90 deg.
Scan rate:             20 Hz
Slow scan:        Enabled
Z limit:                  440 V

Z Scan Controls:

Ramp size:       100 nm
Scan rate:             4 Hz
FV scan rate:         6 Hz

Feedback Controls:

Trigger mode:              Relative
Trig threshold:                 10 nm
Data type:                   Deflection

Image Channel:

Samples per line:      64, 32 or 16
Realtime Planefit:                 Line
Offline planefit:                     None
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Force Channel:         

Number of samples: 64, 256 or 512
Data type:                          Deflection

FV Channel:

Force per line:           64, 32 or 16

3.4.10 Fluid Cell Preparation for Force Volume

If making force volume measurements in fluid, ensure that the fluid cell is clean. Wash the cell with 
a mild detergent, rinse in de-ionized water, and blow dry with a few blasts of compressed air.

Place the cantilever (preferably UV cleaned) in the holder and gently seat the O-ring in its place in 
the cell. Ultraviolet (UV) cleaning is achieved by irradiating the probe at 3-5mm distance from a 
UV lamp.

Place a thin film of fluid/buffer (20-30µL) on the sample before placing it into the microscope.

Adjust the positioning screws so that, when the fluid cell is placed in the head of the microscope, 
neither the O-ring nor the tip are in contact with the fluid.

Place the holder into the microscope and aim the laser at the tip of the cantilever and adjust the 
photodetector so that the deflection is approximately zero.

Using the screws, slowly lower the tip towards the sample until the fluid meets the O-ring. Then, 
watching the A+B (sum) signal for a large deflection, lower the tip until it is pulled by surface 
tension into the fluid. Lower the stage carefully a little more to ensure that the entire fluid cell is full 
of fluid.

If there are no air bubbles in the cell or on the cantilever, simply adjusting the mirror should bring 
the laser spot back onto the photodetector.

If the laser spot cannot be found, gently inject (by syringe and/or through a tube) more fluid into the 
cell to flush bubbles out (also through a tube).

Once the signal is regained, lower the tip to the surface and begin imaging.

CAUTION: Be careful; if the O-ring is not well-seated or the fluid cell 
otherwise leaks, the piezoelectric actuating scanner tube may 
suffer a high voltage short circuit and require replacement.
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3.4.11 Force Volume Image File Format

While the NanoScope analysis software includes many useful routines, sometimes one might wish 
to import a force volume image into third party software - a spreadsheet program or an image 
processing system. The following discussion explains how to extract data from a saved (captured) 
force volume image.

Like all NanoScope image files, the force volume image file has two parts: a header, and one or 
more images (see Figure 3.4s). The header contains a series of lists, each of which contains a 
number of parameters. There is a list for the microscope, for the piezoelectric actuator, for the 
images, and for the force curves. Basically, every parameter under operator control is written to 
some line in a list in the header. This information, when combined with the data stored in the 
images, can be used to reconstruct the original images.

Figure 3.4s   Force Volume Data File Structure.

The end of the header is flagged with a CTRL-Z character (ASCII 26). Different types of files 
have different length headers, but they all end with the CTRL-Z. There is a block of padding 
(random) data between the header and the actual images. The height image (Channel 1) is first, 
followed by the force volume image. All the image data is saved by the NanoScope with 16 bits per 
pixel, (i.e., in 2’s complement notation for negative numbers with the least significant byte (LSB) 
in “little endian” form).
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The height image data begins at byte 8192. It is a two dimensional array of data. The NanoScope 
Manual explains how to reconstruct the image from information in the header.

The force volume data is stored as a series of force curves. Depending on the resolution of the 
height image, the starting byte will vary. The start position of the force volume data can be found in 
the Data offset line of the Ciao Force List, designated as:

\*Ciao Force List

. .

. .

\Data offset:

Regardless of which is displayed during data collection, both the retract and extend portions of the 
force curve are written to disk. The force curve data set is a linear array of deflection values. The 
first half of the array is the retracting portion of the curve; the second half is the extending portion. 
Both Z position and deflection values need to be scaled based on header values.

The force curves which make up the force volume image are saved in column major format. For 
example, if Number of samples is 256 and Force per line is 32, then there are 32 x 32 = 1024 
force curves, each with 512 (retract and extend) deflection values. The force curves are ordered 
such that the first 32 form the first row of the image, the second 32 the next row, etcetera. 

Only the deflection values of the force curves are saved to the file. The corresponding Z-position 
values are calculated from information in the header:

z = index *440.0 * zsens * zscansize / (65536.0 * samples)

where index = the index in the Z direction, 0-511, of a deflection value

           zsens = \Z sensitivity

     zscansize = \*Force image list\Scan Size

       samples = \*Force image list\Samps/line

Deflection values are scaled according to the following formula:

       deflscaled = deflraw* (20.0 /dsens) / 65536.0

where deflraw = the raw, integer values from the file.

              dsens = \Detect sens.

Once the force volume data has been extracted from the file, it can be processed and analyzed by 
third party software such as RSI’s IDL, NIH Image, or Adobe Photoshop.
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Third party graphics software is needed to construct a composite figure of several slices or 
representative force curves pictured along with the height image, for example. The images (heights 
or slices) and force curves need to be saved/exported individually and then loaded into the third 
party software.

3.5 Piezoresponse Force Microscopy1

Piezoresponse force microscopy is a Contact Mode technique to measure sample displacement out 
of the sample plane in response to an applied AC bias. The method is most directly applicable to 
piezoelectric samples such as lead zirconia titanate, but can also work for electrostrictive samples 
such as lead magnesium niobate, and has been used on ferroelectric materials such as barium 
titanium oxide.

With the SPM in Piezoresponse Mode, the tip is engaged with the sample and an AC voltage is 
applied between tip and sample during scanning. A responsive sample expands and contracts in 
synchronization with the applied voltage. By feeding the photodetected cantilever deflection signal 
into a lock-in amplifier whose reference signal is the applied AC bias frequency, background 
topography is suppressed from the resulting image which features only the sample surface height 
changes induced by the applied field.

Piezoresponse imaging does not require any dedicated hardware and works with both fixed tip/
rastered sample (MultiMode) and fixed sample/rastered tip (Dimension) SPMs. There are several 
consequences of the need to form a circuit to bias the sample:

• The sample must be electrically connected to the sample platform (e.g., with silver 
paint; see Figure 3.6j).

• Though a light imaging force best preserves samples, the tip must stay in contact with 
the sample to maintain the applied tip/sample voltage. A particularly rough sample may 
require a higher load force, higher gains or slower scan speeds to ensure a continuous 
electrical connection.

Note: Internal current limiting protects the NSV Controller and the probe tip when 
using the NanoScope V Controller to apply the bias voltage.

• A conductive cantilever (such as MESP [Magnetic, Etched Silicon Probe], NPG [silicon 
Nitride Probe, Gold-coated], PIC [Platinum Iridium, Contact], or PIT [Platinum 
Iridium, Tapping]) is required.

Note: Active tip cantilevers are not conductive, so PR is not operable with FastScan 
or dual scan, but only by normal scan using the tube scanner exclusively.

• Piezoresponse imaging may be performed in a nonconducting fluid. In a conductive 
fluid, a conductive cantilever must be insulated from the fluid, except at the tip; this is 
difficult to accomplish.

1.This feature is optional on some microscopes such as the Dimension Icon-PI.
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Piezoresponse imaging is set up in the following procedure:

1. Click the SELECT EXPERIMENT icon. This opens the Select Experiment window, shown in 
Figure 3.5a.

Figure 3.5a   The Piezoresponse Select Experiment window

2. Select Piezoresponse in the Experiment Category panel.

3. Select the type of piezoresponse measurement that you wish to perform in the Experiment 
panel and click START EXPERIMENT.
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4. To reduce tip wear and increase resolution, set the DEFLECTION SETPOINT (in the Feedback 
panel, Figure 3.5b) to a low value, 0.25V initially. Decrease this later while looking at an 
image to lower the force applied to the sample, or increase it to ensure contact on a rough, 
but robust sample. This low value, 0.25V, assumes a stiff cantilever (such as MESP, PIC or 
PIT).

Note: For an NPG probe, set DEFLECTION SETPOINT to 2.0V instead.

Note: Most Piezo Response control parameters can be found in the Piezo Response 
panel and have PR for Piezo Response in the parameter name. See Figure 3.5b.

Figure 3.5b   EXPANDED MODE Scan Parameter List including Piezoresponse variables

Step 4Step 4

Step 6

Step 7

Step 8

Step 9

Step 10
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5. Click the Meter workspace, shown in Figure 3.5c, and zero-out the photodetector. Note the 
low DEFLECTION SETPOINT (dashed line).

Figure 3.5c   Zero the photodetector

6. Set the Piezo Response LOCK-IN TYPE. See Figure 3.5b.

Note: This selection is done for you when you select LOW or HIGH SPEED in the 
Experiment panel of the Select Experiment window.

7. To increase vertical sensitivity, set the Piezo Response VERTICAL 16X GAIN to ENABLED 
(default for this workspace). See Figure 3.5b.

8. To further increase vertical sensitivity (by 6x), reduce the DEFLECTION LIMIT in the Limits 
panel to 4.096V. See Figure 3.5b.

Note: Reducing the DEFLECTION LIMIT only provides additional bit resolution but 
does not multiply the deflection by a factor as the vertical 16X GAIN does.

9. Set the PR DRIVE AMPLITUDE to 2000MV and the PR LOCK-IN BW to 0.3KHZ. See Figure 
3.5b.

10. To prevent ESD, set the AC Bias to DISABLED before Engaging the sample. See Figure 3.5b.

11. Engage the tip on the sample and optimize scan parameters while watching the displayed 
image with Channel 1/Data Type set to HEIGHT SENSOR.

 The following steps provide initial settings for the Piezo Response control parameters.

12. Select SAMPLE in the AC Bias drop-down menu.

13. Adjust the PR DRIVE AMPLITUDE to optimize contrast in your PR image.
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14. Set the PR DRIVE FREQUENCY.

15. Set PR DRIVE PHASE to 0° initially. This may be adjusted to shift the location of high 
contrast regions in the piezoresponse image.

16. Select PR AMPLITUDE in Channel 4 and PR PHASE for Data type in Channel 5. 

Note: These are the Piezoresponse workspace default channels.

Write an area in the piezoelectric sample

Using the ferroelectric properties of piezoelectric materials, we will now write an area.

Set the following Scan Parameters:

• SCAN SIZE: 2 m

• SCAN RATE: 1HZ

• SAMPLES/LINE: 512

1. Change the ASPECT RATIO to 64 to write a small strip.

2. View the LS PR Phase channel.

3. Set the REALTME PLANE FIT to NONE.

4. Set the TIP BIAS to 10V to write the area. See Figure 3.5d.

CAUTION: AC bias frequency is set to excite piezoresponse in the chosen sample. 
Typical values are between 2 and 5KHZ, though 60KHZ PR imaging 
has also been successful. The bias frequency should be well above the 
scan rate so at least one full bias cycle is performed at each pixel in a 
piezoresponse image. Check TappingMode Cantilever Tune (see the 
Q Control chapter in the NanoScope V Controller Manual) to 
determine the cantilever resonant frequency if there is a possibility it 
is close to the AC bias frequency desired. PIC cantilevers have 
resonant frequencies of approximately 10kHz; PIT probes resonate 
between 60 and 90kHz. Do not set PR DRIVE FREQUENCY near the 
cantilever resonant frequency because the probe could begin 
mechanically oscillating, compromise tip/sample contact and 
confound cantilever deflection due to energy absorbed at resonance 
from the desired deflection due only to piezoresponse of the sample. 
A 2nm cantilever deflection amplitude is typical both of a 
piezoresponsive material and of a cantilever being driven in 
TappingMode.
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Figure 3.5d   Set the TIP BIAS to 10V to write the area.

5. After writing the area, turn off the TIP BIAS by setting it to 0V.
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Image the written area

1. Increase the scan size to see the area that was written:

• Increase the Scan Size to 3m. See Figure 3.5e. Note the written area between 0.5m 
and 2.5m.

• Increase the ASPECT RATIO to 4. The images are shown in Figure 3.5f.

Figure 3.5e   Written strip
2 NanoScope Software 8.10 User Guide Rev. D



Realtime Views
Piezoresponse Force Microscopy
Figure 3.5f   Piezo Response images of written strip
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Optimize the image

Piezo response image contrast my be improved by using the Generic Sweep feature of the 
NanoScope V Controller to optimize the drive frequency or phase.

1. Start the Generic Sweep by clicking the SWEEP icon in the Workflow Toolbar to open the 
Generic Sweep window, shown in Figure 3.5g.

Figure 3.5g   Generic Sweep Window

2. Set the CHANNEL 1 DATA TYPE to LS PR INPHASE and the CHANNEL 2 DATA TYPE to LS 
PR QUADRATURE.

3. Set the SWEEP OUTPUT to PR DRIVE PHASE.

4. Click the OFFSET Cursor Mode radio button.

5. Drag the dashed red cursor to the point of maximum response and click EXECUTE to set the 
PR DRIVE PHASE.
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6. Click EXIT to exit the Generic Sweep function.

This will change the PR DRIVE PHASE to maximize the PR In Phase signal and minimize the PR 
Quadrature signal. See Figure 3.5h.

Figure 3.5h   LS PR In Phase optimized

7. Similarly, one may also optimize LS PR Quadrature.

Additional information about the piezoresponse mode can be found in Piezoresponse Atomic Force 
Microscopy Using a NanoScope V Controller, Bruker p/n 013-444-000.
Rev. D NanoScope Software 8.10 User Guide 185



Realtime Views
Surface Potential Detection

18
3.6 Surface Potential Detection

3.6.1 Surface Potential Detection Overview

Surface potential detection measures the effective surface voltage of the sample by adjusting the 
voltage on the tip to match that of the surface, thereby minimizing the electric force from the 
sample. Samples for surface potential measurements must have a surface voltage in the range
[-10,+10 volts], and operation is easiest for voltages in the range of [-5,+5V]. The noise level with 
this technique is typically 10mV. Samples may include both conducting and nonconducting 
regions. Samples with regions of different metals will also show contrast due to contact potential 
differences. Quantitative voltage measurements are made of the relative voltages within a single 
image.

3.6.2 Surface Potential Detection—Theory

Theory Overview

Surface potential detection is a two-pass procedure where the surface topography is obtained by 
standard TappingMode in the first pass and the surface potential is measured on the second pass 
(see Figure 3.6a). The two measurements are interleaved: that is, they are each measured one line at 
a time with both images displayed on the screen simultaneously. A block diagram of the Surface 
Potential measurement system is shown in Figure 3.6b. On the first pass, in TappingMode, the 
cantilever is mechanically vibrated near its resonant frequency by a small piezoelectric element. On 
the second pass, the tapping drive piezo is turned off and an oscillating voltage  is 

applied directly to the probe tip. If there is a DC voltage difference between the tip and sample, 
then there will be an oscillating electric force on the cantilever at the frequency . This causes the 
cantilever to vibrate, and an amplitude can be detected.

VAC tsin
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Figure 3.6a   LiftMode Principles Used in Surface Potential Detection

If the tip and sample are at the same DC voltage, there is no force on the cantilever at and the 
cantilever amplitude will go to zero. Local surface potential is determined by adjusting the DC 
voltage on the tip, Vtip, until the oscillation amplitude becomes zero and the tip voltage is the same 

as the surface potential. The voltage applied to the probe tip is recorded by the NanoScope 
Controller to construct a voltage map of the surface.

Figure 3.6b   Simplified Block Diagram of Surface Potential Detection
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Theory Details

A good way to understand the response of the cantilever during Surface Potential operation is to 

start with the energy in a parallel plate capacitor, , where C is the local capacitance 

between the AFM tip and the sample and V is the voltage difference between the two. The force 
on the tip and sample is the rate of change of the energy with separation distance: 

Figure 3.6c   Force as a Function of Voltage

The voltage difference, V, in Surface Potential operation consists of both a DC and an AC 
component. The AC component is applied from the oscillator, VACsint, where  is the resonant 

frequency of the cantilever.

VDC includes applied DC voltages (from the feedback loop), work function differences, surface 

charge effects, etc. Squaring V and using the relation  produces: 

The oscillating electric force at  acts as a sinusoidal driving force that can excite motion in the 
cantilever. The cantilever responds only to forces at or very near its resonance, so the DC and 2 
terms do not cause any significant oscillation of the cantilever. In regular TappingMode, the 
cantilever response (RMS amplitude) is directly proportional to the drive amplitude of the tapping 
piezo. Here the response is directly proportional to the amplitude of the F drive term:
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The goal of the Surface Potential feedback loop is to adjust the voltage on the tip until it equals the 
voltage of the sample (VDC=0), at which point the cantilever amplitude should be zero (F

The larger the DC voltage difference between the tip and sample, the larger the driving force and 
resulting amplitude will be. But the Famplitude alone is not enough information to adjust the 

voltage on the tip. The driving force generated from a 2V difference between the tip and sample is 
the same as from a -2V difference (see Figure 3.6c).

What differentiates these states is the phase. The phase relationship between the AC voltage and the 
force it generates is different for positive and negative DC voltages (see Figure 3.6d through
Figure 3.6g).

In the case where VDC = 2V, the force is in phase with VAC. When VDC = -2V, the force is out of 
phase with VAC. Thus, the cantilever oscillation will have a different phase, relative to the reference 
signal VAC, depending on whether the tip voltage is larger or smaller than the sample voltage. Both 
the cantilever amplitude and phase are needed for the feedback loop to correctly adjust the tip 
voltage. The input signal to the Surface Potential feedback loop is the cantilever amplitude 
multiplied by the sign of its phase (i.e., amplitude for phase 0 degrees, -amplitude for phase <0 
degrees). This signal can be accessed in the software by selecting POTENTIAL INPUT (interleave 
scan line) in one of the channel panels.

If VDC = 0, the electric drive force is at thefrequency 2The component of the force at is zero 
so the cantilever does not oscillate (see Figure 3.6h and Figure 3.6i). The Surface Potential 
feedback loop adjusts the applied DC potential on the tip, Vtip, until the cantilever’s response is 

zero. Vtip is the Potential data that is used to generate a voltage map of the surface.

Figure 3.6d   VAC at VDC = 2V

2V

V

Time (arbitrary units)

VAC
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Figure 3.6e   Major Force Component in Phase with VAC at Frequency VDC = 2V

Figure 3.6f   VAC at VDC = 2V

Figure 3.6g   Major Force Component 180° Out of Phase with VAC at Frequency VDC = 2V

Figure 3.6h   VAC at VDC= 0V
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Figure 3.6i   Force at frequency of 2VDC = 0V

3.6.3 Surface Potential Detection — Voltage Application

If the sample does not require voltage to be applied (as in measuring work function difference on a 
sample made up of several metals), skip to Surface Potential Detection — Procedure: Section 
3.6.4.

It is often desirable to apply a voltage to the probe tip and/or to the sample. The NSV Controller 
provides a dedicated programmable power supply for each option through parameters Tip Bias 
Control and Sample Bias Control, respectively.

To bias the sample using an NSV Controller, ensure the sample is electrically connected to a 
standard steel sample puck using conductive epoxy or silver paint, as shown in Figure 3.6j.

Note: Painted samples are easier to remove from the puck than epoxied samples.

Figure 3.6j   Electrically Connecting a Sample to the Piezo Cap (MultiMode) or Chuck (Dimension)

Note: With an NSV Controller, it is often unnecessary to insulate a sample from the 
conductive sample platform (the MultiMode piezo cap or the Dimension 
sample chuck) to bias the sample using an external power supply. Instead, 
electrically connect the sample to its platform (see Figure 3.6j) and bias the 
platform. To apply a custom waveform or a voltage >|12V| directly to the 
sample, isolate (insulate) the sample from the platform (with Kapton tape, see 
Figure 3.6k).

Time (arbitrary units)

Force

Piezo Cap/Sample Chuck

Sample

Conductive Epoxy
or Paint

Steel Sample Puck
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Figure 3.6k   Electrically Isolating a Sample from the Piezo Cap (MultiMode) or Chuck (Dimension)

To electrically bias the tip during scanning, set Other tab/TIP BIAS CONTROL to TIP BIAS. 
Similarly, to electrically bias the sample platform, set Other/Sample Bias Control to SAMPLE 
BIAS as shown in Figure 3.6l. With the NSV Controller, the Tip Bias signal is dedicated to 
applying a voltage to the tip, while the Sample Bias signal is dedicated to sample biasing. The Tip 
Bias power supply may be set anywhere in the range [-12, +12V] while the Sample Bias power 
supply range is [-10, +10V]. Therefore, the tip/sample voltage difference may be made as large as 
22V.

Figure 3.6lSample Bias

Note: Tip Bias and Sample Bias parameter names do not appear in the Feedback 
and Interleave panels until selected for either Tip Bias Control or Sample 
Bias Control.

In the Feedback panel, set the desired voltage levels for the two parameters for the main scan lines 
(for Surface Potential, setting to zero or ground is recommended). In the Interleave panel set 
Sample Bias separately for the interleave scan lines.

Alternatively, each of these two parameters may be assigned the value GROUND instead. The 
GROUND setting is used to force the tip or sample to ground. Selecting GROUND for Tip Bias 
Control overrides the current value of TIP BIAS in setting the voltage of the tip. Similarly, selecting 
GROUND for Sample Bias Control overrides the current value of Sample Bias in setting the 
voltage of the sample platform.

Note: Tip and sample biasing as just described are not limited to Surface Potential 
Detection, but work as well with other SPM applications using the NSV 
Controller.

Note: Bruker recommends biasing the tip for Surface Potential detection.

Piezo Cap

Sample

Electrical Insulator

>10 M

External
Voltage
 Source
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3.6.4 Surface Potential Detection — Procedure

1. Mount a sample onto the sample platform. Ensure electrical connectivity between sample 
and platform if bias will be applied to the sample (see Figure 3.6j).

2. Mount a metal-coated cantilever into the probe holder (i.e., an MMEFCH probe holder for 
MultiMode SPMs). MESP- or SCM-PIT model cantilevers (metal coated, 225 µm long, with 
resonant frequencies around 70 kHz) usually work well.

Note: The MMEFCH probe holder for MultiMode SPMs is a special probe holder 
used for both EFM and Surface Potential that can be recognized by the white 
Teflon washer beneath the screw at the base of the cantilever clip.
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3. Click the SELECT EXPERIMENT icon. This opens the Select Experiment window, shown in 
Figure 3.6m.

Figure 3.6m   The Surface Potential Select Experiment window

4. Select ELECTRICAL AND MAGNETIC AFM in the Experiment Category panel.

5. Select SURFACE POTENTIAL MICROSCOPY (SPOM) in the Experiment panel and click 
START EXPERIMENT.

6. After you have aligned the laser and photodetector, click the CANTILEVER TUNE icon 
(shown) in the Workflow Toolbar. Set Start frequency, End frequency and Target 
amplitude appropriately then click AUTOTUNE to locate the cantilever resonant peak.
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7. Engage the AFM and make the necessary adjustments for a good TappingMode image while 
displaying HEIGHT SENSOR (or HEIGHT, depending on your SPM) data in Channel 1.

8. Set the Interleave/Drive Frequency (and any other unmentioned interleave parameters) to 
the main feedback values (i.e., set parameters gray).

Note: When an Interleave parameter is green, the value shown is used during the 
interleave scan. To fix any parameter so that it is the same on the main and 
interleave scans, click on that parameter. The parameter changes color to gray 
(“off”) and the main Feedback value for that parameter is used.

9. The Interleave/Drive Amplitude is the AC voltage that is applied to the AFM tip, VAC. To 
start, choose a Drive Amplitude of 6V and set the corresponding button green.

10. Set Interleave/Lock-In phase. For MESP, SCM-PIT, or FESP cantilevers (resonant 
frequency ~60-80khz) enter a LOCK-IN PHASE of -90 DEGREES. Ensure that the 
corresponding button is green.

Note: The NSV Controller records phase in standard degrees with the convention that 
cantilever phase is zero at resonance.

11. Choose a LIFT START HEIGHT of 0NM (i.e., the parameter is ignored because there is no need 
for additional initial retraction to break free of the surface in TappingMode) and a Lift Scan 
Height of 100NM. The Lift Scan Height can be readjusted later (i.e., in step 12).

12. In the Interleave panel set Input Feedback to POTENTIAL. Set Interleave Mode to LIFT.

13.  Set the Channel 3 Scan line to INTERLEAVE and DATA TYPE to Potential. For both data 
channels (height and potential) set the SCAN LINE direction to Retrace. The retrace direction 
should be chosen because the lift step occurs on the trace scan.

14. Set Sample Bias Control and Tip Bias as appropriate.

15. Adjust the input gains. Set the Input Igain to 10 and Input Pgain to 10 as a starting point. 
As with the topography gains, the scan can be optimized by increasing the gains to maximize 
feedback response, but not so high that oscillation sets in. More information on tuning the 
feedback loop is given in Section 3.6.5.

16. Optimize the LIFT SCAN HEIGHT. The best resolution is achieved with LIFT SCAN HEIGHT 
at the smallest value possible that does not make the tip crash into the sample surface (see 
Optimizing LIFT SCAN HEIGHT, page 197 ).
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3.6.5 Surface Potential Detection Pointers

Troubleshooting

Potential signal is oscillating

1. Observe the POTENTIAL signal in the Scope window. If oscillation noise is evident in the 
signal, reduce the input gains. If oscillations persist even at very low input gains, try 
increasing the Lift Scan Height and/or reducing the Interleave/Drive Amplitude until 
oscillation stops. If the tip crashes into the surface during the Potential measurement, dark or 
light streaks or dots appear in the Potential image, and the signal becomes unstable and can 
cause the feedback loop to malfunction. Increasing the Lift Scan Height and reducing the 
Drive Amplitude can prevent this problem.

Note: An electrically “floating” sample is a common cause of oscillation. Ensure that 
there is a low impedance ground connection.

2. Lower INPUT IGAIN and INPUT PGAIN.

Potential signal is stuck at an extreme (i.e., railed), at either +12V or -12V

1. If the Potential signal is perfectly flat and shows no noise even with a small data scale, the 
feedback loop is probably railed at ±12V. Verify this by changing the value of RT Plane Fit 
to NONE in the Channel 3 (POTENTIAL) panel and increasing the Data Scale to the 
maximum value, 20V. Check if the data is railed at one of the limits in the Scope window. 
Common reasons for this include:

• A regular probe holder is being used instead of the EFM probe holder.

• An inappropriate Drive Phase is being used. For MESP or SCM-PIT probes ensure that 
the Interleave Lock-In Phase is set near -90 DEGREES. For more details on optimizing 
drive phase, see Lock-In Phase, page 198 .

• An incorrect electrical connection is being made. Verify that the sample is connected 
properly to the sample platform. Verify that the jumpers in the base of the MultiMode or 
on the backplane of the Dimension are in their factory configuration.

Signal contrast is poor, but the Potential signal is not railed

1. Verify there is an electric field at the sample surface. If applying bias voltage to the sample to 
generate an electric field, set the potential channel Realtime Plane Fit to NONE. While 
observing the Scope trace, vary the interleave Bias value and verify that the potential signal 
shifts accordingly.
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Optimizing LIFT SCAN HEIGHT

1. Fine tune Lift Scan Height to as small a value as possible without hitting the surface. Lateral 
resolution of surface potential detection improves with decreased tip/sample separation. The 
minimum Lift Scan Height depends on the roughness of the sample, the difference between 
the Amplitude Setpoint and free air amplitude, and the quality of the height image. Hitting 
the surface usually produces phase data with extremely high contrast (i.e., either black or 
white pixels).

Because the tip is not oscillating during the Potential measurement (the feedback loop works 
to keep the amplitude zero), the Lift Scan Height is generally smaller than with other 
LiftMode techniques. Lift Scan Heights down to –5NM are possible on smooth samples. This 
lower limit to the Lift Scan Height is affected by sample roughness, scan speed, and target 
amplitude used during tuning, etc. Once oscillation stops, you can increase the input gains for 
improved performance.

Tip Choices

It is possible to deposit custom coatings on model FESP silicon TappingMode cantilevers. Verify 
that all deposited metal adheres strongly to the silicon cantilever.

It is also possible in some cases to use uncoated tips. The metallic coating and low spring
constant/resonance frequency of MESP and SCM-PIT tips make them well suited for sensitive 
electrical measurements. However, the coating increases the tip radius, and wear of the coating can 
cause significant changes in the detection of the electric field in the immediate vicinity of the tip. It 
has been suggested (Jacobs, H.O., Knapp, H.F., Stemmer, A., “Practical Aspects of Kelvin Probe 
Force Microscopy,” Rev. Sci. Instrum. 70 (1999) 1756.) that these changes in tip shape account for 
many of the DC shifts observed in Surface Potential images. Standard TappingMode probes 
(Models TESP) and the Force Modulation probes (Model FESP) are highly n-doped silicon that are 
often conductive enough for surface potential detection. The advantage to using uncoated silicon 
tips is the small tip radius improves lateral resolution in topographic imaging and the absence of 
changes in the metallic coating during surface potential detection. FESP tips have a lower spring 
constant and should be more sensitive to smaller forces than TESP tips. However, there is a 
reduction in sensitivity to small electric fields with the decreased conductivity of an uncoated tip.

If tips with higher resonant frequency are used, such as TESP (~300kHz), a different drive phase 
must be used, see Lock-In Phase, page 198 .

Tuning

Two curves should appear in the Cantilever Tune box—the amplitude curve in blue and the lock-in 
curve in red. In Surface Potential it is more important than usual that the resonant peak is 
symmetric. If the peak is unsatisfactory, its shape can often be changed by readjusting the position 
of the probe in the probe holder. The laser and photodiode usually require readjustment after the 
probe is moved.
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Drive Amplitude

Higher Interleave Drive Amplitudes produce larger electric forces on the cantilever, and this 
makes for more sensitive potential measurements. Conversely, the maximum total voltage (AC + 
DC) that may be applied to the tip is ±12V. So a large Drive Amplitude reduces the range of the 
DC voltage that can be applied to the tip (POTENTIAL signal). If the potentials to be measured are 
very large, it is necessary to choose a small Drive Amplitude (it is not recommended to use less 
than 2V), while small surface potentials can be imaged more successfully with large Drive 
Amplitudes. To start, choose a Drive Amplitude of 6V.

Lock-In Phase

Lock-In Phase adjusts the phase of the reference signal to the lock-in amplifier. As discussed in 
Surface Potential Detection—Theory Section 3.6.2, the correct phase relationship must exist 
between the reference and the input signals to the lock-in for the potential feedback loop to perform 
correctly. Lock-In Phase depends on the mechanical properties of the cantilever. For cantilevers 
with resonant frequencies from 60-80kHz (such as MESP, SCM-PIT, and FESP), use an interleave 
Lock-In Phase of 170 DEGREES. For cantilevers with higher resonant frequencies, increased 
electronics phase lag must be compensated. For cantilevers with resonant frequencies around 
300kHz (such as TESP, RTESP) an interleave Lock-In Phase near 130 DEGREES often works well.

Open Loop Operation

Sometimes it is useful to run Surface Potential in the “open-loop” configuration. This means that 
the Potential feedback loop is disabled and the data is only qualitative. The AC voltage is applied to 
the tip as in the standard Potential operation; the tapping piezo used for mechanical driving of the 
cantilever is disabled. Because the feedback is disabled, there is no adjustment of the DC voltage 
on the tip, so the oscillating electrical force drives the cantilever into motion. This motion can be 
monitored by observing the amplitude signal (the input to the potential feedback loop), called 
“potential input.” Set up the system as described above with the following changes: Set the Input 
Igain and Input Pgain to zero. Select AMPLITUDE or POTENTIAL as the Data Type.

Note: Turning the input gains to zero stops further changes to the DC voltage on the 
tip but does not set the tip voltage back to zero.
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3.7 NanoScope V Controller Lock-In

The Generic Lock-In GUI, brings together all of the controls associated with the use of the three 
internal lock-in amplifiers of the NanoScope V Controller into a single panel, shown in Figure 3.7a. 
The tabs along the top of the main panel are used to access the interface for individual lock-ins.

Figure 3.7a   The Generic Lock-In, shown configured for TappingMode imaging. The DDS 1 output is routed to 
the Tapping Piezo and the lock-in input is set to monitor the vertical photodetector signal.

Note: The Generic Lock-In function is not available on all microscopes, e.g. the 
Dimension Icon-PI, supported by NanoScope version 8 software.
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3.7.1 Mode-specific behavior

TappingMode

When calling the lock-in panel with the microscope set to TAPPINGMode, the primary lock-in 
selection tab is labelled Feedback. In addition the parameters DRIVE ROUTING, LOCK-IN1 
SOURCE and Lock-in ENABLE/DISABLE are disabled and greyed out. This prevents the user from 
inadvertently mode switching while scanning and using the primary lock-in for feedback.

Contact Mode

When calling the lock-in panel with the microscope set to CONTACT mode the primary lock-in 
selection tab is labelled Lock-In 1. All of the lock-in parameters including those disabled for 
tapping mode are enabled for user selection. Lock-in changes are unable to change the microscope 
mode while scanning in Contact mode.

Other Modes

STM, Tapping/TR, TR/Tapping, Dynamic Friction and Piezo Response modes are not yet 
supported by the Generic Lock-In.

3.7.2 Generic Sweep Window

Below the lock-in selection tabs are controls, shown in Figure 3.7b, that enable the lock-in enable 
setting parameters for both main and interleave modes. Each of the three lock-in panels has all of 
the controls necessary to use that lock-in independent of the state of the other lock-ins. Each panel 
also has a button that allows the user to rapidly access the NanoScope Generic Sweep function, 
shown in Figure 3.7c.

Figure 3.7b   Buttons to enable/disable the lock-in and to set parameters for main and interleave modes.

The GENERIC SWEEP button takes the user to the Generic Sweep window and populates fields 
based on values in the calling lock-in panel. Clicking the MORE button of the Generic Sweep 
window allows the user to toggle between the enabled lock-ins without leaving the Generic Sweep 
window.

Generic Sweep
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Figure 3.7c   The Generic Sweep window may be accessed from the lock-in panel.
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3.7.3 Drive Output Panel

The Drive Output panel, shown in Figure 3.7d, contains all of the controls to configure the output 
waveform of the DDS including frequency, amplitude, DC offset and the signal routing.

Figure 3.7d   The Drive Output panel

Harmonic

The HARMONIC Drive Output option, available for Lock-In 2, locks in on a user-selected 
harmonic (1-25) of the drive (DDS 1) signal. This enables you to lock in on higher (than the 
fundamental) frequency modes of the cantilever. You must set Lock-In 1 (Feedback) to ENABLED 
and select set Lock-In 2 to HARMONIC.

Drive Frequency

Sets the frequency of the corresponding DDS output and the reference for the lock-in input.

Drive Amplitude

Sets the zero-to-peak amplitude of the DDS output.

Drive DC Offset

Applies a DC shift to the AC bias.

Note: The maximum output voltage of the DAC is +/-10 Volts. Ensure that the DC 
offset plus the AC DRIVE AMPLITUDE is less than 10V to avoid clipping the 
output waveform.
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Drive Routing

Sets the output destination for the drive signal. Options are TAPPING PIEZO, TIP, SAMPLE, X 
DRIVE, Y DRIVE, Z DRIVE, FRONT PANEL (Lock-In 2)and NULL. When the output is selected as 
FRONT PANEL, the output is routed to the DDS 2 BNC on the front panel of the NanoScope V 
Controller. When the output is selected as NULL, the output is not routed but allows a reference 
signal to be generated and the lock-in used for inputs.

3.7.4 Lock-Input Panel

The Lock-In Input panel, shown in Figure 3.7e, contains all of the controls to configure the inputs 
to the lock-in.

Figure 3.7e   The Lock-In Input panel.

Reference Frequency

Duplicates the frequency from the Drive Output panel.

Lock-In Source

Selects the input source to the lock-in amplifier. Options are VERTICAL Photo-detector, 
HORIZONTAL Photo-detector, APPLICATION MODULE and FRONT PANEL.

Lock-In Phase

Sets the phase offset between the detected signal and the reference. Three buttons below the 
parameter display add/subtract 90° or Zero the current phase.

Lock-In BW

Sets the lock-in bandwidth for the lock-in input.
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Time Constant

Calculated from the lock-in bandwidth as (1/lock-in BW).
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3.8 High Speed Data Capture

The High Speed Data Capture window, shown in Figure 3.8a, allows you to capture and store 
many signals. To open the High Speed Data Capture window, click CAPTURE > HIGH SPEED 
DATA CAPTURE.

Figure 3.8a   High Speed Data Capture window

Note: The High Speed Data Capture function is not available on all microscopes, 
e.g. the Dimension Icon-PI, supported by NanoScope version 8 software.

Status panel
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3.8.1 Channel Selection Panel

Channels A and B can capture data at 6.25MHz and 50MHz while channels C and D capture data at 
500kHz. Channels A and B capture VERTICAL and LATERAL DEFLECTION respectively. Data 
capture of those channels may also be turned OFF.

The following data types are available for capture at 500kHz by the C and D channels:

• Height

• Signal Sum

• X sensor

• Y sensor

• Z sensor

• Amplitude

• Phase

• TM Deflection

• Deflection Error

• Friction

• Z Feedback Output

• Input 1

• Input 2

• Input 3

• X Scan

• Y scan

3.8.2 Trigger Controls Panel

The following trigger controls are available:

Arm Trigger

ARM TRIGGER begins monitoring for the trigger conditions to be met and starts data acquisition 
into the FIFO buffer. This button toggles to DISARM TRIGGER when the trigger is armed.
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Disarm Trigger

DISARM TRIGGER stops data acquisition and stops monitoring for a trigger event.

Auto Re-Arm

The AUTO RE-ARM check box causes the trigger to be re-armed after the data acquisition is 
completed. If AUTO RE-ARM is not checked, the trigger will be disarmed after the data acquisition 
has been completed.

Force Trigger

The FORCE TRIGGER button triggers data collection.

Event

The trigger EVENT drop-box allows you to trigger on an EDGE, EOL (End of Line), EOF (End of 
Frame) or NONE. When the trigger is armed and a trigger Event occurs (or, if the trigger is forced), 
an ABORT box, shown in Figure 3.8b, giving you the ability to abort the data acquisition appears.

Note: If Event = NONE, you must FORCE TRIGGER to begin data acquisition.

Figure 3.8b   Abort box
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Channel

The Channel drop-box allows the following data types to be used as a trigger:

• Signal Sum

• X sensor

• Y sensor

• Z sensor

• Deflection Error

• Friction

• Z Feedback Output

• Input 1

• Input 2

• Input 3

• X Scan

• Y Scan

Level

Select the trigger LEVEL at which you wish to begin acquiring data.

Slope

You may trigger on either a POSITIVE or NEGATIVE SLOPE.

Delay

Trigger DELAY, if POSITIVE, specifies the amount of time between when the trigger conditions are 
met and when data capture begins. If NEGATIVE, DELAY specifies the amount before the trigger 
conditions are met that data capture begins.

Duration

The time DURATION of data that is saved.
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3.8.3 Status Panel

The high speed data capture status is displayed in the status panel at the bottom of the HSDC 
window. Captured file names have a suffix of .hsdc

3.8.4 Point And Shoot

The High Speed Data Capture (HSDC) function in the Point and Shoot view, shown in Figure 3.8c, 
allows you to mark a spot for data collection. This can be operated in two modes:

1. WHILE SCANNING: triggers a capture when the tip passes the marker point.

2. WHILE SCAN IDLE: stops the scan, moves to the marked point and captures data there.

In either mode, you must set the capture conditions in the High Speed Data Capture window 
before acquiring data.

FORCE TRIGGER: forces a trigger at the marked point regardless of the preset trigger conditions.
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Figure 3.8c   Point and Shoot - High Speed Data Capture
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3.9 Pulse Counting

Counting of TTL-compatible pulses input through the DIGITAL 1 IN 1 and DIGITAL 2 IN 2 inputs is 
enabled by setting the Channel Data Type to either COUNTER 1, COUNTER 2, FREQ.1 or FREQ.2, 
shown in Figure 3.9a. COUNTER 1/2 Data Types display results in counts/pixel while FREQ.1/2 
DATA TYPES display results in counts/second (Hz). I.e. each pixel represents a frequency. This 
result is a function of Scan Rate and number of Samples/Line.

Figure 3.9a   Pulse Counter Enabled 

Set Offline Plane Fit to NONE. If Offline Plane Fit is not set to NONE, the frequency data will be 
offset. REALTIME PLANE FIT applies only to image view mode, not data, but typically should be 
set to LINE to enable visibility of data over all ranges.

The counter range is 0 to 32767 counts/pixel.

The sensitivity of pulse counter is user-adjustable but should generally be left unchanged at 1.0.

Note: The Pulse Counting function is not available on all microscopes, e.g. the 
Dimension Icon-PI.
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Chapter 4   File Navigation and Browsing
The Browse and File Navigation commands allow you to select, display and export NanoScope 
images.

Refer to the following commands available in the NanoScope software:

• The Browse Window:  Section 4.1

• Image Display:  Section 4.1.1

• Exporting Images:  Section 4.1.2

• Add View:  Section 4.2.1

• Workflow Toolbar Commands:  Section 4.2

• Add View:  Section 4.2.1

• Remove File on Close:  Section 4.2.2
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4.1 The Browse Window

Open the Browse window by clicking the SHOW/HIDE BROWSE icon on the toolbar. Directory 
icons appear in the browse window. Double-click a folder icon to browse that directory (see Figure 
4.1a).

Figure 4.1a   Browse Window

Browse window icons are shown in Figure 4.1b.

Figure 4.1b    Browse Window Icons

Directory Folder Icon

SHOW/HIDE BROWSE WINDOW

List View

Thumbnail View Browse Capture Directory

Go Up One Level
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Selecting the first icon of the file browsing window initiates a List View of file information, shown 
in Figure 4.1c.

Figure 4.1c   Browse List View

Right-clicking the USER DEFINABLE button allows you to view and sort for many SPM parameters. 
See Figure 4.1d.

Figure 4.1d   Browse Column Configuration

Clicking the second icon in the upper left of the file browsing window causes thumbnail 
presentation of image files, illustrated in Figure 4.1e. 

If no images are selected, right-clicking in the image browse window (but not on an image icon) 
allows you to sort the image icons in the browse window. See Figure 4.1f. Double- click on a 
thumbnail to open the image for further analysis. 

Clicking the CAPTURE DIRECTORY icon in the upper left of the file browsing window displays file 
information, in either text or thumbnail presentations, of the capture directory (default is 
D:\capture).
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Figure 4.1e   Thumbnail Images in the Browse Window

Figure 4.1f   Sorting Thumbnails

You can change the current capture directory in the Capture File dialog box by selecting 
CAPTURE > CAPTURE FILENAME... from the menu bar, shown in Figure 4.1g.

Figure 4.1g   Capture File Dialog Box
6 NanoScope Software 8.10 User Guide Rev. D



File Navigation and Browsing
The Browse Window

Re
4.1.1 Image Display

If no images are selected, right-clicking in the image browse window (but not on an image icon) 
allows you to select a display channel and a color table for the image icons in the browse window. 
See Figure 4.1h.

Figure 4.1h   Selecting the Display Channel and Color Table for the Icons

 See Appendix B for a list of color tables.
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4.1.2 Exporting Images

You may export images, in either bitmap, JPEG or tiff formats from the image browse window by 
right-clicking single or multiple images (shift right-click), shown in Figure 4.1i. You may then 
select the channel and a color table.

Figure 4.1i   Exporting Multiple Images from the Image Browse Window
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4.2 Workflow Toolbar Commands

4.2.1 Add View

Right-click the offline icon of an image in the workspace window to display the Offline Add View 
menu. The commands include display, measurement, analysis and modification commands, shown 
in Figure 4.2a.

Figure 4.2a   Image Processing Functions Menu

You can also add Offline views by clicking IMAGE, ANALYSIS or MODIFY in the NanoScope 
toolbar and selecting the desired function (see Figure 4.2b).

Figure 4.2b   Adding Offline Functions

display commands

measurement/analysis commands

modify commands
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4.2.2 Remove File on Close

Select TOOLS > OPTIONS > REMOVE FILE ON CLOSE menu item (see Figure 4.2c). You can also 
right-click the workspace and select REMOVE FILE ON CLOSE, shown in Figure 4.2d. When 
selected, this option removes the workspace item of the offline file when all views on that file are 
closed.

Figure 4.2c   Select TOOLS > OPTIONS > REMOVE FILE ON CLOSE

Figure 4.2d   Select REMOVE FILE ON CLOSE from the Workflow Toolbar
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Note: The entire Tools > Options menu, with the exception of Set Help File..., is 
available when you right click in the workspace (not on a node).
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Chapter 5   Display Commands
The Display commands relate to the display of images captured in Realtime mode. These 
commands are known as image processing.

Refer to the following analysis commands available in Offline menu of the NanoScope software:

• Image:  Section 5.1

• Multiple Channel Analysis:  Section 5.1.2

• 3D Surface Plot:  Section 5.2

• Zoom:  Section 5.3

• High Speed Data Capture Display:  Section 5.4
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5.1 Image

The term Image refers to the data captured in RealTime mode. The current image processing 
capabilities include data analysis, modification, presentation and storage of the images. The source 
of the image includes: 

• Data captured in RealTime scanning mode

• New image files created using modify or analysis commands

For general information on the interface and basic functions in image processing, see Using the 
Image Interface: Section 5.1.1.

5.1.1 Using the Image Interface

To process an image, you must open an image file. This can be done by:

1. Clicking File > Open. When the Open Nanoscope File dialog box opens (see Figure 5.1a), 
select Captured Data File (*.*) and click the Ok button.

Figure 5.1a   Open NanoScope File Dialog Box
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2. Double-clicking an image in the Browse window. The new image appears in the client 
window (see Figure 5.1b).

Figure 5.1b   Image for Processing

Right-Clicking in the Image Window

By right-clicking in the Image window, but not on the image (see Right-Clicking on the Image on 
page 226), shown in Figure 5.1b, that allows you to perform the following tasks:

• Note—Adds notes to an image file.

• All Channels—When checked, the All Channels button displays all captured data 
channels.

• Export View—Exports the current view as a jpeg image.

• Copy View—Copies the current view to the clipboard.
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Right-Clicking on the Image

By right-clicking on the image, you will get a menu, shown in Figure 5.1c, that allows you to 
perform the following tasks:

Figure 5.1c   Image Click

• Rotating Line—Left-click, hold, and drag out a line. Release the mouse button to end 
the line.

• Box (for some analyses)—Left-click, hold, and drag out a box and release the mouse 
button.

Note: Left-clicking in the center of the box allows you to translate. Left-clicking on 
edges allows you to change the box size.

• Copy Clipboard—Copies the image to the Microsoft clipboard.

• Tooltip Info Level:

• Basic

• Medium

• Advanced

• None

• Export—Exports the image as a bitmap.

• Channel—Selects which channel is displayed.
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Image Buttons

Clicking the Image buttons, shown in Figure 5.1d, above the captured image (see Figure 5.1e) 
performs the following functions:

Figure 5.1d   NanoScope Image buttons

Table 5.1a   NanoScope image buttons

Right-Clicking on the Color Bar

Right-clicking on the color bar along the right side of the image (see Figure 5.1e) will produce a 
COLOR SCALE button. Clicking on this COLOR SCALE button will open the Color Scale dialog 
box, where you can perform the following image adjustments:

• Contrast—Number (-10 to +10) designates contrast of colors in displayed image (e.g., 
-10 shows little change, while 10 shows highest contrast).

• Offset—Number (-128 to +128) designates offset of colors in displayed image (e.g., 
120 shows illuminated background on image). Offset effectively changes the color 
value around which the color scale is mapped.

• Data Scale—Designates the vertical range of the displayed data, corresponding to the 
full extent of the color table.

• Table—Designates the Color Table number. There are 25 available color scales. For 
instance color Table 0 is grayscale, color Table 1 features blue... See Appendix B for a 
list of color tables.

Measure Left-click, hold, and drag out a line. Length of line appears in a box near the line any time cursor is 
on the line.

Pan From a zoomed image, you can pan around to other areas of the original image.

Data Zoom Left-click, hold, and drag out a box. Release the mouse button and the image will automatically 
zoom in to the area of the box. The zoomed region will be centered about the point originally 
selected.

Resize Up Resizes the image up to the previous zoom level.

Resize Down Resizes the image down to the previous zoom level.

Measure

Pan

Data Zoom

Resize Up

Resize Down
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Figure 5.1e   Image Adjustment Controls

 Using the Mouse Within a Captured Image

Figure 5.1f   Image Cursor Menu

Left-Click anywhere in image 
window, drag line out, and 
release

Creates a line of X length, at o angle in the image window

Place cursor on line Displays length and angle values of line in the image window

Place cursor on line, click 
and hold left button, and 
drag

Allows you to drag the line anywhere in the image window

Click and hold on either end 
of line and drag

Changes length and/or the angle of the line

Right-Click Clicking the right mouse button when the cursor is on the line 
accesses the Image Cursor menu (see Figure 5.1f)

• Delete—deletes the line.

• Flip Direction—switches the line end to end.

• Show Direction—Adds small arrowhead to the line to 
indicate direction.

• Set Color—Allows you to change the color of the line.

• Clear All—Deletes all lines.

Image
Buttons

Color Scale
Menu

Color
Scale 
Dialog Box

Color Bar
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5.1.2 Multiple Channel Analysis

It is often advantageous to analyze more than one channel of data from the same scan 
simultaneously. The Multiple Channel Analysis feature allows you to view up to eight channels of 
data simultaneously with one channel enlarged. Multiple Channel is the default initial view for all 
offline image analysis.

Eight Channel Image

Open the Multiple Channel offline view by double-clicking an image file in the image browse 
window. See Figure 5.1g and Figure 5.1h. Change the displayed channel by clicking either a 
thumbnail on the bottom or the previous/next buttons below the image window.

Figure 5.1g   Multi-Channel offline view—single monitor

Channel
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Figure 5.1h   Multi-Channel offline view—dual monitor

Analyzing Captured Multichannel Images

When performing any analysis of a multichannel scan, you may only analyze one channel at a time. 
Highlight the appropriate channel image by clicking on it, then select the desired Analysis View by 
any one of the following:

• Right-clicking on the image file name in the Workspace, selecting Add View, and 
clicking on the desired view.

• Selecting Analysis or Modify from the menu bar and clicking on the desired view.

• Clicking on the appropriate button in the toolbar bar.

• Right-clicking on a thumbnail in the Multiple Channel window.

Once you select the desired channel, and the appropriate view, a new window will open with only 
the image of the selected channel and you may start your analysis. If the image display in the view 
is not the desired channel, you can right-click on the image, go to Channel, and select the 
appropriate channel from the pop-up menu.

Channel
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5.1.3 Dual and Triple-Scan Images

Clicking the Image icon on the toolbar will display a single channel image. Right-click in the 
Image window, but not on the image and select ALL CHANNELS to display up to three channels 
simultaneously. Click on the desired image to select the channel and the corresponding channel data 
will appear (see Figure 5.1i).

Note: The location of the Channel data may vary depending on window proportions.

Figure 5.1i   Captured Dual-Scan Image
Rev. D NanoScope Software 8.10 User Guide 231



Display Commands
3D Surface Plot
5.2 3D Surface Plot

The 3D Surface Plot View displays the selected image with color-coded height information in a 
three-dimensional, oblique perspective. You can select the viewing angle and illumination angle for 
a modeled light source. 

You can view the 3D Surface Plot view using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > 3D Surface 
Plot from the popup menu.

Or

• Right-click on a thumbnail in the Multiple Channel window and select 3D SURFACE 
PLOT.

                                     Or

• Select IMAGE > 3D SURFACE PLOT from the menu bar.

                                     Or

• Click the 3D Surface Plot icon in the toolbar.

The 3D Surface Plot panel, shown in Figure 5.2a, appears and allows formatting of image data.

Figure 5.2a   3D Surface Plot Window
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5.2.1 Parameters in the 3D Surface Plot Inputs

The Projection, Plot Type, and Label Type parameters can be changed by clicking in the related 
window and selecting from the drop-down menus. The remaining parameters may be changed by 
typing the desired information in the related window or by use of the keyboard and mouse keys. 

• To zoom in or out on the image, hold the control key down and slide the mouse up and 
down on the image while holding the left mouse button.

• To pan, hold the shift key down and move the mouse up, down, left, or right on the 
image while holding the left mouse button.

• Clicking and holding the right mouse button down while moving the mouse left and 
right changes the light rotation on the image. This is only available when Plot Type is 
set to MIXED.

• Clicking and holding the right button while moving the mouse up down changes the 
light pitch. This is only available when Plot Type is set to Mixed.

The function of the Input parameters are:

Projection Select either Parallel or Perspective 

• In Parallel mode, the viewing volume does not 
change, which has the effect keeping objects the 
same size as they are projected. This is useful for 
maintaining the size and angle of objects between 
the front and back of the view. 

• In Perspective mode, objects appear to get smaller 
the further away they are from the eye. This is how 
the objects are perceived in the real world.

Plot Type Select Height, Wire, or Mixed

• Height displays the image with height values 
encoded according to the color table.

• Wire displays the image as a line representation of 
the scanned data.

• Mixed displays a combination of height and 
illumination encoding. 

Rotation The Rotation parameter in the Surface Plot Inputs 
changes as the viewing angle is changed by rotating the 
displayed image about the Z axis relative to its captured 
orientation.

Pitch The Pitch parameter in the Surface Plot Inputs changes 
as the viewing angle by manually changing the pitch of the 
Y axis in the three-dimensional Surface Plot image.

Light Rotation The Light Rotation parameter in the Surface Plot Inputs 
rotates the light source in the horizontal plane (xy plane). 
This is only available when the Plot Type is set to Mixed.
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The Export button allows the operator to export the image in the window to either JPEG or bitmap 
(bmp) format.

Light Pitch The Light Pitch parameter in the Surface Plot Inputs 
changes the viewing angle by selecting the pitch of the Z 
axis in the three-dimensional Surface Plot image. This is 
only available when the Plot Type is set to Mixed.

Light Intensity Selects the percentage of the imaginary light source mixed 
with the color-encoded height information when the Plot 
Type is set to Mixed.

Label Type The Label Type parameter in the Surface Plot Inputs 
selects whether labels and/or axes are displayed with the 
image.

• All displays the axes with labels.

• Axis displays the axes without labels.

• None displays the image without labels.

Channel Displays the current channel of multichannel scan dis-
plays.
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5.3 Zoom

The Zoom function has been replaced by the Crop and Split function. See Crop and Split: 
Section 7.3.

5.4 High Speed Data Capture Display

Files created using the High Speed Data Capture on page 205 feature can be displayed by double-
clicking the file icon (.hsdc file type) in the NanoScope browse window. This opens a window, 
shown in Figure 5.4a, that displays the captured data for multiple channels.

Figure 5.4a   HSDC Offline Display Window

You may zoom in on the plotted data by using CTRL plus the left mouse button. Revert to the 
original plot scale by clicking the magnifying glass in the lower left corner of the plot area.

In addition to displaying the captured data plotted vs. time, you may also perform a Fast Fourier 
Transform of the data by changing the DISPLAY TYPE to AMPLITUDE VS FREQUENCY.
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The function of the Channel data parameters are:

Channel Number Selects the CHANNEL (1-4) to display

Points/Pixel This parameter is used to speed plotting of large data files in a small (~355 
pixels horizontally) display area. If your file has 100,000 data points and you 
select 100 points/pixel (the default) ~35,500 data points will be plotted—
every third point. As you zoom in, the number of skipped points will decrease.
Aliasing may occur if there are many skipped points.
The total number of points in the file and plot increment is shown in the status 
bar at the lower left of the NanoScope window.

Display Type Determines the type of plot:

• CHANNEL VS TIME

• AMPLITUDE VS FREQUENCY computes and displays a FFT of the 
data between the markers. If you do not have markers, the FFT will be 
performed on all the input data.

The plot is updated only when the DISPLAY TYPE is changed.

Frequency Bin Width The approximate width of the histogram bin used in for the FFT calculation. 

Because a FFT algorithm is employed, this user input is updated so that 2n 
points are used.

Number of Time Segments (sample data time)/(1./frequency bin width). [1] A portion of the last segment 

may be truncated to accommodate the FFT 2n points requirement. You may 
wish to increase the FREQUENCY BIN WIDTH if the NUMBER OF TIME 
SEGMENTS is small.

X Scale Determines the scaling of the X Axis:

• LINEAR

• LOG base 10

Y Scale Determines the scaling of the Y Axis:

• LINEAR

• LOG base 10

High Speed Data Type Displays the DATA TYPE of the selected channel.

Units Determines the Y axis units:

• VOLTS

• METRIC

Fit Type Determines the type of fit between the markers:

• NONE

• LINE
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The Analysis commands relate to analyzing the surface behavior of materials on images captured 
in Realtime mode. These commands are known as image processing or analysis commands. The 
commands contain views, options and configurations for analysis, modification, and storage of the 
collected data. The analysis may be automated (i.e., in autoprograms) or completed manually. In 
general, the analysis commands provide methods for quantifying the surface properties of samples.

Refer to the following analysis commands available in Analysis menu of the NanoScope software:

• Depth:  Section 6.1

• Power Spectral Density:  Section 6.2

• Roughness:  Section 6.3

• Section:  Section 6.4

• Step:  Section 6.5

• Tip Qualification:  Section 6.6

• Width:  Section 6.7

• XY Drift:  Section 6.8
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6.1 Depth

To analyze the depth of features you have numerous choices which measure the height difference 
between two dominant features that occur at distinct heights. Depth was primarily designed for 
automatically comparing feature depths at two similar sample sites (e.g., when analyzing etch 
depths on large numbers of identical silicon wafers).

Refer to the following sections on Depth analysis:

• Depth Theory: Section 6.1.1

• Depth Procedures: Section 6.1.2

• Depth Interface: Section 6.1.3

6.1.1 Depth Theory

The Depth command accumulates depth data within a specified area, applies a Gaussian low-pass 
filter to the data to remove noise, then obtains depth comparisons between two dominant features. 
Although this method of depth analysis does not substitute for direct, cross-sectioning of the 
sample, it affords a means for comparing feature depth between two similar sites in a consistent, 
statistical manner.

The Depth window includes a top view image and a histogram; depth data is displayed in the 
Results window and in the histogram. The mouse is used to resize and position the box cursor over 
the area to be analyzed. The histogram displays both the raw and an overlaid, Gaussian-filtered 
version of the data, distributed proportional to its occurrence within the defined bounding box.

Histogram

Raw Data

Figure 6.1a (bottom graph) displays a histogram from raw depth data. Data points A and B are the 
two most dominant features, and therefore would be compared in Depth analysis. Depending upon 
the range and size of depth data, the curve may appear jagged in profile, with noticeable levels of 
noise.

Note: Color of cursor, data, and grid may change if user has changed the settings. 
Right-click on the graph and go to Color if you want to change the default 
settings. 
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Figure 6.1a   Depth Histogram

Correlation Curve

The Correlation Curve is a filtered version of the Raw Data Histogram and is located on the 
Raw Data Histogram represented by a red line. Filtering is done using the Histogram Filter 
Cutoff parameter in the Inputs parameters box.The larger the filter cutoff, the more data is filtered 
into a Gaussian (bell-shaped) curve. Large filter cutoffs average so much of the data curve that 
peaks corresponding to specific features become unrecognizable. On the other hand, if the filter 
cutoff is too small, the filtered curve may appear noisy.

The Correlation Curve portion of the histogram presents a lowpass, Gaussian-filtered version of 
the raw data. The low-pass Gaussian filter removes noise from the data curve and averages the 
curve’s profile. Peaks which are visible in the curve correspond to features in the image at differing 
depths.

Peaks do not show on the correlation curve as discrete, isolated spikes; instead, peaks are 
contiguous with lower and higher regions of the sample, and with other peaks. This reflects the 
reality that features do not all start and end at discrete depths. 

When using the Depth view for analysis, each peak on the filtered histogram is measured from its 
statistical centroid (i.e., its statistical center of mass).

30 60 90 1200
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6.1.2 Depth Procedures

1. You can open the Depth view, shown in Figure 6.1c and Figure 6.1d, using one of the 
following methods:

• Right-click on the image name in the Workspace and select Add View > Depth from 
the popup menu. See Figure 6.1b.

Figure 6.1b   Select Depth from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select DEPTH.

                                     Or

• Select ANALYSIS > DEPTH from the menu bar.

                                     Or

• Click the Depth icon in the toolbar.

2. Using the mouse, left-click and drag a box on the area of the image to analyze. 
The Histogram displays the depth correlation on this specified area.

Note: If no box is drawn, by default, the entire image is selected.

3. Adjust the Minimum Peak to Peak to exclude non relevant depths.

4. Adjust the Histogram Filter Cutoff parameter to filter noise in the histogram as desired.
0 NanoScope Software 8.10 User Guide Rev. D



Analysis Commands
Depth

Re
5. Note the results.

Note: To save or print the data, run the analysis in an Auto Program 
(see Chapter 8).

Figure 6.1c   Depth Window—single monitor
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Figure 6.1d   Depth Window—dual monitor
2 NanoScope Software 8.10 User Guide Rev. D



Analysis Commands
Depth

Re
6.1.3 Depth Interface

The Depth interface includes a captured image, Input parameters, Results parameters and a 
correlation histogram (see Figure 6.1e).

Figure 6.1e   Depth Interface
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Depth Input Parameters

The depth input parameters below define the slider cursor placement for determining the exact 
depth of a feature.

Results Parameters:

Using the Grid Display

Measurement cursors for the histogram are automatically positioned based on the numerical values 
selected in the Input fields. Slide the markers into the grid from the left or right side by clicking 
and holding the left mouse button. The location of the two markers is displayed in the Grid 
Markers window.

Number of Histogram Bins The number of data points which result from the filtering calculation. Note: 
Having more histogram bins than pixels is unnecessary.

Histogram Filter Cutoff Lowpass filter which smooths out the data by removing wavelength com-
ponents below the cutoff. Use to reduce noise in the Correlation histogram.

Minimum Peak To Peak Sets the minimum distance between the maximum peak and the second 
peak marked by a cursor. The second peak is the next largest peak to meet 
this distance criteria.

Left Peak Cutoff The left (smaller in depth value) of the two peaks chosen by the cursors. 
Value used to define how much of the left peak is included when calculat-
ing the centroid. At 0 percent, only the maximum point on the curve is 
included. At 25 percent, only the maximum 25 percent of the peak is 
included in the calculation of the centroid. 

Right Peak Cutoff The right (larger in depth value) of the two peaks marked by the cursors. 
Value used to define how much of the right peak is included when calculat-
ing the centroid. At 0 percent, only the maximum point on the curve is 
included. At 25 percent, only the maximum 25 percent of the peak is 
included in the calculation of the centroid.

Data Range Pad Creates a buffer region at either end of the histogram.

Peak to Peak Distance Depth between the two data peak centroids as selected using the line cur-
sors.

Minimum Peak Depth The depth of the deeper of the two features.

Maximum Peak Depth The depth of the shallower of the two features.

Depth at Histogram Maximum Depth at the maximum peak on the histogram.

Number of Peaks Found Total number of peaks included within the data histogram.
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Right-clicking on the grid will bring up the Grid Parameters menu (see Figure 6.1f) and allow you 
to make the following changes:

Figure 6.1f   Grid Parameters Menu

Color Allows operator to change the color of the:

• Curve (data)

• Text

• Background

• Grid

• Minor Grid

• Markers

Filter Typically used for a Profiler Scan.

• Type—Select None, Mean (default), Maximum, or Minimum

• Points—Select 4k, 8k (default), 16k, or 32k

Minor Grid Places a minor grid in the background of the Graph window.

Scale Allows user to auto scale, set a curve mean, or set their own data 
range

Line Style For each curve, the operator can choose a connect, fill down, or point 
line.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard

Print Prints out the current screen view to a printer

Export Exports data in bitmap, JPEG or XZ data format

Active Curve Determines which curve you are analyzing
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6.2 Power Spectral Density

The Power Spectral Density (PSD) function is useful in analyzing surface roughness. This 
function provides a representation of the amplitude of a surface’s roughness as a function of the 
spatial frequency of the roughness. Spatial frequency is the inverse of the wavelength of the 
roughness features.

The PSD function reveals periodic surface features that might otherwise appear random and 
provides a graphic representation of how such features are distributed. On turned surfaces, this is 
helpful in determining speed and feed data, sources of noise, etc. On ground surfaces, this may 
reveal some inherent characteristic of the material itself such as grain or fibrousness. At higher 
magnifications, PSD is also useful for determining atomic periodicity or lattice.

Refer to the following Power Spectral Density sections:

• PSD and Surface Features:  Section 6.2.1

• PSD and Flatness:  Section 6.2.2

• Performing a Spectral Density Analysis:  Section 6.2.3

• Changing Parameters of the Spectrum Plot:  Section 6.2.4

6.2.1 PSD and Surface Features

Consider the image in Figure 6.2a.

Figure 6.2a   Waveform Surfaces

This synthetic surface consists of essentially two dominant wave forms: a long period waveform 
along the X-axis, and a shorter period waveform along the Y-axis. A 2 dimensional power spectral 
density plot consists of two dominant spikes (one for each dominant wavelength), plus some 
number of extra wavelengths inherent within the image. (These extra wavelengths may appear due 
to fine surface features and/or side bands of the dominant wave forms.) Because of the sinusoidal 
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nature of the composite wave form, a relatively small set of spectral frequencies suffices to describe 
the entire surface. By contrast, an image comprised of angular (saw-toothed or square) waveform 
contains more spatial frequency components.

Over a given range of spatial frequencies the total power of the surface equals the RMS roughness 
of the sample squared. 

The frequency distribution for a digitized profile of length L, consisting of N points sampled at 
intervals of do is approximated by:

Where i = -1, and frequencies, f, range from  to . Practically speaking, the algorithm used 

to obtain the PSD depends upon squaring the FFT of the image to derive the power. Once the 
power, P, is obtained, it may be used to derive various PSD-like values as follows:

The terms used in the denominators above are derived by progressively sampling data from the 
image’s two-dimensional FFT center (see Figure 6.2b).

Figure 6.2b   Progressive Data Sampling

Each sampling swings a “data bucket” of given frequency f. Since samples are taken from the 

image center, the sampling frequency, f, is limited to , where N is the scan size in pixels. This 

forms the upper bandwidth limit (i.e., the highest frequency or Nyquist frequency) of the PSD plot. 
The lower bandwidth limit is defined at 1/L.
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6.2.2 PSD and Flatness

PSD is used increasingly as a metrology tool for evaluating extremely flat surfaces, such as 
polished or epitaxial silicon. Generally, the desired surface is expected to adhere to certain PSD 
thresholds, signifying it meets a specified flatness criterion.

The main advantage gained over traditional RMS specifications is that PSD flatness is qualified 
through the full spectral range of interest. For example, one may specify spectral thresholds at 
frequencies measured on the atomic scale, thus ensuring surfaces consist largely of uniform 
lattices. Setting the precise thresholds for various materials remains a matter of debate.

Consider the image of epitaxial gallium arsenide in Figure 6.2c.

Figure 6.2c   Epitaxial Gallium Arsenide Image

This surface is comprised of “terraces” formed from the material’s natural lattice structure; each 
terrace is one atomic monolayer thick and is spaced at fairly regular intervals. This degree of 
flatness is handily evaluated with PSD, as the terraces produces a spectral spike corresponding to 
their spacing wavelength. A PSD plot for this type of surface generally takes the form shown in 
Figure 6.2d.

Figure 6.2d   PSD Plot for Terraced Sample

 

Special spike corresponding to “terrace” spacings on surface
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This tapered PSD plot is characteristic of flat, isotropic surfaces. Longer wavelengths are present 
up to the scan width, and are accompanied by uniformly decreasing powers of shorter wavelengths 
down to 2 pixels. On the plot shown above a spike stands out, corresponding to the wavelength 
spacing of the terraced features. Depending upon the qualitative standards of the person evaluating 
such a plot, this spike may exceed a threshold standard of flatness.

6.2.3 Performing a Spectral Density Analysis

To use the PSD Analysis function, perform the following procedures:

1. You can open the Power Spectral Density view, shown in Figure 6.2f, using one of the 
following methods:

• Right-click on the image name in the Workspace and select Add View > Power 
Spectral Density from the popup menu. See Figure 6.2e.

Figure 6.2e   Select Power Spectral Density from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select POWER 
SPECTRAL DENSITY.

                                     Or

• Select ANALYSIS > POWER SPECTRAL DENSITY from the menu bar.

                                     Or

• Click the Power Spectral Density icon in the NanoScope toolbar.
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The PSD window opens to allow spectral density plotting (see Figure 6.2f and Figure 6.2g).

Figure 6.2f   The Initial PSD Analysis Window
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Figure 6.2g   The PSD analysis window—dual monitor
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Compute PSD Buttons

Once the PSD analysis window is opened, select the type of spectral density analysis you wish to 
perform by clicking the appropriate button in the Compute PSD window.

2D Isotropic—Executes a two-dimensional Power Spectral Density analysis.

Horizontal Axis—Executes a one-dimensional Power Spectral Density analysis along the X-axis.

Vertical Axis—Executes a one-dimensional Power Spectral Density analysis along the Y-axis.

The calculation begins as soon as one of these buttons is selected. The PSD and a table of values 
from the graph are shown in the Results window. Completion of the analysis will also result in a 
topographical histogram in the spectrum plot window, shown in Figure 6.2h.

Figure 6.2h   Power Spectral Density Histogram
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Results Parameters:

Results Display

The Results window displays the Name and Value of the procedures performed during a PSD 
analysis. The teal shaded area in the display window corresponds to the area designated by the teal 
cursor on the Power Spectral Density histogram, and the magenta shaded area corresponds to the 
magenta cursor. You can generate a report by right-clicking in the Results window, selecting COPY 
TEXT and pasting the clipboard into another application (e.g. Notepad, Word...).

Select Displayed Parameters

Wavelength The wavelength, , in m/cycle units at current cursor positions. See Fig-
ure 6.2a.

Frequency The spatial frequency (1/) at current cursor positions.

Power Power measured in nm2 at current cursor positions.

1D PSD One-dimensional power spectral density. Power measured in nm3 at cur-
rent cursor positions. See Page 247 for a mathematical definition.

1D Isotropic PSD One-dimensional isotropic power spectral density. Power measured in 

nm3 at current cursor positions. See Page 247 for a mathematical defini-
tion.

2D Isotropic PSD One-dimensional isotropic power spectral density. Power measured in 

nm4 at current cursor positions. See Page 247 for a mathematical defini-
tion.

Total Power The sum of the power contained in the entire spectrum.

Equivalent RMS The root-mean-square (RMS) roughness of the sample. It is calculated as 
the square root of the total power.

Power Between Cursors The sum of the power contained in the portion of the spectrum between 
the cursors.

Equivalent RMS The root-mean-square (RMS) roughness of the sample contributed by the 
frequencies between the cursors. It is calculated as the square root of the 
integral of the Power Between Cursors (above).
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The operator can select which Results will or will not be displayed in the Results window by 
Right-clicking in the Results window, selecting SHOW ALL from the popup menu, and checking or 
unchecking the appropriate boxes (see Figure 6.2i).

Figure 6.2i   Select Show All On/Off Check Boxes

Exporting Text

Selecting COPY TEXT from the popup menu will copy the text from the Results window, in tab-
delimited text format, to the Windows clipboard. You may then paste it into a text or word 
processing program.
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6.2.4 Changing Parameters of the Spectrum Plot

The Spectrum Plot window displays results of the PSD analysis (see Figure 6.2j). The window has 
two cursors whose color corresponds to the shaded areas in the Results window. You can move 
either of these cursors within the Spectrum Plot window by placing the cross hair cursor directly 
over the cursor, clicking and holding the left mouse button, and dragging the mouse to the left or 
right. You can also move both cursors simultaneously by left-clicking the mouse with the cross hair 
cursor anywhere between the two cursors and dragging to the left or right.

To change the parameters of the Spectrum Plot, right-click in the Spectrum Plot window at the 
bottom of the display and choose from the popup menu.

Figure 6.2j   Spectrum Plot Parameter Menu

Popup MenuTeal Cursor Magenta CursorSpectrum Plot
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Spectrum Plot Popup Menu Items

Color—Changes the colors of the curves, text, background, grid lines, minor grid lines (if 
selected), and the marker pairs (see Figure 6.2k).

Filter—Selects Filter type and points (see Figure 6.2l).

Minor Grid—Shows/hides minor grid lines

Figure 6.2k   Color Menu Items

Figure 6.2l   Filter Menu Items

Scale—Sets the vertical axis range, the center of the range, or allow the software to autoscale (see 
Figure 6.2m).

Line Style—Changes the line style of the Spectrum Plot graphical display (see Figure 6.2n).

User Preferences—You can either save all changes made to the graphical display, or restore 
previously saved settings (see Figure 6.2o). Save will result in all graphical displays maintaining 
any design changes made to this display.

Copy Clipboard—Copies the graphical display only to the Windows clipboard, allowing it to be 
pasted into any compatible Windows program.

Print—Prints the graphical display only to a printer.
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Export—Saves the graphical display as a JPEG graphic, a Bitmap graphic, or as an XZ Data file 
text, which can be read in a database program (e.g. Excel).

Active Curve—Changes the curve displayed when more than one curve has been plotted. (Does 
not occur in PSD).

Figure 6.2m   Scale Settings Dialog Box
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Figure 6.2n   Line Style Display

Figure 6.2o   User Preferences Menu
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6.3 Roughness

The Roughness command generates a variety of statistics on surfaces, including classical 
roughness values and peak and zero crossing data. “Image” statistics are reported for the entire 
image. “Box” statistics are reported only for the region you define within a cursor box. In addition, 
the data can be augmented with stopbands, (excluding features) to isolate desired analysis.

Refer to the following sections on Roughness:

• Roughness Theory:  Section 6.3.1

• Roughness Procedures: Section 6.3.2

• Roughness Interface: Section 6.3.3

Most industrial standards for roughness measurement call for planefitting data before calculating 
values. Planefitting applies a temporary first-order planefit before calculating statistics. On many 
surfaces, especially those which are tilted, this yields different values from those seen in raw 
(unplanefitted) data. Moreover, peripheral features included within the analyzed region may 
produce cumulative results uncharacteristic of the feature(s) of interest. To ensure the best results, 
you should observe the following rules when using Roughness analysis:

• If the image shows signs of second- or third-order distortion (e.g., bow due to large 
scans on large scanners), apply a second- or third-order Flatten and Planefit to the 
image before using Roughness analysis.

• Isolate your analysis to specific areas of the image. This may be accomplished by using 
the box cursor in Roughness to analyze only select portions of the image.

6.3.1 Roughness Theory

Regarding the effects of Planefitting on Roughness statistics—When Roughness analysis is 
applied to an image, statistical values are calculated according to the relative heights of each pixel 
in the image. Planefitting (used to correct images for tilt and bow) reorients these pixels in a 
manner which can affect roughness statistics dramatically on some surfaces. This is especially true 
of surfaces having broad, coplanar features. Planefitting can be applied at the time of file capture 
using OL Plane Fit from a Channel panel, or via the Modify > Plane Fit function.

When Roughness analysis is applied to an image, the image data is automatically planefit 
beforehand. This is done to accord with ASME and ISO metrological standards. (Only the Raw 
mean parameter is exempt from this operation, being calculated from raw data only.) To avoid 
unexpected results due to planefitting, be certain to apply Roughness analysis only to the surface(s) 
of interest by utilizing a cursor box, or by scanning just the specific site of interest. Including 
peripheral features within an analyzed area may produce cumulative results uncharacteristic of the 
feature(s) of interest.

The relationship between the zero plane and the data also changes according to the setting of the 
OL Plane Fit parameter. If the OL Plane Fit parameter is set to None, the offset is not removed 
from the data and it is very possible that the zero plane does not intersect the data. The other 
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settings (see Data Type Range or Settings on page 93) of the parameter subtract the average Z value 
from every point in the image so the data varies around the zero plane.

Regarding Basic Roughness Measurements—Average roughness (Ra) is one of the most commonly 

used roughness statistics. Figure 6.3a represents two surfaces having the same average roughness.

Similarly, a number of other roughness values are based upon least-squares calculations (e.g., RMS 
roughness, or Rq), and their algorithms are more concerned with a best fit of all height points than 

with the spatial frequency of features.

The surface of image A is represented as having a high frequency profile of features. Image B 
represents a separate surface having the same average feature height, but distributed at wider 
(lower-frequency) intervals. In terms of average and RMS roughness, both surfaces are equally 
rough. If you are interested in differentiating between the two, you must rely upon other statistical 
parameters such as Power Spectral Density.

Figure 6.3a   Basic Roughness Measurements

6.3.2 Roughness Procedures

Example of Using Roughness Analysis

For general Roughness Analysis, complete the following procedures:

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

To use the Roughness Analysis function, perform the following procedures:

A B

Best-fit plane 
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2. You can open the Roughness view, shown in Figure 6.3c, using one of the following 
methods:

• Right-click on the image name in the Workspace and select Add View > Roughness 
from the popup menu. See Figure 6.3b.

Figure 6.3b   Select Roughness from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select ROUGHNESS.

                                     Or

• Select ANALYSIS > ROUGHNESS from the menu bar.

                                     Or

3. Click the Roughness icon in the NanoScope toolbar.

4. The Roughness View appears showing results for the entire image.

5. To perform Roughness measurements within an area, left-click and move the mouse to draw 
a measurement box. Click on the Execute button to calculate the Roughness inside the box.

6. To exclude an area, right-click in the image to access a pop-up menu and select Stop Band. 
Using the mouse, draw a box around the area to be excluded by the stop band command. 
Click on the Execute button to calculate the Roughness outside the box.
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6.3.3 Roughness Interface

The Roughness View shows the image along with Input parameters and a Results window.

Figure 6.3c   Roughness Display—single monitor

Input
Parameters Results

PARAMETERS
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Figure 6.3d   Roughness Display—dual monitor

Note: Some parameters are reported only when certain subroutines are turned on.

Input
Parameters

Results
PARAMETERS
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Input Parameters

Peak

The Peak feature, when switched ON, isolates specified height portions of the image (peaks) from 
background data. Peaks are specified using the Peak Threshold parameters, either in terms of their 
absolute height or their deviation from the RMS value of all surface data, and relative to either the 
highest data point (Peak) or the mean (Zero). When Peak is turned ON, portions of the image 
contained within the box cursor and falling within the specified boundaries are retained; all other 
data is removed.

Range or Settings—When Peak is turned ON, the following subcommands are activated (see 
Figure 6.3e): 

When Peak is turned ON, the following statistical parameters are turned on. All Peak parameters 
are calculated from the thresholds you define with the Peak subcommands.

• Rz

• Rz count

• Peak Count

• Valley Count

• Max peak ht (Rp)

• Av. Max ht (Rpm)

• Max depth (Rv)

• Av. max depth (Rvm)

When Peak is turned OFF, statistics are not calculated.

Peak Threshold 
Reference

The Reference buttons select whether the threshold is defined relative to 
the Zero (lowest) value, or the tallest Peak in the selected region.

Peak Threshold 
Value Type

The Value Type determines whether the threshold is defined as an abso-
lute distance from the reference point in nanometers (Absolute value) or 
a percentage of the root-mean-square (Rms %) of the Z values.

Peak Threshold 
Value 

The Value is an absolute distance from the reference point in nanometers 
(Absolute value) or a percentage of the root-mean-square (Rms %) of the 
Z values.
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Figure 6.3e   Input On Parameters

Zero Crossing

A zero crossing is a point where the Z values go through zero regardless of slope. This value is the 
total number of zero crossings along both the X and Y center lines divided by the sum of the box 
dimensions.

Range or Settings—When Zero crossing is turned ON and you click the EXECUTE button, the 
number of zero crossings along the X and Y center lines of the box cursor is determined (see Figure 
6.3e). The number of zero crossings is divided by the sum of the lengths of the X and Y center lines 
and reported as the Line density.

When Zero crossing is turned OFF, the zero crossing determination is not performed.

Peak Input Parameter ON

Zero Crossing Input Parameter ON
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Results Parameters

Statistics used by the Roughness routine are defined in this section. The terms are listed 
alphabetically. Most are derived from ASME B46.12 (“Surface Texture: Surface Roughness, 
Waviness and Lay”) available from the American Society of Mechanical Engineers.

Av max Depth (Rvm) Average distance between the (VALLEY COUNT value) lowest profile 
points and the mean data plane.

Av max ht (Rpm) Average distance between the (PEAK COUNT value) highest profile 
points and the mean data plane.

Box x Dimension The width of the Lx box cursor you define.

Box y Dimension The length of the Ly box cursor you define.

Image Mean Mean value of data contained within the image.

Image Projected surface 
area

Area of the image rectangle (X x Y).

Image Ra Arithmetic average of the absolute values of the surface height deviations 
measured from the mean plane. 

Image Raw mean Mean value of image data without application of plane fitting.

Image Rmax Maximum vertical distance between the highest and lowest data points in 
the image following the planefit.

Image Rq Root mean square average of height deviations taken from the mean 
image data plane, expressed as:

Image Surface area The three-dimensional area of the entire image. This value is the sum of 
the area of all of the triangles formed by three adjacent data points.

Image Surface Area 
Difference

Difference between the image’s three-dimensional Surface area and two-
dimensional projected surface area.

Image Z range Maximum vertical distance between the highest and lowest data points in 
the image prior to the planefit.

Kurtosis This is a non-dimensional quantity used to evaluate the shape of data 
about a central mean. It is calculated as

Graphically, kurtosis indicates whether data are arranged flatly or sharply 
about the mean.
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Line Density The number of zero crossings per unit length on the X and Y center lines 
of the box cursor. A zero crossing is a point where the Z values go through 
zero regardless of slope. This value is the total number of zero crossings 
along both the X and Y center lines divided by the sum of the box dimen-
sions.

Maximum Depth (Rv) Lowest data point in examined region.

Max Height (Rmax) Maximum vertical distance between the highest and lowest data points 
within the cursor box.

Max Peak ht (Rp) Maximum peak height within the analyzed area with respect to the mean 
data plane.

Mean The average of all the Z values within the enclosed area. The mean can 
have a negative value because the Z values are measured relative to the Z 
value when the microscope is engaged. This value is not corrected for tilt 
in the plane of the data; therefore, plane fitting or flattening the data 
changes this value.

Mean Roughness (Ra) Arithmetic average of the absolute values of the surface height deviations 
measured from the mean plane within the box cursor:

Peak Count The number of peaks taller than the THRESHOLD VALUE.

Projected Surface Area Area of the selected data.

Raw Mean Mean value of image data within the cursor box you define without appli-
cation of plane fitting.

Rms (Rq) This is the standard deviation of the Z values within the box cursor and is 
calculated as:

where Zi is the current Z value, and N is the number of points within the 

box cursor. This value is not corrected for tilt in the plane of the data; 
therefore, plane fitting or flattening the data changes this value.

Rz This is the average difference in height between the (RZ COUNT value) 
highest peaks and valleys relative to the Mean Plane.

Rz Count Number of peak/valley pairs that are used to calculate the value Rz.
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6.4 Section

The Section command displays a top view image, upon which one, two or three reference lines 
may be drawn. The cross-sectional profiles and fast Fourier transform (FFT) of the data along the 
reference lines are shown in separate windows. Roughness measurements are made of the surface 
along the reference lines you define.

Section is probably the most commonly used Analysis command; it is also one of the easiest 
commands to use. To obtain consistently accurate results, ensure your image data is corrected for 
tilt, noise, etc. before analyzing with Section.

• Sectioning of Surfaces: Overview: Section 6.4.1

• Section Procedures: Section 6.4.2

• Section Interface: Section 6.4.3

Skewness Measures the symmetry of surface data about a mean data profile, 
expressed as:

where Rq is the Rms roughness. Skewness is a non dimensional quantity 

which is typically evaluated in terms of positive or negative. Where 
Skewness is zero, an even distribution of data around the mean data plane 
is suggested. Where Skewness is strongly non-zero, an asymmetric, one-
tailed distribution is suggested, such as a flat plane having a small, sharp 
spike (> 0), or a small, deep pit (< 0).

Surface Area The three-dimensional area of the region enclosed by the cursor box. This 
value is the sum of the area of all of the triangles formed by three adjacent 
data points.

Surface Area Diff Difference between the analyzed region’s three-dimensional Surface area 
and its two-dimensional, footprint area.

Valley Count The number of valleys shorter than the THRESHOLD VALUE.

Z Range Peak-to-valley difference in height values within the analyzed region.

Skewness
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6.4.1 Sectioning of Surfaces: Overview

Samples are sectioned to learn about their surface profiles. The Section command does not reveal 
what is below the surface—only the profile of the surface itself. When sectioning samples, you 
should first ascertain surface topology. Depending upon the topology and orientation of the sample, 
the results of Section analysis may vary tremendously.

Figure 6.4a   Section Analysis Orientation

In Figure 6.4a, the sample surface (a diffraction grating) is sectioned along three axes. Sections 1 
and 2 are made perpendicular to the grating’s rules, revealing their blaze and spacings. (Sections 1 
and 2 may be compared simultaneously using two fixed cursor lines, or checked individually with a 
moving cursor.) Section 3 is made parallel to the rules, and reveals a much flatter profile because of 
its orientation.

The Section command produces a profile of the surface, then presents it in the Section grid (see 
Figure 6.4b).

1

2       

3

3

2

1
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Figure 6.4b   Section Command Profile

Generally, Section analysis proves most useful for making direct depth measurements of surface 
features. By selecting the type of cursor (Rotating Line, Rotating Box, or Horizontal Line), and 
its orientation to features, you may obtain:

• Vertical distance (depth), horizontal distance and angle between two or more points.

• Roughness along section line: RMS, Ra, Rmax, Rz.

• FFT spectrum along section line.

Features are discussed below. Refer to Roughness: Section 6.3 for additional information 
regarding roughness calculations.
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6.4.2 Section Procedures

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Section view, shown in Figure 6.4e, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Section from 
the popup menu. See Figure 6.4c.

Figure 6.4c   Select SECTION from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select SECTION.

                                     Or

• Select ANALYSIS > SECTION from the menu bar.

                                     Or

3. Click the Section icon in the NanoScope toolbar.

4. The Section View appears showing results for the entire image.

5. Before doing a section analysis, ensure that the image is properly oriented by removing any 
tilt or bow. This is especially important if a high level of precision is to be employed in 
measuring the blaze angle.
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6. To remove any tilt which might be present, select Modify > Plane Fit or the PLACE FIT icon 
on the NanoScope toolbar. Set the Plane Fit Order parameter in the panel to 1ST, then click 
the EXECUTE button. The image is fitted to a plane (“leveled”) by fitting each scan line to a 
first-order equation, then fitting each scan line to others in the image. At this point, the image 
has not been appreciably altered, it has only been reoriented slightly.

7. In Section Analysis, to make a single-line section of the image, use the mouse to draw a line 
through the image, as in Figure 6.4d, and note the results.

8. Move the grid cursors along the section to make measurements.

Figure 6.4d   Mouse Drawing Line

6.4.3 Section Interface

When a line is drawn on the image, the cross-sectional profile is displayed, and the FFT spectrum 
along the line is also displayed (see Figure 6.4e and Figure 6.4f). More detail about the FFT 
algorithm used may be found at http://www.fftw.org.

The markers may be positioned in the profile and FFT spectrum. The results window at the bottom 
of the display lists roughness information based on the position of the presently selected reference 
markers. Each marker pair is color coordinated with the data in the results window.

Use the mouse to drag a line
cursor across the image.
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Figure 6.4e   Section View—single monitor
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Figure 6.4f   Section View—dual monitor

Grid Markers:

A pair of markers in the section grid and a single marker in the spectrum grid will automatically be 
drawn. Place the mouse cursor on the desired marker and left-click to move.

Marker pair 0 Default display color is blue. Slide the markers into the grid from the left or right side by 
clicking and holding the left mouse button. Data between the two markers will be dis-
played in the results window at the bottom of the display screen in blue.

Marker pair 1 Default display color is red. Slide the markers into the grid from the left or right side by 
clicking and holding the left mouse button. Data between the two markers will be dis-
played in the results window at the bottom of the display screen in red.

Marker pair 2 Default display color is green. Slide the markers into the grid from the left or right side 
by clicking and holding the left mouse button. Data between the two markers will be 
displayed in the results window at the bottom of the display screen in green.

Spectrum Marker Displays a slider cursor along the spectral data (e.g., FFT Spectrum).
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Results Parameters:

The standard deviation RMS (Rq), mean roughness (Ra), the maximum height (Rmax), and the 

10-point roughness (Rz) for the segment between the reference markers are also listed in the 

Results window. 

Results Parameters:

Changing the cursor on the FFT changes lc, the cutoff length of the high-pass filter applied to the 

data. The filter is applied before the roughness data is calculated; therefore, the position of the 
cutoff affects the calculated roughness values.

Length Length of the roughness curve.

Rms (Standard Deviation) Standard deviation of the Z values between the reference markers, calcu-
lated as:

where Zi is the current Z value, Zave is the average of the Z values 

between the reference markers, and N is the number of points between the 
reference markers.

 Ra (Mean Roughness) Mean value of the roughness curve relative to the center line, calculated 
as:

where L is the length of the roughness curve and f(x) is the roughness 
curve relative to the center line.

Rmax (Maximum Height) Difference in height between the highest and lowest points on the cross-
sectional profile relative to the center line (not the roughness curve) over 
the length of the profile, L.

Rz (Ten-Point Mean 

Roughness)

Average difference in height between the five highest peaks and five low-
est valleys relative to the center line over the length of the profile, L. In 
cases where five pairs of peaks and valleys do not exist, this is based on 
fewer points.

Freq. Cutoff (m) Frequency Cutoff measured in terms of a percentage of the root mean 
square.
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• Rz Count—number of peaks used for Rz computation

• Radius—radius of circle fitted to the data between the cursors

• Radius Sigma—mean square error of radius calculation

• Surface Distance—distance measured along the surface between the cursors

• Horizontal Distance—horizontal distance between the cursors

• Vertical Distance—vertical distance between the cursors

• Angle—angle of the imaginary line drawn from the first cursor intercept to the second 
cursor intercept

• Spectral Period—spectral period at the cursor position

• Spectral Frequency—spectral frequency at the cursor position

• Spectral RMS Ampl.—amplitude at the cursor position

Right-clicking in the bottom results window opens allows you to open a Configure Columns 
window, shown in Figure 6.4g, which lets you select which parameters will be computed and 
displayed.

Figure 6.4g   Configure Columns Window
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Mouse Operations for a Rotating Line Cursor:

• Mouse down, drag—Anchors the origin of a line segment and expands from the selected 
position, allowing a line segment to be drawn in any direction.

• Mouse up—Anchors the terminal point of the first (dashed) line segment and draws a 
moving reference line perpendicular to the fixed-line segment. The cross-sectional 
profile and the FFT along the reference line are displayed at this time. The position of 
the moving reference line tracks the movements of the mouse. When the mouse is 
stationary, the cross-sectional profile and the FFT of the data along the moving 
reference line is updated.

• Clicking on the center of the line and dragging moves the line on the image.

• Clicking on either end of the line rotates the line.

Mouse Operations for Rotating Box Cursor (Right-Click Selection):

• 1st click—Anchors the origin of a box and “rubber bands” out from the center of the 
selected position.

• As a reference, the cursor positions show up on the center line in the box.

• Clicking on the box—Allows the box to be moved (cursor inside box), or resized (cursor 
on edge of box). Clicking on the corner allows the box to be resized in two directions.

• Holding the Shift button down while clicking on the box and dragging in a circular 
direction rotates the box.

Mouse Operations for a Horizontal Line Cursor:

• Mouse down—Draws a horizontal line segment at that location.

• Clicking on the line and dragging moves the line on the image.

Using the Grid Display

Measurement cursors for histogram and cross section views in Depth and Section are provided to 
the left and right of the Grid Display. You can bring the cursors into the grid by placing the mouse 
cursor onto the measurement cursors, clicking and holding the left mouse button, and dragging 
them onto the grid. When you place the mouse cursor onto a measurement cursor, the cursor will 
change to a horizontal or vertical double-arrow cursor , which indicates you can grab and drag 
this cursor.

Right-clicking on the grid will bring up the Grid Parameters menu (see Figure 6.1f) and allow you 
to make the following changes:
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Figure 6.4h   Grid Parameters Menu

Color Allows operator to change the color of the

• Curve (data)

• Text

• Background

• Grid

• Minor

• Marker

See Figure 6.4h.

Filter Typically used for a Profiler Scan.

• Type—Select None, Mean (default), Maximum, or Minimum

• Points—Select 4k, 8k (default), 16k, or 32k

Minor Grid Places a minor grid in the background of the Graph Window.

Scale Allows user to auto scale, set a curve mean, or set their own data 
range

Line Style For each curve, the operator can choose a connect, fill down, or point 
line.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard

Print Prints out the current screen view to a printer

Export Exports data in bitmap, JPEG or XZ data format

Active Curve Determines which curve you are analyzing
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6.5 Step

The Step command makes relative height measurements between two regions (steps) on sample 
surfaces. Typical applications include measuring film thickness and etch depths. Step works 
similarly to a Section command with an averaging box cursor, but its operation is simplified.

Step displays a top view of the image, then the user draws a reference line across the regions to be 
measured. A height profile is generated from averaged data on either side of the reference line in 
the box. Cursors—which are moved along the profile—define specific regions (steps). These may 
be measured (Measure button) relative to each other, with or without data leveling (Level button).
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6.5.1 Step Procedures

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Step view, shown in Figure 6.5b, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Step from the 
popup menu. See Figure 6.5a.

Figure 6.5a   Select STEP from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select STEP.

                                     Or

• Select ANALYSIS > STEP from the menu bar.

                                     Or

3. Click the Step icon in the NanoScope toolbar.

4. The Step View appears showing results for the entire image.
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6.5.2 Step Interface

The Step interface, shown in Figure 6.5b and Figure 6.5c, includes a captured image and a graph of 
averaged height within a selected box. Two pairs of cursors (one black and one red) can be moved 
across this profile to define the steps to be measured. The region between each cursor defines a 
“step.” The marker position is shown below the height graph.
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Figure 6.5b   Step Interface—single monitor
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Figure 6.5c   Step Interface—dual monitor
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Step Display Menu Commands

Level

Reorients the profile so that the average height of each step region (between cursor pairs) is equal.

Figure 6.5d   Level Option Profile

Measure

Displays the relative height between steps.

Restore

Returns the profile to its original, unleveled form. (Deselects the Level option.)

Original Profile

Level Option Applied
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Results

Vertical Distance

Displays the difference between the average height of each region (between cursor pairs). If the 
height of the region between the second pair of cursors is lower than the first’s, this will be a 
negative value.

Using the Grid Display

Measurement cursors for the graph are automatically positioned based on the numerical values 
selected in the Input fields. Right-clicking on the grid will bring up the Grid Parameters menu 
(see Figure 6.5e) and allow you to make the following changes:

Color Allows operator to change the color of the:

• Curve (data)

• Text

• Background

• Grid

• Minor Grid

• Markers

See Figure 6.5e.

Filter Typically used for a Profiler Scan.

• Type—Select None, Mean (default), Maximum, or Minimum

• Points—Select 4k, 8k (default), 16k, or 32k

Minor Grid Places a minor grid in the background of the Vision window.

Scale Allows user to auto scale, set a curve mean, or set their own data 
range

Line Style For each curve, the operator can choose a connect, fill down, or point 
line.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard

Print Prints out the current screen view to a printer

Export Exports data in bitmap, JPEG or XZ data format

Active Curve Determines which curve you are analyzing
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Figure 6.5e   Grid Parameters Menu

6.6 Tip Qualification

Tip Qualification refers to estimating tip shape from appropriate characterizer samples and rating 
tips as good, worn, bad, suspect or no tip. A characterizer refers to a sample whose surface is well-
suited to deducing tip condition when imaged using an SPM probe.

6.6.1 Overview

The Tip Qualification function incorporates the two separate capabilities of tip estimation and tip 
qualification. Tip Estimation generates a model of the tip based on an image of a characterizer and 
displays the model in the top-middle of the Tip Qualification window (see Figure 6.6f). Tip 
Qualification uses the estimate to determine whether the tip is acceptable for use.

• Check tips periodically for signs of wear. Exchange unacceptably worn tips.

• By using tip estimation and qualification to enforce tip acceptance criteria, metrological 
values can be compared from image to image, ensuring consistent, long-term 
comparability of samples.

Tip Estimation identifies a series of local peaks in the topographic image data and then successively 
analyzes each peak, refining a 3-dimensional tip model as it does so. At each peak, the slope away 
from the peak in all directions is measured, determining the minimum tip sharpness, as no data in 
the image can have a slope steeper than the slope of the tip. As this process is repeated for each 
local peak, any steeper slope than was found from all previously analyzed peaks causes the tip 
model to update to a new, sharper tip estimate.
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6.6.2 Probe/Sample Interactions and Tip Qualification

It is not useful to qualify a probe tip that is poorly matched to the sample to be imaged. Specifically, 
a tip cannot resolve the linear and angular aspects of any sample feature sharper than the tip itself. 
(However, even a blunt tip can resolve height accurately on a surface with shallow slopes.) Select a 
probe with a tip sharp enough to resolve the features of interest.

Tip Artifacts and Probe Selection

Atomic Force Microscope (AFM) images depend on the shape of the tip used to probe the sample. 
Tip artifacts refer to either the occurrence of features or the absence of features in an image that are 
not in the sample, but due to the tip used as compared (hypothetically) with an ideal tip of near-zero 
tip radius. In the simplest case, the finite size of the AFM tip does not allow it to probe narrow, deep 
fissures in a sample where the tip radius is greater than the radius of the recess (see Figure 6.6a).

Figure 6.6a   A Tip Artifact: Failure to Image Trench Bottom Due to Excessive Tip Radius
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Also, sharp sample features scanned with a dull tip are broadened in AFM images. Consequently, 
image measurements such as surface roughness and surface area depend on probe tip shape. An 
image generated with a sharp tip shows greater roughness and larger surface area than an image 
produced with a dull tip (see Figure 6.6b).

Figure 6.6b   A Tip Artifact: Broadened Peaks Due to Excessive Tip Radius

Scanning Resulting Image

Sharp tip Accurate

Dull tip Distorted
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The Estimated Tip Model is Characterizer-Dependent

The model generated by TIP ESTIMATION is not, in general, the actual shape of the tip. Because the 
tip model is constructed by analyzing the shapes of peaks in the image data, the accuracy of the 
model is limited by the sharpness of features on the characterizer. Only a surface with infinitely 
sharp features can produce an accurate model of the tip. Conversely, a surface having only large 
rounded features imparts its shape to the tip through Tip Estimation. Here are a few examples:

Figure 6.6c   A Perfect Spike on the Characterizer Surface Yields a Perfect Tip Estimate

Figure 6.6d   A Sample with No Sharp Features Yields a Dull Tip Estimate

Figure 6.6e   Similar Characterizer Feature and Tip Size Yields a Combined Geometry Tip Estimate

Due to tip/sample interdependence, it is important to consider the effects of the characterizer 
features on the calculated tip model. Characterizer samples that provide the most accurate estimate 
of tip size and shape are those with many fine protrusions. Very flat characterizer samples provide 
the least useful estimate of tip shape.

Despite the dependence on characterizer characteristics, Tip Estimation and Tip Qualification can 
often provide a reliable method of tracking tip wear and ensuring that probes are changed when 
they become dull. For example, when making repeated measurements on suitable rough samples, 
Tip Estimation can provide very reproducible estimates of tip size and shape, which change in a 
predictable and consistent fashion as the tip wears.

To avoid tip artifacts, replace worn tips with sharper ones.

Dull tip on a sharp characterizer spike Resulting tip estimate

Sharp tip on dull, rounded characterizer features Resulting tip estimate

Normal tip on normal features Resulting tip estimate

Actual tip shape
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Based on thresholds set by the user, Tip Qualification software usually finds the tip status to be 
GOOD, WORN, or BAD. A tip status of GOOD indicates that the tip is still sufficiently sharp and that the 
image data should be acceptable. A tip status of WORN indicates that the tip is becoming dull and 
should be changed, but previous image data taken with this tip should still be acceptable. If a BAD 
status is returned, the tip should be changed and the current image data discarded. In cases where 
imaging errors are suspected, Tip Qualification may assign a status of SUSPECT or NO TIP.

Characterizer Sample Selection

For the reasons cited in the last section, just as probe selection influences imaging results, 
characterizer sample selection influences probe tip characterization. An ideal characterizer sample 
for tip diagnosis has isolated extremely sharp peaks. Bruker provides a characterizer sample that is 
recommended for tip evaluation. The polycrystalline titanium roughness sample (part number RS, 
available at http://www.brukerafmprobes.com) has jagged features suitable for obtaining an 
accurate tip model.
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6.6.3 Operating Principles of Tip Qualification

The result of running Tip Qualification is a display as exemplified in Figure 6.6f.

Figure 6.6f    A Typical Tip Qualification Window 

The top-left frame is the image analyzed to evaluate the tip. The top-middle frame, labeled Tip, is a 
top view image of the software model of the tip (looking into its apex). 
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Once a tip model has been generated, Tip Estimation extracts an estimate of the tip geometry in 
cross-sections at two different distances from the tip apex (see Figure 6.6g).

Figure 6.6g   Estimated Tip Diameters at Two Heights from the Apex

The cross-section diagrams on the right in Figure 6.6f show the apparent size and shape of the tip at 
two different distances from its apex (labeled “Level 1 ETD” and “Level 2 ETD.” In the level 1 
cross-section, the roughly circular tip diameter is shown in light gray. In the lower-right frame of 
Figure 6.6f, the level 1 cross-section is shown again in light gray and the level 2 cross-section is 
shown darker. (The actual colors of the tip cross-sections depend on the color table selected.)

Tip Estimation then provides, at each cross section, two numerical measures of tip size and shape: 
effective tip diameter (ETD) and aspect ratio (AR). The effective tip diameter is defined as the 
diameter of a circle having the same area as the measured tip cross-section (see Figure 6.6h). The 
ETDs for both levels are shown in the frames on the right side of Figure 6.6f as blue circles.

Figure 6.6h   An ETD Has the Same Area as the Cross Section It Represents

Height 1

Height 2
  Cross
Section 1

  Cross
Section 2

Tip

ETD-1

ETD-2

ETD
Equal Area

Tip Cross Section
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Aspect Ratio is defined as the ratio of the maximum vertical (Y) dimension to the maximum 
horizontal (X) dimension of a tip cross section (see Figure 6.6i).

Figure 6.6i   Cross Section Aspect Ratio is Coordinate System Orientation-Dependent

Control of Tip Qualification Status

Tip Qualification generates a tip status based on the calculated values of ETD, AR and on threshold 
and limit values selected. There are two ETD thresholds that affect tip status:

• Good/Worn ETD Threshold—If the ETD is smaller than this number, the tip will 
usually be characterized as GOOD. The threshold diameters are shown as green circles 
in the ETD windows.

• Worn/Bad ETD Threshold—If the ETD is smaller than this threshold, but bigger than 
the Good/Worn ETD Threshold, it is characterized as WORN. If the ETD is larger 
than this number, it is characterized as BAD. These threshold diameters are shown as 
red circles in the ETD windows.

There are separate sets of ETD thresholds for the two tip levels (ETD 1 at HEIGHT 1, and ETD 2 at 
HEIGHT 2). There are also minimum and maximum limits for tip AR at each level. These limits 
detect when the image data produces a tip model of an oblong shape that is unlikely to accurately 
represent the tip. Usually an oblong tip model is induced by an imaging artifact, such as a noise 
streak not removed by discontinuity rejection. The AR limits should not be adjusted.

It takes some experimentation with a particular tip and characterizer sample type to find appropriate 
values for the various thresholds. The basic idea is to find the maximum ETDs (the diameters of the 
dullest tips) that provide reliable image data for your samples, then set the Worn/Bad ETD 
Thresholds based on these diameters. Then set the Good/Worn ETD Thresholds slightly smaller 
than the Worn/Bad ETD Thresholds.

An additional limit, Min ETD Size, is used to reject Tip Qualification results if the estimated tip is 
unreasonably small (indicating a tip that is sharper than physically likely). This is usually induced 
by imaging artifacts, such as noise spikes not removed by spike rejection. In most cases, Min ETD 
Size can be set at or near the same value as the height from the tip apex for both cross sections. So, 
if Height 1 = 10NM, a reasonable value for the Min ETD Size is also 10NM.

Note: A tip estimate rejected in this way returns Tip Status of SUSPECT.

Tip Cross Section

X
max

Ymax

AR = 
Ymax
X

max
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Since the tip estimate is valid only where the tip contacts the characterizer sample, cross section 
heights should be selected to ensure that the tip makes “frequent” contact with the characterizer 
sample at those heights. Thus, the cross section heights should be below the sample peak-to-valley 
values. If the cross section heights are too high for the characterizer sample, the resultant ETD will 
tend to be very large and multiple apparent peaks will be found at that height.

6.6.4 Tip Qualification Procedures

1. Scan (contact mode) the characterizer sample. Set the scan size to approximately 2.5m. 
Characterizer image size is important because, along with Tip Image Size (see Tip 
Estimation Panel Parameters on page 297) and feature density, it determines how many 
peaks are used for the tip estimation (see Tip Qualification Buttons on page 296). To 
accurately estimate the tip shape, there must be many peaks (greater than 10 is good).

2. Select an image file of the characterizer sample from the file browsing window at the right of 
the main window. Double click the thumbnail image to select and open the image.

3. You can open the Tip Qualification view, shown in Figure 6.6k, using one of the following 
methods:

• Right-click on the image name in the Workspace and select Add View > Tip 
Qualification from the popup menu. See Figure 6.6j.

Figure 6.6j   Select TIP QUALIFICATION from the workspace
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                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select TIP 
QUALIFICATION.

                                     Or

• Select ANALYSIS > TIP QUALIFICATION from the menu bar.

                                     Or

4. Click the Tip Qualification icon in the NanoScope toolbar.
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5. The Tip Qualification View appears.

6.6.5 Tip Qualification Interface

The initial Tip Qualification interface is shown in Figure 6.6k.

Figure 6.6k   The Tip Qualification Window before Calculations

Tip Qualification Buttons

ESTIMATE TIP—Performs a new tip assessment. A bottom-to-top, plan view rendering of the tip, 
labeled Tip, is shown in the middle-top image. The original image appears in the upper-left corner 
of the screen, with green markers (+) indicating the data peaks used for the estimation. If the SAVE 
TIP button is selected, the estimated tip image is saved to a file. This image can be loaded and 
analyzed in the same ways as other NanoScope images.
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QUALIFY TIP—Results in:

1. If any “Tip Estimation” parameter or the analysis region has been changed, a new tip 
estimation is performed.

2.  The tip cross sections and qualification results appear in the Results panel.

3.  Tip status is determined based on the estimated tip shape.

SAVE TIP—Stores the estimated tip image as a NanoScope image file, allowing it to be analyzed 
using the standard NanoScope MODIFY and ANALYZE functions. A tip image is approximately the 
size specified by the Tip Image Size parameter and thus has fewer data points than a standard 
image.

Tip Estimation Panel Parameters

Tip Image Size—Sets the size of the image displayed in the upper-left corner of the Tip 
Qualification window. Calculated tip diameters are not expected to exceed Tip Image Size. For 
example, Tip Image Size = 120 NM will result in a tip image approximately 120nm square. A 
reported ETD is the smallest odd integer multiple of the sample data resolution that is greater than 
or equal to the calculated tip diameter.

Tip Image Size also defines in a characterizer image the neighborhood size used to select the 
topographic maxima points used for Tip Estimation. For example, for Tip Image Size = 120 NM, 
each selected maximum pixel is the tallest point topographically within an approximately 120nm 
square centered on the point. Therefore, a larger Tip Image Size may result in fewer selected 
maxima. More points provide more tip information, so select Tip Image Size to be as small as 
possible while also satisfying two other conditions:

1. Tip Image Size should exceed the ETD at as tall a height above the tip apex as is contacted 
imaging the characterizer sample. Determine this experimentally by varying Tip Image Size 
and observing the resultant top-middle image in the Tip Qualification window.

Note: A good starting point for Tip Image Size is the sum of the maximum 
allowable tip diameter plus the diameter of a typical feature in the 
characterizer.

2. If and when “double tip” peaks appear in the image due to tip wear, their apexes should be no 
farther apart than one-half Tip Image Size. This ensures that multiple peaks from a “double 
tip” feature are not treated as separate features from the same peak (which would produce 
erroneous results and no longer guarantee an outside tip envelope).

Note: Characterize image size and feature density also affect the number of selected 
maxima.

LPF (Low Pass Filter) for max select—Determines whether a lowpass filter is applied to the data 
before identifying selected points. The filtered data is only used for point selection, not for the 
actual tip calculation. This filter has the effect of reducing noise sensitivity. It is recommended that 
the filter be turned on (YES).
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Sigma mult[iplier] for spike rejection—Sets a threshold for rejection of isolated upwards-
oriented noise spikes. At each point (x,y) in an image, a difference (x,y) is calculated between the 
pixel value at that point and the average value of the surrounding eight pixels. The average, , and 
standard deviation, , of all positive (x,y)s in the image are then calculated. The normal 
(Gaussian) distribution with average value, , and standard deviation, , is then used to represent 
the actual distribution of positive (x,y) values. If the value of Sigma mult for spike rejection is 
M, then points (x,y) whose (x,y) value differs from  by more than M*are rejected as local 
maxima in TIP ESTIMATION. The algorithm rejects as noise any unusually large pixel values as 
compared to the neighboring pixels. Because most pixel values are close to the average value of 
their neighbors, the (x,y) distribution is skewed toward zero.

If Sigma mult for spike rejection = 0, noise spike rejection is not performed. If the parameter 
value is > 0, noise spike rejection is performed.

Sigma mult[iplier] for Discontinuity Rejection—Similar to Sigma mult for spike rejection 
(above), this parameter sets a threshold for rejection of entire rows of data where a discontinuity is 
detected, such as when the tip “trips” over a feature. If Sigma mult for discontinuity rejection = 
0, discontinuity rejection is not performed. If the parameter is > 0, discontinuity rejection is 
performed as follows: for each row y, the average absolute value y of the differences between each 

point and its immediate neighbor on the next line is calculated. The average  and standard 
deviation  of all such average differences y is computed. Rows are rejected for a discontinuity 

where y meets the following criterion:

where M is Sigma mult for discontinuity rejection.

Points which fall within a Tip Image Size neighborhood centered on a discontinuity row are 
disqualified from contributing to Tip Estimation. Discontinuity rows are displayed as red 
horizontal lines on the image display.

Note: Tip Qualification returns SUSPECT status when discontinuities are 
detected.

Tip Qualification Panel Parameters

Tips are cross-sectionally analyzed at two separate heights above the apex to determine tip status. 
These heights correspond to Cross Section 1 and Cross Section 2 (see Figure 6.6g). Parameters 
are appended with either a “1” or a “2,” depending on which cross section they describe (e.g., 
Height 1 and Height 2, respectively).

Note: If cross-sectional analysis is desired at only one height, set Height 1 to 0.00 
NM, and set Height 2 to the desired value.

Height 1 [Height 2] (From Apex)—Distance from the tip apex at which the cross section is 
defined.

Min ETD1 [ETD2] Size—Minimum credible ETD at Cross Section 1 [2]. If the calculated ETD is 
smaller than Min ETD Size, then Tip Status = SUSPECT.

y  M+
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Good/Worn ETD1 [ETD2] Threshold—Maximum ETD1 [ETD2] assigned
Tip Status = GOOD (assuming that no other conditions such as an unacceptable aspect ratio or the 
presence of discontinuities result in a SUSPECT Tip Status).

Worn/Bad ETD1 [ETD2] Threshold—Maximum ETD1 [ETD2] assigned
Tip Status = WORN. If ETD1 [ETD2] is greater than Worn/Bad ETD1 [ETD2] Threshold then 
Tip Status = BAD.

Min y/x Aspect Ratio 1 [Ratio 2]—Maximum AR1 [AR2] assigned Tip Status = SUSPECT if 
ETD1 [ETD2] is less than Worn/Bad ETD1 [ETD2] Threshold.

Max y/x Aspect Ratio 1 [Ratio 2]—Minimum AR1 [AR2] signed Tip Status = SUSPECT if 
ETD1 [ETD2] is less than Worn/Bad ETD1 [ETD2] Threshold.

Tip Status is evaluated in the following order:

1. SUSPECT—Tips will be qualified as SUSPECT under any of the following conditions:

• A discontinuity exceeding the Sigma mult for discontinuity rejection has been found 
in the data.

• One of the aspect ratios of the tip is outside the range (Min y/x Aspect Ratio, Max y/x 
Aspect Ratio).

• ETD1 or ETD2 is smaller than its Min ETD1 [ETD2] Size.

2. GOOD—Both ETDs are less than the Good/Worn ETD Threshold parameter setting.

3. BAD—At least one of the ETDs is greater than its Worn/Bad ETD Threshold or one of the 
cross-sections intersects a large portion of the tip image boundary.

4. WORN—At least one of the ETDs falls between its Good/Worn ETD Threshold and Worn/
Bad ETD Threshold.
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6.6.6 Running Tip Qualification

The essential procedure for performing tip qualification is as follows:

1. Load an image file (preferably of a characterizer sample).

2. Click the Tip Qualification icon in the NanoScope toolbar to open the Tip Qualification 
window.

3. Enter the Tip Image Size desired for the currently loaded tip and characterization image.

4. Select whether to apply a low pass filter to the image by selecting either YES or NO for 
parameter LPF for max select.

Note: It is generally a good idea to use a low pass filter to ensure that small noise 
artifacts are removed before Tip Estimation. Noise mistaken for an imaged 
feature renders a misleading tip model. Additionally, large noise artifacts can 
be selectively removed by adjusting Sigma mult for spike rejection and 
Sigma mult for discontinuity rejection.

5. Enter values for all parameters in the Cross Section panels.

6. Click ESTIMATE TIP.

7. Click QUALIFY TIP.

8. View the Tip Status in the Results panel, shown in Figure 6.6l.
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Figure 6.6l   Tip Qualification Results

9. If the end radius of the tip is required, click SAVE TIP and then open the saved file. Click the 
SECTION icon to open the file and draw a cursor through the tip center, shown in Figure 
6.6m. The radius of a circle fitted to the data between the cursors is displayed in the bottom 
of the Section window. See Section:  Section 6.4 for more information.
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Figure 6.6m   Section of the saved tip - Single monitor view

Tip Radius
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6.7 Width 

To analyze the width of features you have numerous choices which measure the height difference 
between two dominant features that occur at distinct heights. Width was primarily designed for 
automatically comparing feature widths at two similar sample sites (e.g., when analyzing etch 
depths on large numbers of identical silicon wafers).

The Width command is designed to automatically measure width between features distinguished 
by height, such as trenches and raised features.

The Width command is best applied when comparing similar features on similar sites. Width 
measurement on dissimilar sites is better performed using the Section command.

Refer to the following sections on Width analysis:

• Width Theory: Section 6.7.1

• Width Procedures: Section 6.7.2

• Width Interface: Section 6.7.3

6.7.1 Width Theory

The Width algorithm utilizes many of the same functions found in Depth analysis by accumulating 
height data within a specified area, applying a Gaussian low-pass filter to the data (to remove 
noise), then rapidly obtaining height comparisons between two dominant features. For example, 1) 
the depth of a single feature and its surroundings; or, 2) depth differences between two or more 
dominant features. Although this method of width measurement does not substitute for direct, 
cross-sectioning of the sample, it does afford a means for comparing feature widths between two or 
more similar sites in a consistent, statistical manner.

The Width window includes a top view image and a histogram; depth data is displayed in the 
results window and in the histogram. The mouse is used to resize and position the box cursor over 
the area to be analyzed. The histogram displays both the raw and an overlaid, Gaussian-filtered 
version of the data, distributed proportionally to its occurrence within the defined bounding box.

Histogram

Raw Data

Histograms for depth data are presented on the bottom of the Width window. The histogram peaks 
correspond to the distribution of depths of analyzed regions of the image (see Figure 6.7a).
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Figure 6.7a    Depth Histogram Analysis

Note: Color of cursor, data, and grid may change if user has changed the settings. 
Right-click on the graph and go to Color if you want to change the default 
settings. 

Correlation Curve

The Correlation Curve is a filtered version of the Raw Data Histogram and is represented by a 
red line on the Depth Histogram. Filtering is done using the Histogram filter cutoff parameter in 
the Inputs parameter box.The larger the filter cutoff, the more data is filtered into a Gaussian (bell-
shaped) curve. Large filter cutoffs average so much of the data curve that peaks corresponding to 
specific features are unrecognizable. On the other hand, if the filter cutoff is too small, the filtered 
curve may appear noisy.

The Correlation Curve portion of the histogram presents a lowpass, Gaussian-filtered version of 
the raw data. The low-pass Gaussian filter removes noise from the data curve and averages the 
curve’s profile. Peaks which are visible in the curve correspond to features in the image at differing 
widths.

Peaks do not show on the correlation curve as discrete, isolated spikes; instead, peaks are 
contiguous with lower and higher regions of the sample, and with other peaks. This reflects the 
reality that features do not all start and end at discrete depths. 

When using the Width View for analysis, each peak on the filtered histogram is measured from its 
statistical centroid (i.e., its statistical center of mass). 

6.7.2 Width Procedures

Brief instructions can be found in the Width Analysis Guidelines window below the Inputs 
window.

Note: The maximum recommended input file size is 512 lines by 512 samples/line.
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1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Width view, shown in Figure 6.7c, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Width from 
the popup menu. See Figure 6.7b.

Figure 6.7b   Select WIDTH from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select WIDTH.

                                     Or

• Select ANALYSIS > WIDTH from the menu bar.

                                     Or

3. Click the Width icon in the NanoScope toolbar.

4. The Width View appears showing results for the entire image.
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6.7.3 Width Interface

The Width interface includes a captured image, Input parameters and Grid Markers display, 
Results table, Guidelines and a Depth Histogram with grid markers, shown in Figure 6.7d.

1. Using the mouse, left-click and drag a box on the area of the image to analyze. 
The Histogram displays the depth correlation on this specified area.

Note: If no box is drawn, by default, the entire image is selected.

2. Adjust the Minimum Peak to Peak to exclude non relevant depths.

3. Adjust the Histogram Filter Cutoff parameter to filter noise in the histogram as desired.

4. Adjust the threshold cursor along the histogram to set the level of the cutoff plane. The 
features above or below (depending on Feature Direction) this plane are a single shade in 
the selected area.

5. Right-click on the image in a region outside the box and click Select Feature.

6. Click on various regions inside of the box. Statistics in the table will be generated for each 
distinct (as defined by the Input parameters) feature.

Note: “Distinct” features are displayed in blue.

Note: To save or print the data, either copy, by right-clicking on the results table, and 
paste the text and export the Graphic or XZ Data or run the analysis in an Auto 
Program (see Chapter 8).
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Figure 6.7c   Width Interface

Threshold 
Marker
Rev. D NanoScope Software 8.10 User Guide 307



Analysis Commands
Width

30
Figure 6.7d   Depth Histogram

Width Input Parameters

The depth input parameters below define the slider cursor placement for determining the exact 
depth of a feature.

Feature Direction Select above or below to indicate if features above or below the reference 
plane are to be analyzed.

Threshold Plane The z height which is used as a minimum for the higher peak. This can be 
adjusted by moving the cyan Threshold Depth cursor in the depth histo-
gram.

Number of Histogram Bins The number of data points, ranging from 4 to 512, which result from the fil-
tering calculation.

Reference You may specify a reference point for the cursor. This feature is useful for 
repeated, identical measurements on similar samples. After moving the cur-
sor to a specific point on the correlation histogram, that point is saved as a 
distance from whatever reference peak you choose. These reference peaks 
include: HIGHEST PEAK, LOWEST PEAK.

Histogram Filter Cutoff Lowpass filter which smooths out the data by removing wavelength com-
ponents below the cutoff. Use to reduce noise in the Correlation histogram.

Minimum Peak To Peak Sets the minimum distance between the maximum peak and the second 
peak marked by a cursor. The second peak is the next largest peak to meet 
this distance criteria.

Distance From Peak % DISTANCE, ABSOLUTE DISTANCE

Distance From Peak Cursor distance from the REFERENCE peak
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Grid Markers

Three user-adjustable markers are placed on the depth histogram:

Results Parameters:

Using the Grid Display

Measurement cursors for the histogram are automatically positioned based on the numerical values 
selected in the Input fields. Right-clicking on the grid will bring up the Grid Parameters menu 
(see Figure 6.7e) and allow you to make the following changes:

Threshold Depth Cyan. Distance from peak and distance from peak type.

Lowest Peak Magenta. The right (larger in depth value) of the two peaks marked by the 
cursors.

Highest Peak Gold. The left (smaller in depth value) of the two peaks chosen by the cur-
sors. You can adjust min and max peaks by adjusting the MINIMUM 
PEAK TO PEAK.

X location X location

Y location Y location

X mean The average of the highlighted X values within the enclosed area.

X sigma The standard deviation of the measured X values.

Y mean The average of the highlighted Y values within the enclosed area.

Y sigma The standard deviation of the measured Y values.

Area The area below the threshold in the selected region.

Threshold to Local Minimum The distance from the Threshold Plane to a local minimum.

Threshold to Local Maximum The distance from the Threshold Plane to a local maximum.

Color Allows operator to change the color of the:

• Curve (data)

• Text

• Background

• Grid

• Minor Grid

• Markers
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Figure 6.7e   Grid Parameters Menu

Filter Typically used for a Profiler Scan.

• Type—Select None, Mean (default), Maximum, or Minimum

• Points—Select 4k, 8k (default), 16k, or 32k

Minor Grid Places a minor grid in the background of the Vision window.

Scale Allows user to auto scale, set a curve mean, or set their own data 
range

Line Style For each curve, the operator can choose a connect, fill down, or point 
line.

User Preferences Restore—Reverts to initial software settings

Save—Saves all changes operator has made during this session. This 
becomes the new default settings.

Copy Clipboard Copies the grid image to the Microsoft Clipboard

Print Prints out the current screen view to a printer

Export Exports data in bitmap, JPEG or XZ data format

Active Curve Determines which curve you are analyzing
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6.8 XY Drift

Due to temperature differences, thermal lateral drift can occur between two successive images 
while scanning. Using Offline XY Drift analysis, NanoScope software can calculate the lateral 
shift between two images. You can also manually enter the drift.

6.8.1 Offline XY Drift Analysis

Requirements

Two images captured within 1 day of each other are required. The capture and trace directions must 
be the same for both images (up/down, trace/retrace), and the images must have the same 
microscope configuration and scanner calibration properties.

Procedure

To calculate XY Drift using NanoScope software:

1. Start with an earlier image and use one of the following methods to open the XY Drift 
Analysis view (see Figure 6.8b). Select an image file from the file browsing window at the 
right of the main window. Double click the thumbnail image to select and open the image.

• Right-click on the image name in the Workspace and select Add View > XY Drift 
from the popup menu. See Figure 6.8a.

Figure 6.8a   Select XY DRIFT from the workspace
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                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select XY DRIFT.

                                     Or

• Select ANALYSIS > XY DRIFT from the menu bar.

                                     Or

2. Click the XY Drift icon in the NanoScope toolbar.

3. The XY Drift View, shown in Figure 6.8b and Figure 6.8c, appears showing one image.

XY drift corrections calculated from other than the two most recently captured images may not 
reflect current environmental conditions.

Figure 6.8b   XY Drift Interface—single monitor
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Figure 6.8c   XY Drift Interface—dual monitor

4. Use the Load Image button to browse for the subsequent image.

5. Click the Calculate Shift button. The software will calculate the shift of the second image 
relative to the first image.

6. The results display in the Results panel. 

a. To apply the corrections in the Inputs box, click the Apply Correction button.

                                                             Or

b. You can also manually enter the correction values in the Inputs box. Click the Apply 
Correction button.
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Input Parameters

Statistics used by the XY Drift analysis are defined in this section. 

Results Parameters

Results of the XY Drift analysis are presented in this section.

XY Drift Buttons

Number of scan lines Specifies the number of lines to calculate.

Flatten Flattens both images before the shift is calculated. (Use the Undo Flatten 
button to reverse the flatten).

X Correction Specifies the amount of correction to apply to the X-axis of the scanner.

Y Correction Specifies the amount of correction to apply to the Y-axis of the scanner.

Second Image Defines the location of the second image used in the analysis.

Image resize factor Speeds up the shift calculation by averaging for images larger than 512 
pixels

X Shift Specifies the amount of calculated shift along the X-axis of the second 
image relative to the first.

Y Shift Specifies the amount of calculated shift along the Y-axis of the second 
image relative to the first.

Tested Correlation
Coefficient

Reports the correlation coefficient after correcting for the detected shift. A 
perfect correlation is 1.0. If the tested correlation coefficient is too low, 
then the calculation is not valid and should not be applied. You may need 
features that have more distinct contrast.

Raw Correlation
Coefficient

Reports the correlation coefficient between the two images prior to pro-
cessing.

Load Image Browse to open the second image in the right box.

Calculate Shift Compares left image to right image, and reports the shift statistics in the 
Results box.

Apply Correction Applies the correction in the Inputs box to the second image.

Undo Flatten Undo Flatten restores the image to its original form.
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Chapter 7   Modify Commands
Modify commands are used to eliminate noise and correct for bow and tilt. These operations 
process the captured/stored image, then produce another (modified) version of the image

Refer to the following analysis commands available in the NanoScope software:

• Image Filtering using Data Matrix (Kernel) Operations: Section 7.1

• Clean Image: Section 7.2

• Crop and Split: Section 7.3

• Erase: Section 7.4

• Flatten: Section 7.5

• Gaussian: Section 7.6

• Lowpass: Section 7.7

• Median: Section 7.8

• Plane Fit: Section 7.9

• Spectrum 2D: Section 7.10

• Subtract Image: Section 7.11
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7.1 Image Filtering using Data Matrix (Kernel) Operations

A number of Modify image filters use matrix operations to achieve their effects. The matrix 
operations include:

• Clean Image

• Gaussian

• Lowpass

• Median

In each of these commands, data is analyzed in kernels (matrices), with every pixel individually 
recalculated based upon its neighboring values. For example, data which is undergoing a Median 
filter applies a 3 x 3 or 5 x 5 matrix operation to each image pixel. (Most filters utilize 3 x 3 
matrices.)

Figure 7.1a    Median Filter Example

In the example in Figure 7.1a, each pixel is individually evaluated within its own local, 5 x 5 
“neighborhood.” Neighborhood A has pixel a2a3 at its center. For a Median filter, the 25 pixels in 

neighborhood A are evaluated to locate the median value pixel. The median value of neighborhood 
A is then mapped to a new pixel a2a3 in a separate data set. 

The matrix is shifted over one column to define a new neighborhood (“B”) with pixel a2a4 at its 

center. The median value for neighborhood “B” is found, then mapped to pixel a2a4 in the separate 

data set. The filtering process is repeated until all pixels have been remapped.

Note: In this and all other matrix operations, pixels are mapped to the new, separate 
data set without changing pixel values in the original image data until saved. 
(Matrices do not operate cumulatively on previously filtered data.) Filters 
include averaging (e.g., Lowpass filter) and non-averaging (e.g., Highpass) 
types.

Pixel a2a3 (height datum) Pixel a2a4

Neighborhood A Neighborhood B

Image data

Shift neighborhood
one column right
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Most filters utilize 3 x 3 pixel matrixes (see Figure 7.1b), which tend to confine averaging effects to 
smaller areas. They process image data in a manner similar to the 5 x 5 matrix example in Figure 
7.1a.

Figure 7.1b   3 x 3 Pixel Matrix

Gaussian filters utilize a 1 x N matrix, where N is determined by the Filter size parameter. In this 
instance, image data is analyzed in two-dimensional matrices which are shaped to a Gaussian curve 
where the sigma value () is determined by the Filter size parameter. (see Gaussian: Section 7.6.)

Figure 7.1c   Gaussian Filter Example

Pixel a2a2
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7.2 Clean Image

The Clean Image command is used to smooth noisy image data within the cursor box you specify. 
The Spike cut off and Streak cut off commands define sigma cutoffs for spikes and streaks, 
respectively. Data points lying beyond the mean ± designated sigma values () are replaced with 
the mean data value.

Figure 7.2a   Clean Image Diagram

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Clean Image view, shown in Figure 7.2c, using one of the following 
methods:

• Right-click on the image name in the Workspace and select Add View > Clean Image 
from the popup menu. See Figure 7.2b.

Figure 7.2b   Select CLEAN IMAGE from the workspace






Affected dataAffected data







User-specified
cut off values
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                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select CLEAN IMAGE.

                                     Or

• Select MODIFY > CLEAN IMAGE from the menu bar.

                                     Or

• Click the Clean Image icon in the toolbar.

3. A separate window opens, also displaying the image. Right-click in the image to display the 
Clean Image options menu (see Figure 7.2c and Figure 7.2e).

Figure 7.2c   Clean Image Window
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4. Click and drag in the image to define a box.

5. Configure the Input parameters.

6. Click EXECUTE to perform the operation.

7. To restore the unprocessed image, click the RELOAD button.

Figure 7.2d shows the image of Figure 7.2c after a clean operation with Spike and Streak cutoff 
both set to 1 and Figure 7.2e shows the image of Figure 7.2c after a clean operation with Spike 
and Streak cutoff both set to 0.5.

Figure 7.2d   Image of Figure 7.2c after a 1 clean operation
0 NanoScope Software 8.10 User Guide Rev. D



Modify Commands
Clean Image
Figure 7.2e   Dual monitor image of Figure 7.2c after a 0.5 clean operation

Clean Image Input Parameters

Remove Spikes Settings:

• ON—Enables the Spike cut off value and applies it to 
data within the cursor box you specify.

• Off—Disables the Spike cut off value.

Remove Streaks Settings:

• ON—Enables the Streak cut off value and applies it to 
data within the cursor box you specify.

• Off—Disables the Streak cut off value.

Spike Cutoff Number of sigma values to use as the cut off point for spike data. Data 
points lying outside the mean ± Spike cut off sigma value(s) are 
replaced by the mean data value.

Range:

• 0 to 10

Streak Cutoff Number of sigma values to use as the cut off point for streak data. 
Data points lying outside the mean ± Streak cut off sigma value(s) are 
replaced by the mean data value.

Range:

• 0 to 10

Output File Name Select the path of the extracted image file. Leave blank for immediate 
view/use without saving the altered image file

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.
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Buttons on the Clean Image Panel 

Execute Initiates the Clean Image command.

Reload Restores the image to its original form by reloading the original file.
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7.3 Crop and Split

The Crop and Split function replaces and expands the Zoom function used in version 7.0 and 
earlier releases of NanoScope software. Use the Crop and Split function to extract an image from 
a large Version 7 image for Version 5 analysis or to inspect only part of an image. NanoScope 
Version 5 software features a number of Offline functions currently not available in Versions 7 and 
8 NanoScope software. Crop and Split will produce the largest Version 5 image size possible 
within the bounded region (128 x 128, 256 x 256 or 512 x 512). 

Note: The image produced by this analysis is Version 5 compatible, however, if the 
image is later processed by a Version 7 analysis, the image may no longer be 
Version 5 compatible.

7.3.1 Crop and Split Procedure

Use the Crop and Split function to isolate a portion of a high resolution image.

1. Open a large Version 7 or 8 image (larger than 512 x 512).

2. You can open the Crop and Split view, shown in Figure 7.3b, using one of the following 
methods:

• Right-click on the image name in the Workspace and select Add View > Crop and 
Split from the popup menu. See Figure 7.3a.

Figure 7.3a   Select CROP AND SPLIT from the workspace

                                     Or
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• Right-click on a thumbnail in the Multiple Channel window and select CROP AND 
SPLIT.

                                     Or

• Select MODIFY > CROP AND SPLIT from the menu bar.

                                     Or

3. Click the Crop and Split icon in the toolbar.

4. The selected image opens in the Crop and Split dialog box (see Figure 7.3b and Figure 
7.3c).
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Figure 7.3b   The Crop and Split window—single monitor

Bounding Box
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Figure 7.3c   The Crop and Split window—dual monitor

5. Create a bounding box by dragging the mouse in the image (see Figure 7.3b or Figure 7.3c). 
Place the cursor inside the box, and while holding the mouse button, move the box to the 
location of interest. If CROP V5 COMPATIBLE is selected, the box is restricted to the largest 
possible Version 5-compatible image size (usually 512 x 512).

6. Select the OUTPUT FILE NAME by clicking on the file name and then clicking the box to the 
right of the file name. Select a location and name for the new image.

7. Click the CREATE FILE(S) button.

8. Use this new image for further (Version 5 or other) analysis.
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7.3.2 Crop and Split Interface

Input Parameters

Crop V5 Compatible Settings:

• YES—A V5 compatible file (128 x 128, 256 x 256 or 512 x 
512) is created from the image.

• No—Crops to arbitrary sizes.

Method Available with CROP V5 COMPATIBLE set to YES.

Settings:

• INTERPOLATE—Data points will be interpolated to create 
new image.

• Replicate—Data points will be used as is to create a new 
image.

V5 Number of Samples Available with CROP V5 COMPATIBLE set to YES.

Settings:

• 128, 256, 512.

Save Channels Separately Settings:

• Yes— Individual files, named OriginalFileName_crop and 
splitN.f07, where N is the channel number (1 through 8), are 
created.

• No—One file with all selected channels will be created.

Save Subset File Settings:

• Yes—One file with all selected channels will be created.

• Yes— Individual files, named OriginalFileName_crop and 
splitN.f07, where N is the channel number (1 through 8), are 
created.

Note: You must select Yes for either the Save 
Channels Separately or the Save Subset File 
commands.

Output File Name Select the path of the extracted image file.

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.

Include Channels Settings:

• Yes— This channel is included in the output file(s).

• No—This channel is not included in the output file(s).
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Results Parameters

Crop and Split Buttons

Number of X Points Number of x points in the new image.

Number of Y Lines Number of y lines in the new image.

Aspect Ratio Aspect ratio of the new image.

Scan Size Scan size of the new image. The units of this parameter are volts if the 
Units parameter (Other Controls panel) is set to Volts. The units are 
linear distance (nm or µm) if the Units parameter is set to Metric.

Error Possible errors:

• No Error—(Default)

• Not Enough X Points—Original image has less than 512 
points/line.

• Invalid Aspect Ratio—Zoomed image results in an aspect 
ratio greater than 256:1.

• File Write—A disk error occurred.

• Unknown—An unknown error has occurred.

Create File(s) An image is created from the portion of the high resolution image that 
is contained in the bounding box.
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7.4 Erase

The Erase modify command is a retouching function for editing images. This function allows 
horizontal lines or areas to be replaced with an interpolation from the adjacent lines.

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Erase view, shown in Figure 7.4b, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Erase from 
the popup menu. See Figure 7.4a.

Figure 7.4a   Select ERASE from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select ERASE.

                                     Or

• Select MODIFY > ERASE from the menu bar.

                                     Or

3. Click the Erase icon in the toolbar.

4. A separate window opens, also displaying the image. Right-click in the image to display the 
Erase options menu (see Figure 7.4b). Select either Horizontal Line or Area and a check 
mark will appear. The option chosen will remain checked until another selection is made.
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5. Click anywhere within the image to define a horizontal line, or click and drag in the image to 
define a box to be replaced.

Figure 7.4b   Erase Options Menu

6. Click the EXECUTE button to perform the interpolation.
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Figure 7.4c   Effect of the erase interpolation on a rectangular area—single monitor

Before After
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Figure 7.4d   Effect of the erase interpolation on a rectangular area—dual monitor

7. Right-click on an Erase feature of a modified image (either line or box) for options to 
complete the operation. Click Delete to erase the dashed construction lines from the display 
of the selected feature. Click Clear All to eliminate all construction lines from the display, 
while retaining the modifications to the image.

8. To eliminate all trace of Erase activity to an image, click the Reload button while the image 
is still open in the Erase panel.

Before

After
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7.5 Flatten

The Flatten command eliminates unwanted features from scan lines (e.g., noise, bow and tilt). It 
uses all unmasked portions of scan lines to calculate individual least-square fit polynomials for 
each line. 

Flatten is useful prior to image analysis commands (e.g., Depth, Roughness, Section, etc.) where 
the image displays a tilt, bow or low frequency noise, which appear as horizontal shifts or stripes in 
the image.

Figure 7.5a   Image Flattened

Refer to the following sections on Flatten analysis:

• Flatten Theory: Section 7.5.1

• Flatten Procedures: Section 7.5.2

• Flatten View Interface: Section 7.5.3

Bow in Image

Bow Removed
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7.5.1 Flatten Theory

The Flatten command is a filter that modifies the data to delete low frequency noise and remove 
tilt from an image. Each line is fit individually to center data (0th order) and remove tilt (1st order), 
or 2nd or 3rd order bow. A best fit polynomial of the specified order is calculated from each data 
line and then subtracted out. In some cases, the stopband (box cursor to exclude features) can be 
used to remove regions of the image from the data set used for the polynomial fits. Click on the 
image to start drawing a stopband box. Right-click on a box to delete it or change its color. 

Flatten Polynomials

The polynomial equations calculate the offset and slope, and higher order bow of each line for the 
data (see Table 7.5a).

Table 7.5a   Flatten Polynomials

Order Polynomial Explanation

0 z = a Centers data along each line.

1 z = a + bx Centers data and removes tilt on each 
line [i.e., calculates and removes off-
set (a) and slope (b).

2 z = a + bx + cx2 Centers data and removes the tilt and 
bow in each scan line, by calculating 
a second order, least-squares fit for 
the selected segment then subtracting 
it from the scan line.

3 z = a + bx + cx2 + dx3 Centers data and removes the tilt and 
bow in each scan line, by calculating 
a third order, least-squares fit for the 
selected segment then subtracting it 
from the scan line.
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7.5.2 Flatten Procedures

For an image that contains a number of noisy scan lines, use the Flatten command to correct the 
problem.

1. Open the image. Note disjointed scan lines which are misaligned along the Z-axis (some are 
high and some are low). This effect somewhat resembles an unshuffled deck of cards when 
viewed on-edge or appears as horizontal streaks or bands. The image may have bow along its 
Y-axis. 

Figure 7.5b shows an image file in its original, raw form as an example for the Flatten command. 
Many of the image’s scan lines are disjointed along the Z-axis. 

Figure 7.5b   Raw Image of Syndiatatic Polystyrene (500nm)

Top View of Image to Flatten                                         Surface Plot of Image showing Bow
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2. You can open the Flatten view, shown in Figure 7.5e, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Flatten from 
the popup menu. See Figure 7.5c.

Figure 7.5c   Select FLATTEN from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select FLATTEN.

                                     Or

• Select MODIFY > FLATTEN from the menu bar.

                                     Or

3. Click the Flatten icon in the toolbar.

4. Set the Flatten Order value to 0TH. This removes the scan line misalignment.

5. Click Execute to initiate the Flatten command. The flattened image appears on the display 
screen.

Note: Figure 7.5d shows the same image file after using a zero-order Flatten 
(Flatten Order = 0TH). The scan lines are now aligned.
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Figure 7.5d   Flattened Image of Syndiatatic Polystyrene (500 nm)

6. To see a variety of effects using the Flatten command, enter different Flatten order values. 
Each new change may be undone by clicking on the Reload button.

Top View of Flattened Image Surface Plot View of Flattened Image
Rev. D NanoScope Software 8.10 User Guide 337



Modify Commands
Flatten

33
7.5.3 Flatten View Interface

Click Modify in the menu bar and select Flatten, or click on the Flatten icon in the tool bar. A 
series of parameters appear in the Flatten View, allowing the order of the flatten polynomial to be 
selected and display parameters to be adjusted to your preference.

Figure 7.5e   Flatten view—single monitor

Before After 2nd order flatten
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Figure 7.5f   Flatten view—dual monitor

Before

After 2nd

order flatten
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 Input Parameters:

Range and Settings:

Buttons on the Flatten Panel 

Flatten Order Flatten Order selects the order of the polynomial calculated and sub-
tracted from each scan line.

Settings:

• Zero Order (0th)—Removes the Z offset between scan lines 
by subtracting the average Z value for the unmasked segment 
from every point in the scan line.

• First Order (1th)—Removes the Z offset between scan lines, 
and the tilt in each scan line, by calculating a first order, least-
squares fit for the unmasked segment then subtracting it from 
the scan line.

• Second order (2nd)—Removes the Z offset between scan 
lines, and the tilt and bow in each scan line, by calculating a 
second order, least-squares fit for the unmasked segment then 
subtracting it from the scan line.

• Third order (3rd)—Removes the Z offset between scan lines, 
and the tilt and bow in each scan line, by calculating a third 
order, least-squares fit for the unmasked segment then 
subtracting it from the scan line.

Flatten Z Thresholding 
Direction

Specifies the range of data to be used for the polynomial calculation 
based on the distribution of the data in Z:

Range or Settings:

• Use Z >= —Uses the data whose Z values are greater than or 
equal to the value specified by the Z thresholding %.

• Use Z <—Uses the data whose Z values are less than the value 
specified by  the Z thresholding %.

• No thresholding—Disables all thresholding parameters.

Flatten Threshold for Applies the Thresholding values for the whole image or each line inde-
pendently.

Range or Settings:

• The whole image

• Each line

Flatten Z Threshold % Defines a Z value as a percentage of the entire Z range in the image (or 
data set) relative to the lowest data point.

Output File Name Specifies the name of the file to be created. Leave blank for immediate 
view/use without saving the altered image file.

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.

Execute Initiates the command, based on the order selected.

Reload Restores the image to its original form by reloading the original file.
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7.6 Gaussian

The single axis GAUSSIAN Filter permits analysis of images along either the X or Y axis with a 
1-by-X kernel you define specified in Gaussian terms. The FILTER SIZE value corresponds to the 
sigma () value of the Gaussian curve, encompassing approximately 68 percent of the data with the 
symmetric Gaussian curve centered over the operated-upon pixel.

Larger Filter size values distribute the curve broadly (see Figure 7.6a). During LOWPASS filtering, 
this lends greater weight to values farther away from the pixel and increases the Gaussian filter’s 
averaging effects upon the image. During HIGHPASS filtering, this subtracts a decreased average 
from each pixel, lessening the filter’s impact.

Figure 7.6a   Larger Filter Size

Smaller Filter size values concentrate curve data around the center value (see Figure 7.6b).

Figure 7.6b   Smaller Filter Size 

During Lowpass filtering, this lends less weight to pixels distant from the center, decreasing the 
Gaussian filter’s ability to average local pixels with distant ones—the filter’s impact is lessened. 
During Highpass filtering, the larger and more localized pixel average being subtracted from the 
operated-upon pixel value yields an enhanced impact upon the image.

Note: Filter size is specified in units of Distance, Spatial Frequency, Time, 
Temporal Frequency, and #pixels. 

- +

Larger Filter size

- +

Smaller Filter size
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7.6.1 Gaussian Filter Panel

The Gaussian Filter panel is shown in Figure 7.6c and Figure 7.6d.

Figure 7.6c   Gaussian filter panel—single monitor
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Figure 7.6d   Gaussian filter panel—dual monitor
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Parameters in the Gaussian Filter Panel

Buttons on the Gaussian Panel 

Filter size Size of the scan line to be operated upon by the Gaussian filter kernel. 
This value is expressed in the Cutoff Units specified below.

Range and Settings:

• Minimum = 3 pixels

• Maximum = one-half scan size

Filter Axis Settings:

• HORIZONTAL—Applies the one dimensional Gaussian filter 
along the X axis.

• Vertical—Applies the one dimensional Gaussian filter 
along the Y axis.

Cutoff Units Selected units are applied simultaneously to the Filter size. (The #pix-
els field displays the pixel equivalent of the current Filter size value.)

Range and Settings:

• DISTANCE

• SPATIAL FREQUENCY

• TIME

• TEMPORAL FREQUENCY

Filter Type Range and Settings:

• LOWPASS filtering allows longer wavelength features through 
while filtering out shorter wavelength features. The net effect 
is to remove noise in the form of spikes and fuzz on the image.

• HIGHPASS filtering allows shorter wavelength features 
through while filtering out longer wavelength features.

#pixels The current FILTER SIZE in pixel units. This value may be used to 
both enter and monitor the FILTER SIZE.

Range and Settings:

• Minimum = 3 pixels

• Maximum = one-half scan size

Output File Name Select the path of the extracted image file. Leave blank for immediate 
view/use without saving the altered image file

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.

Execute Applies the Gaussian Filter to the currently loaded image.

Reload Restores the image to its original form by reloading the original file.
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7.6.2 Gaussian Kernel Algorithm

The general equation used to generate a 1-by-(N+1) Gaussian kernel is: 

Where i is in units of pixels, and  is set by the Filter size value. Using this kernel, the filter output 
is: 

The actual impact of filtering on an image is best demonstrated by reviewing examples of images 
before and after filtering. In the following example, both Lowpass and Highpass Gaussian filter 
capabilities are demonstrated.

7.6.3 Lowpass Gaussian Filtering

During LOWPASS filtering, the Gaussian Filter has a unique ability to average features oriented 
orthogonally to the scan frame. For example, the Gaussian filter can average features running 
parallel to an image’s Y scan axis while leaving features relatively unchanged along the X axis, or 
vice versa. This is a similar capability to the Spectrum 2D (see Section 7.10) function; however, it 
is more unidirectional (i.e., strictly operating along the X or Y axis). One such example is provided 
in the three views of a diffraction grating in Figure 7.6e.

The grating image Scan size is 1.872 microns. Applying a Gaussian Filter with Filter size of 250 
nm along the Y Filter axis results in view B. Notice that rulings running parallel to the Y axis are 
smoothed along their length by the filter, while features oriented orthogonal to the Y axis remain 
relatively unchanged. This results in an idealized (averaged) profile of the X axis.

In view C, the Filter size values is unchanged; however, the Filter axis has been rotated 90° to the 
X axis. The filter’s impact upon the image here is very dramatic, destroying the ruling features in 
the image by averaging across their profile. The result is an almost flat surface.
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Figure 7.6e   Views of Diffraction Grating

B. Filter axis = Y.

C. Filter axis = X.

A. Original image.
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7.6.4 Highpass Gaussian Filtering

Applications for HIGHPASS filtering are limited to detecting smaller features. Generally, higher 
frequency (shorter wavelength) features are enhanced, while sacrificing lower frequency (longer 
wavelength) features and height data.

One example of applying a Gaussian Highpass filter is provided in Figure 7.6f. 

This 27.41-micron, MFM image reveals magnetic domains in a permalloy specimen. Although 
magnetic domains are visible on the original image, you may apply a Gaussian highpass filter to 
highlight boundaries between domains.

Figure 7.6f   Magnetic Domains in a Permalloy Specimen

Figure 7.6f shows the magnetic force microscopy (MFM) image in its original form. This is an 
early MFM image of a permalloy specimen, and contains artifacts which are significantly reduced 
in phase analyzed images. Magnetic force is represented in the image as height data. Suppose the 
microscopist wanted to highlight the magnetic boundaries without regard to magnetic force (height 
data). A Gaussian Highpass filter would be appropriate.
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7.6.5 Procedure for the Gaussian Command

1. Select an image file from the file browsing window at the right of the main window. Double 
click the thumbnail image to select and open the image.

2. You can open the Gaussian view, shown in Figure 7.6c, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Gaussian 
from the popup menu. See Figure 7.5c.

Figure 7.6g   Select GAUSSIAN from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select GAUSSIAN.

                                     Or

• Select MODIFY > GAUSSIAN from the menu bar.

                                     Or

3. Click the Gaussian icon in the toolbar.

4. A separate window opens, also displaying the image.

5. Configure the Input parameters.

6. Complete the Output File Name field to save the result.

7. Click EXECUTE to perform the Gaussian filtering operation.
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8. To restore the unprocessed image, click the RELOAD button.

Highpass Gaussian Filter Example

Example Explanation. First, the image is filtered along the X-axis by setting the Filter axis to 
HORIZONTAL. Clicking Execute activates the Gaussian filter,—the result is shown in Figure 7.6h, 
View A. Notice that features running parallel to the X-axis (e.g., the tips of each oval area) are 
washed out, while features running perpendicular to the X-axis are enhanced. Enter an OUTPUT 
FILE NAME to save the results for additional processing.

Figure 7.6h   Gaussian Highpass-Filtered Images

Next, reload the image and filter along the Y-axis by setting the Filter Axis to VERTICAL. Clicking 
Execute activates the Gaussian filter—the result is shown in Figure 7.6h, View B. Notice that 
features running parallel to the Y-axis (e.g., the sides of each oval area) are washed out, while 
features running perpendicular to the Y-axis are enhanced. Enter an OUTPUT FILE NAME to save 
the results for additional processing.

To construct a composite image of the two Gaussian-filtered images, add them together. (This can 
be accomplished by subtracting an inverted image from another image.) A composite of the two 
filtered images is shown in Figure 7.6h, View C. This shows the domain boundaries clearly; 
however, all Highpass filtered images have lost their height data, including the composite.

- =

A B C

X Filter Axis Y Filter Axis Composite Image
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7.7 Lowpass

The Lowpass modify command applies spatial filtering to a captured image, suppressing high 
spatial frequency components. Each pixel in an image is replaced with the average value of the 
3pixels centered on it.

1. Select an image file from the file browsing window at the right of the main window. Double-
click the thumbnail image to select and open the image.

2. You can open the Lowpass view, shown in Figure 7.7b and Figure 7.7c, using one of the 
following methods:

• Right-click on the image name in the Workspace and select Add View > Lowpass 
from the popup menu. See Figure 7.7a.

Figure 7.7a   Select GAUSSIAN from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select LOWPASS.

                                     Or

• Select MODIFY > LOWPASS from the menu bar.

                                     Or

3. Click the Lowpass icon in the toolbar.
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Figure 7.7b   Lowpass image interface—single monitor
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Figure 7.7c   Lowpass image interface—dual monitor

4. Select the OUTPUT FILE NAME.

5. Click the Execute button in the Lowpass window to apply the low pass function to the copy 
of the image in both windows.

6. To restore the unprocessed image, click the Reload button.

Note: There are no parameter controls for the Lowpass modify command.
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7.8 Median

The Median modify command is similar to Lowpass; it reduces the contributions of high spatial 
frequency, reducing contrast in regions of high contrast. For each pixel in an image, Median 
substitutes the median pixel value of the nn array of pixels centered around that pixel. The size of 
the filter’s sliding window pixel array is set under Inputs > Median Order. Figure 7.8a illustrates 
the effect of three different size pixel arrays applied to the same image.

Figure 7.8a   Different pixel arrays of the same image—single monitor

3 x 3 7 x 7 11 x 11
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Figure 7.8b   Different pixel arrays of the same image—dual monitor

3 x 3

7 x 7

11 x 11
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1. Select an image file from the file browsing window at the right of the main window. Double-
click the thumbnail image to select and open the image.

2. You can open the Median view, shown in Figure 7.8a, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Median from 
the popup menu. See Figure 7.8c.

Figure 7.8c   Select MEDIAN from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select MEDIAN.

                                     Or

• Select MODIFY > MEDIAN from the menu bar.

                                     Or

3. Click the Median icon in the toolbar.

4. Select the Median Order from the Inputs menu: 33, 55, 77, 9x9, or 1111.

5. Choose an Output File Name.

6. Click Execute to apply the Median filter.

7. Click Reload to start over.
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7.9 Plane Fit

The Plane Fit command computes a single polynomial of a selectable order for an image and 
subtracts it from the image. The Plane Fit operation can be applied to either or both of the XY 
directions.

Box cursors or passbands allow specific points to be used in the calculation of the polynomial. 
Click on the image to start drawing a passband box. Right-click on a box to delete it or change its 
color.

Figure 7.9a illustrates an image with tilt and bow which could affect the analysis of the surface 
data.

Figure 7.9a   Visual Representation of Plane Fit

Refer to the following sections on Plane Fit analysis:

• Fitted Polynomials: Section 7.9.1

• Plane Fit Procedures: Section 7.9.2

• Plane Fit Interface: Section 7.9.3

                                    

Tilt of Sample Surface 3rd Order Plane Fit
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7.9.1 Fitted Polynomials

Refer to Table 7.9a to view the polynomials that calculate the best plane fit for the images in the 
Plane Fit Auto function.

Table 7.9a   Plane Fit Auto Equations

Order Variable Polynomial Equation

0 X z = a

Y z = a

XY (Add Higher Order Cross 
Terms for XY OFF)

z = a

XY (Add Higher Order Cross 
Terms for XY ON)

z = a

1 X z = a + bx

Y z = a + by

XY (Add Higher Order Cross 
Terms for XY OFF)

z = a + bx + cy

XY (Add Higher Order Cross 
Terms for XY ON)

z = a + bx + cy + dxy

2 X z = a + bx + cx2 

Y z = a + by + cy2

XY (Add Higher Order Cross 
Terms for XY OFF)

z = a + bx + cy + dxy + ex2 + fy2

XY (Add Higher Order Cross 
Terms for XY ON)

z = a + bx + cy + dxy + ex2  + fy2+ gxy2 + hx2y + 

ix2y2

3 X z = a + bx + cx2 + dx3

Y z = a + by + cy2 + dy3 

XY (Add Higher Order Cross 
Terms for XY OFF)

z = a+ bx + cy + dxy + ex2 + fy2 + gxy2 + hx2y + 

jx3 + ky3

XY (Add Higher Order Cross 
Terms for XY ON)

z = a + bx + cy + dxy + ex2 + fy2+ gxy2 + hx2y + 

ix2y2 + jx3 + ky3 + lxy3 + mx2y3 +nx3y3 +ox3y + 

px3y2
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7.9.2 Plane Fit Procedures

Use Plane Fit to correct the image distortion as follows:

1. Select an image file from the file browsing window at the right of the main window. Double-
click the thumbnail image to select and open the image.

2. You can open the Plane Fit view, shown in Figure 7.9d, using one of the following methods:

• Right-click on the image name in the Workspace and select Add View > Plane Fit 
from the popup menu. See Figure 7.8c.

Figure 7.9b   Select PLANE FIT from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select PLANE FIT.

                                     Or

• Select MODIFY > PLANE FIT from the menu bar.

                                     Or

3. Click the Plane Fit icon in the toolbar.

4. The Plane Fit input parameters appear along with the top view image. 

5. Select X, Y, or XY as the Plane Fit Mode.

6. Select the Plane Fit Order as 0TH, 1ST, 2ND or 3RD.
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7. Click Execute.

8. Notice that the image distortion is removed, reflecting a flat, planar profile. 

Figure 7.9c   Saddle Image Before Plane Fit
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Figure 7.9d   Plane fit view—single monitor
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Figure 7.9e   Plane fit view—dual monitor

Figure 7.9f   Plane Fit Image
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Now, experiment with this image to explore the range of Plane Fit capabilities. Try the following:

• Change the Plane Fit Order value to see its effects. Notice that there is a vast 
difference between a value of 1, 2 or 3.

• Try plane fitting in one axis (for example, X), but not the other. This generally keeps 
whatever distortions are presently oriented along the unused axis. For example, the 
image can be straightened along its Y axis, while leaving the X axis strongly bowed.

• Try using a different Plane Fit Order for the X and Y axis (for example, a setting of 3 
for X, but a setting of 1 for Y.) This is similar to using one axis, but not the other.

• Compare the effect of Plane Fit with Flatten. Notice that each command has a 
significantly different impact; although, the difference is less noticeable for some types 
of images.

7.9.3 Plane Fit Interface

The Plane Fit dialog box, shown in Figure 7.9g, allows the display parameters and the Plane Fit 
Order to be adjusted to your preferences. 

Figure 7.9g   Plane Fit Inputs Dialog Box
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Input Parameters:

 Buttons on the Plane Fit Window:

Plane Fit Mode X, Y, XY

Plane Fit Order Selects the order of the plane calculated and subtracted from the image.

Settings:

• 0th—centers data.

• 1st—removes tilt.

• 2nd—removes 2nd order bow.

• 3rd—removes 3rd order bow.

Z Thresholding direction Specifies the range of data to be used for the polynomial calculation based on 
the distribution of the data in Z:

Range or Settings:

• Use Z > = —Uses the data whose Z values are greater than or equal to 
the value specified by  the Z thresholding %.

• Use Z <—Uses the data whose Z values are less than or equal to the 
value specified by  the Z thresholding %.

• No Thresholding—Disables all thresholding parameters.

Z Thresholding Percent Defines a Z value as a percentage of the entire Z range in the image (or data 
set) relative to the lowest data point.

Add Higher Order Turning this on adds higher order cross terms to the polynomial fit when XY 
is chosen (see Table 7.9a).

Output File Name Select the path of the extracted image file. Leave blank for immediate view/
use without saving the altered image file.

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.

Execute  Initiates the plane fit operation.

Reload Restores the image to its original form.
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7.10 Spectrum 2D

The Spectrum 2D (two-dimensional) function transforms images into the frequency domain via a 
2D fast Fourier transform (FFT), then allows you to selectively pass or remove specific frequencies 
from the image. After selected frequencies are passed or removed, the image is reconstructed, 
yielding an improved version. The Spectrum 2D function is extremely useful in removing 
electrical and acoustic noise from images, and may also be used to isolate certain surface features 
(e.g., lathe lines on turned surfaces, load marks on ground or polished surfaces, etc.).

Noise removable using the Spectrum 2D function generally consists of two types: [1] high 
frequency electrical noise (most visible at atomic resolution); [2] lower-frequency acoustic noise 
from floor vibrations, air blowers, etc. The 2D spectral display is scaled according to the scan size 
of the original image

7.10.1 Spectrum 2D Procedures

Before beginning, it is advisable to make a backup copy of the original image file. The Spectrum 
2D function is capable of making major changes to the image which, if saved, can destroy the 
original data.

The Spectrum 2D command allows filtering of images in the frequency domain through the 2-
dimensional fast Fourier transform (FFT). The 2-D FFT (power spectrum) of the image is 
calculated and displayed. As the cursor is moved through the 2D plot, instantaneous results are 
displayed. Rectangular boxes representing either frequencies to pass (multiply by 1.0), passband, or 
frequencies to stop (multiply by 0.0), stopband, can then be selected. Finally, the inverse transform 
is performed on the filtered transform data to reconstruct a new filtered image.
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Use Spectrum 2D to correct the image distortion as follows:

1. Select an image file from the file browsing window at the right of the main window. Double-
click the thumbnail image to select and open the image.

2. You can open the Spectrum 2D view, shown in Figure 7.10b and Figure 7.10d, using one of 
the following methods:

• Right-click on the image name in the Workspace and select Add View > Spectrum 2D 
from the popup menu. See Figure 7.10a.

Figure 7.10a   Select SPECTRUM 2D from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select SPECTRUM 2D.

                                     Or

• Select MODIFY > SPECTRUM 2D from the menu bar.

                                     Or

3. Click the Spectrum 2D icon in the toolbar.
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7.10.2 Spectrum 2D View

The Spectrum 2D view, shown in Figure 7.10b and Figure 7.10d, allows display parameters to be 
adjusted to your preferences.

Figure 7.10b   The Spectrum 2D View

A spectrum 2D (FFT) image of alkane, C60H122, is shown in Figure 7.10d. The fundamental period 

is approximately 7.5nm.
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Figure 7.10c   Image of alkane C60H122

Figure 7.10d   Spectrum 2D analysis of image of Figure 7.10c—dual monitor view
Rev. D NanoScope Software 8.10 User Guide 367



Modify Commands
Spectrum 2D

36
Input Parameters in the Spectrum 2D Panel

Buttons in the Spectrum 2D Panel 

Controls in Spectrum 2D

Right-clicking an image in a Spectrum 2D, shown in Figure 7.10e, window: 

Figure 7.10e   Select BOX or STOPBAND 

Right-clicking inside a BOX or STOP BAND box in an (Fourier transformed) image, shown in 
Figure 7.10f, window: 

Output File Name Select the path of the modified image file.

Write File Upon Execute Writes the output file(s) when the Create File(s) button is clicked.

FFT Initiates the two-dimensional FFT calculation.

INVERSE FFT Computes the modified image using the filter parameters 
defined in the FFT step.

RELOAD Reloads the original image.

BOX Puts the mouse in the passband mode. This allows placement 
of passband boxes which set the frequency data outside the 
boxes to zero. Data inside the boxes is passed.

STOP BAND Puts the mouse in the stopband mode. This allows placement 
of stopband boxes which set the frequency data within the 
boxes to zero. The data outside of the boxes is passed. Stop-
bands appear on the top view image as “X-ed” rectangles.

DELETE Erases the passband Box or Stopband box that enclose the cur-
sor.

CLEAR ALL Deletes all passband Box and Stopband boxes.

SET COLOR Allows you to set the cursor and/or box colors.

Stop Band

Box
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Figure 7.10f   DELETE, SET COLOR and CLEAR ALL buttons are active inside a passband or STOPBAND 
window.
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Results Parameters in Spectrum 2D

Hints for Optimizing the Spectrum 2D Command

• If any passband boxes exist on the display, then data outside the passband boxes is 
deleted. Thus, it is superfluous to have a stopband box completely outside the confines 
of a passband box.

• Due to the symmetry of the transformed data about the line , all stopband and 
passband boxes drawn actually produce two boxes on the display.

See also: Offline/Modify menu: Lowpass: Section 7.7 command.

X PERIOD Spatial frequency in the x direction. The lowest frequency is at 
the center of the plot.

Y PERIOD Spatial frequency in the y direction. The lowest frequency is at 
the center of the plot.

R PERIOD Spatial frequency in the radial direction.

ANGLE Arctangent of (y/x).

MAX AMP The maximum amplitude (0-peak) of the transformed image.

MAX RMS AMP The maximum of the RMS amplitude of the transformed image.

MAX POWER The maximum power of the transformed image.

MAX PSD The maximum power spectral density of the transformed image.

AMP The amplitude of the 2D FFT at that spatial frequency.

RMS AMP Amp/(sqrt(2))

POWER Amplitude2 = (2D FFT)2

PSD Normalized power spectrum per number of points = (2DFFT * # 

x_points * # y_points)2/(# x_points * # y_points)

REL AMP Amplitude/(Max Amplitude)

REL PSD PSD/(Max PSD)

fx f– y=
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7.10.3 Example 1—Simplifying an Image

Regarding data contained within an image, more data is not always better. Sometimes it is desirable 
to eliminate components of an image to better isolate and accentuate another component of direct 
interest. The following example demonstrates how to utilize the Spectrum 2D function to simplify 
an image for analysis. The image utilized here is of lathed plastic used in the manufacture of 
contact lenses.

1. Load an image from the IMAGES DIRECTORY (or in the IMAGES folder on your installed 
system). Examine the image using the 3D Surface Plot (see 3D Surface Plot: Section 5.2) 
function.

Supposing you want to make a general, cross-sectional inspection of the sample’s lathe lines, it may 
prove helpful to remove spikes and smaller, jagged features on the surface. Notice the surface 
topology may be analyzed in terms of two dominant influences: 1) lathe lines running parallel to the 
image’s Y-axis; 2) a contiguous, jagged aspect to each lathe line (i.e., the lines themselves are not 
smooth streaks, but present a jagged profile along their length). Because the parallel lathe lines 
occur at longer wavelengths than the short-wavelength, jagged bumps and spikes, it is possible to 
separate these components using 2D spectral analysis.

2. With the image selected, click the Spectrum 2D icon. The Spectrum 2D panel appears as 
does the image. Click the FFT button.

The 2D spectrum of the image appears in the Spectrum 2D image window as a clustering of data 
having a narrow, horizontal band. This horizontal band reveals the prominence of the parallel lathe 
lines, and the fact that they are distributed uniformly along the X-axis of the image.

As the cursor is moved through the 2D plot, the x period, y period and r period values are 
displayed in a box to the right of the plot. Moving the cursor through the data cluster reveals that 
shorter wavelengths lie around the periphery of the plot, while longer wavelengths lie near the 
plot’s center. Notice that the plot is bandwidth limited at its exact center; that is, nothing larger than 
the scan size of the image may be plotted here.

Note: The term “wavelength” as used throughout refers to actual surface features, 
NOT the color of light used to represent those features.

The trick to using 2D spectral filtering lies in first identifying wavelength components of interest to 
you. This requires some interpretive ability on your part and is perfected with practice. When the 
sought-after component is identified, all that remains is to remove everything else.

One use of 2D spectral modification is in removing high frequency components, commonly 
referred to as “noise.” (Whether the component is referred to as “noise,” or simply as “high 
frequency features” of an image is analogous to whether or not to call unwanted plants “weeds.”) 
High frequency components are rendered on images as finely spaced, jagged lines, spikes and fuzz.
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Assuming you want to remove high frequency noise, you would seek to eliminate outer portions of 
the plot. This is easily done with the Spectrum 2D function by enclosing the central cluster of the 
plot within a passband drawn on the transformed image.

The objective here is to pass (allow) the central, longer wavelength portions of the plot, while 
stopping (disallowing) the shorter wavelength components located around the periphery of the plot. 
The x period and y period of the enclosed area are displayed to the right as the boxes are drawn.

3. Click on Cursor / Box, then draw a passband box around the central portion of the 2D 
spectral plot. Click INVERSE FFT to reconstruct the image with the high frequency 
components removed. To obtain the best view of the image, click on the Image / 3D Surface 
Plot function (or 3D Surface Plot icon). Changes to the image are most obvious when 
viewing from an elevated angle.

When the image is reconstructed with its high frequency components removed, the most obvious 
change is smoother, more contiguous image features. Jagged lines and spikes are reduced, 
accentuating the longer wavelength features.

Note: Filtering may also be accomplished by utilizing the Modify > Lowpass filter, 
although without selective wavelength controls.

7.10.4 Example 2—Highlighting Features Using 2D Spectrum Modification

Another use of the Spectrum 2D function is in highlighting certain surface features by filtering out 
unwanted wavelengths. Continuing with the example of the lathed plastic, it is possible to isolate 
and accentuate lathe lines. (This might prove useful to an analyst intending to examine how cutting 
tool geometry imparts features to the surface of the plastic.) Conversely, it may also be used to 
isolate and accentuate smaller surface features inherent within lathe lines, while reducing the 
separation between lines. 

1. Reload the image file used in Section 7.10.3; but do not save the previously filtered version 
of the image. When the image is reloaded, select the Modify > Spectrum 2D function, then 
click on the FFT button. As before, the 2D spectrum of the image is plotted. To isolate the 
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lathe lines, draw a thin, horizontal passband box across the center of the plot (see Figure 
7.10g).

Figure 7.10g   Horizontal Passband Box Illustration

The intent is to pass most wavelengths inherent in the horizontally distributed lathe lines, while 
stopping those wavelengths inherent in the vertically distributed features of each line (i.e., the 
jagged contour running along each individual line). After the passband box is drawn, click on the 
Inverse FFT button to reconstruct the image. Use the Image > 3D Surface Plot function to look 
closer at the reconstituted image. The change in the image quickly becomes evident; lathe lines 
stand out more dramatically and have been smoothed along their length. By analyzing a section 
across the lathe lines ANALYSIS > SECTION, a cleaner profile of lathe lines in the plastic is 
obtained.

The vertically distributed features of the lathe lines may be similarly examined by filtering out the 
horizontal components. By drawing a passband box vertically, it is possible to isolate and 
accentuate the features running along each individual lathe line (see Figure 7.10h) 

Note: This type of analysis might prove helpful in a study of how tool chatter affects 
the surface, without regard to tool geometry.
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Figure 7.10h   Vertical Passband Box Illustration

7.10.5 Example 3—Removing External Noise

In Example 1 above (see Section 7.10.3), high frequency surface noise was removed by drawing a 
passband around the center spectral plot of the image. This type of noise tends to be evenly 
distributed across the surface and is inherent to the surface itself. Another type of noise is 
externally introduced, either due to electrical noise (especially during extremely high resolution, 
atomic scans), or due to acoustic noise introduced from air blowers, loud sounds, etc. 
Distinguishing one type of noise from another requires some experience. Here are a few guidelines.

• Steady acoustic noise (such as from a constant pitch sound or moving air) and steady 
electronic noise, introduce diagonal bands to the image. These bands run parallel and 
are produced when the noise is introduced in sync with the scan. If the bands change 
their angle of orientation when the Scan Size or Scan Rate is altered, they are probably 
from this source. This type of noise can be easily removed from the image by using the 
Spectrum 2D function.

• Sporadic noise (such as from sudden, loud noises and/or powerful EMF spikes) 
introduce isolated “noise lines” which run partially or completely across the image. 
These may arise sporadically and without pattern. This type of noise cannot be removed 
from the image using the Spectrum 2D function; however, another function, Modify > 
Erase, easily removes this type of noise.

• To remove the diagonal bands characteristic of steady acoustic and electronic noise 
using the Spectrum 2D function, do the following:

1. Load the image, then click on the Modify > Spectrum 2D function. Click the FFT button to 
obtain the image’s 2D spectral plot. If the image is of a more or less isotropic surface, search 
the spectral plot for bright “hot spots”—small islands of high spectral concentration—near 
its center.
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Figure 7.10i   Spectrum 2D Hot Spots

Note: Click on the Zoom / 4:1 function to obtain a closer view of the “hot spots.” 

Depending upon the distribution and orientation of the noise bands, the hot spots should be 
distributed at the same angle in the spectral plot as they are on the image. There may also exist 
other spectral hot spots which are actually part of the surface features; however, these are usually 
distributed at some other orientation. If the surface is anisotropic and includes some type of 
banding features naturally, isolating the noise bands proves more difficult, especially if they run 
parallel to the noise bands.

When the hot spots are located, draw a stopband box around them, then click on the INVERSE FFT 
button to reconstruct the image. The image should now appear without the noise bands. If noise 
bands are still present, click on the RELOAD option and try again by stopbanding different hot 
spots.

Spectral “Hot Spots”
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7.11 Subtract Image

 The Subtract Image command enables data from one image to be subtracted from another. This 
proves most useful when comparing two or more images from a surface to determine changes over 
time, or to compare completely different images. The Subtract Image command cannot be directly 
applied to images having different pixel sizes (Number of Samples value). For example, a 256 x 
256 pixel image cannot be directly subtracted from a 512 x 512 image.

Figure 7.11a diagrams an image subtraction and its effects. Surface 2, when subtracted from 
surface 3, yields surface 1 (“3” - “2” = “1”). Conversely, surface 1 plus surface 2 yields surface 3 
(“1” + “2” = “3”).

Figure 7.11a   Effects of Image Subtraction

2

3

1                       

2771-110
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1. Select an image file from the file browsing window at the right of the main window. Double-
click the thumbnail image to select and open the image.

2. You can open the Subtract Image view, shown in Figure 7.11c, using one of the following 
methods:

• Right-click on the image name in the Workspace and select Add View > Subtract 
Image from the popup menu. See Figure 7.11b.

Figure 7.11b   Select SUBTRACT IMAGE from the workspace

                                     Or

• Right-click on a thumbnail in the Multiple Channel window and select SUBTRACT 
IMAGE.

                                     Or

• Select MODIFY > SUBTRACT IMAGE from the menu bar.

                                     Or

3. Click the Subtract Image icon in the toolbar.

4. The Subtract Image view, shown in Figure 7.11c, opens.
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Figure 7.11c   Subtract Image view—single monitor

5. Select a file to subtract from the Inputs > Image to Subtract menu or click the LOAD 
IMAGE button to browse for a file.

6. If necessary, right click in either panel to change the channel.

7. Click the SUBTRACT IMAGE button to subtract the image in the right panel from the image in 
the left pane. The result, which overrides the data in the active channel, is shown (see Figure 
7.11d) in the left panel of the Subtract Image view.

Note: When Data types are not the same, the calculation is performed as follows:

• First Image Relative Z scale * first (left) image - Second image Relative Z scale 
* second (right) image = new image. The Relative Z scale must be greater than
- 32767 and less than 32767.

8. Click Undo to restore the originally loaded file.
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Figure 7.11d   Subtract Image after channel 2 (right) was subtracted from channel 1.Dual monitor view.
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Chapter 8   AutoProgram
An AutoProgram is a sequence of operations that may be applied automatically to at least one 
previously captured image. Typically, an AutoProgram is created to rapidly analyze a large 
number of images taken under similar conditions. Any Offline command except for XY Drift and 
Subtract Image may be included in an AutoProgram.

Refer to the following functions available in AutoProgram menu of the NanoScope software:

• Creating an AutoProgram:  Section 8.1

• Example command: Flatten:  Section 8.2

• Example command: Depth:  Section 8.3

• Example command: Roughness:  Section 8.4

• Running AutoProgram:  Section 8.5
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8.1 Creating an AutoProgram

Do the following to create an AutoProgram:

1. Select a directory, then an image file within it, from the file browsing window at the right of 
the NanoScope main window. Double-click its thumbnail to select and open the image. The 
image file name and the Offline icon, as well as a Multiple Channel icon and the words 
Multiple Channel are added to the Workflow Toolbar (Workspace), and the image opens in 
the viewing window, shown in Figure 8.1a.

Figure 8.1a   Open Image
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2. In the Workflow Toolbar, right-click on the image file name or its Offline icon and select 
Create AutoProgram (see Figure 8.1b). You may also right-click on the Multiple Channel 
icon or Multiple Channel and select Create AutoProgram.

Figure 8.1b   Create AutoProgram

3. You are asked if you want to include the selected image to define the AutoProgram among 
the images processed by the AutoProgram (see Figure 8.1c). (Typically: YES.) The ADD 
LINKED box should also be checked. When linking, any changes made to the currently active 
view will then alter any linked views.

Figure 8.1c   Include Selected Image Box

4. In the AutoProgram Results View (see Figure 8.1d):

a. Right-click on AutoProgram, under the file name or icon appearing on the line under 
Run Group. 

b. Click Add View to add a view to the Autoprogram. This view will then be added to all 
files in the Autoprogram if they are linked.

c. Click the view of an Offline command to be performed first by the AutoProgram. 

d. Repeat for additional views.

Note: Example specifications of the Flatten, Depth and Roughness commands for 
inclusion in an AutoProgram are described next. Similar actions apply to 
include other Offline commands in an AutoProgram.
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Figure 8.1d   Add Views to be Included in an AutoProgram
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8.2 Example command: Flatten

To open the Flatten View:

1. Click the command name or icon that has been added to the Run Group Autoprogram. 

2. Click in the image and drag open a box over features in the image that are to be excluded 
from the polynomial fit calculations (see Figure 8.2a). Typically, only featureless areas are 
used for flattening an image. 

3. In the Inputs panel of the Flatten View, set parameter values to apply for all images 
operated on by the AutoProgram. 

4. Close the Flatten View.

Note: Check the box DO NOT USE DEFAULT CONFIGURATION SETTINGS (Default 
Configuration Settings on page 116). This setting can affect drawn Stopband 
boxes and cursors which can be subsequently changed and used for later 
Autoprograms.

Figure 8.2a   Specify a Flatten Operation
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8.3 Example command: Depth

To open the Depth View:

1. Click the command name or icon that has been added to the Run Group Autoprogram. 

2. Click in the image and drag open a box over an area that contains a height step (see Figure 
8.3a). 

3. In the Inputs panel of the Depth View, set parameter values that will apply for all images 
operated on by the AutoProgram. 

4. Close the Depth View.

Figure 8.3a   Specify a Depth Measurement
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8.4 Example command: Roughness

To open the Roughness View:

1. Click the command name or icon that has been added to the Run Group Autoprogram. 

2. Click in the image and drag open a box over an area where you would like the sample surface 
condition analyzed (see Figure 8.4a).

3. In the Inputs window, set parameter values that will apply for all images operated on by the 
AutoProgram.

4. Close the Roughness View.

Figure 8.4a   Specify a Roughness Measurement for Inclusion in an AutoProgram
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8.5 Running AutoProgram

Once all commands are included in the AutoProgram list and their action specified, you are ready 
to run AutoProgram.

1. Click the Add Files... button in the AutoProgram Results View (see Figure 8.5a). The Add 
Files dialog box appears.

2. In the Add Files dialog box, select the Link Files box to have the same AutoProgram 
instructions apply to each file. Select files of interest and click Add to have the selected files 
included when the AutoProgram is run. Hold down the Shift key to select a consecutive 
group of files or the Control key to select more than one individual file.

3. In the AutoProgram Results View, check the Hide Views box if you don’t want the images 
displayed, as they are automatically analyzed by the AutoProgram. If you want to see the 
images processed during AutoProgram execution, leave Hide Views unchecked. Increasing 
the value in Computation Time allows more time to view operations during Autoprogram 
execution.

Figure 8.5a   Add Files Dialog Box

4. Click the Run button in the Results of [AutoProgram] view to start the AutoProgram.

Note: The RUN button toggles to display Stop while the AutoProgram is running. 
Click it if you need to stop the process before it is completed. Clicking the Run 
button again restarts the AutoProgram at the first image.

5. Upon completion, the data appears in the Log File View property sheet (see Figure 8.5b).
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Figure 8.5b   Log File View Property Sheet

6. Results for individual analysis steps can be found in the Analysis Results drop-down menu, 
also shown in Figure 8.5b.

7. If you close the Autoprogram Results view without saving the Autoprogram, you will be 
prompted to save the Autoprogram as an .apg file.

8. To save the log file, select the SAVE LOG button in the Log File View.

9. To clear the log file, select the CLEAR LOG button in the Log File View.

10. Autoprogram results, with statistical analysis (termed reports), can be printed or exported as 
tab delimited text using the PRINT REPORT or EXPORT REPORT buttons.

Print Report

Export Report Clear Log

Save Log
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Chapter 9   Recipes
The optional Recipe system allows you to automate most microscope functions using an easy to 
use graphical user interface (GUI).

Note: The Recipes option is not available on all Bruker scanning probe microscopes.

Refer to the following analysis commands available in Recipe menu of the NanoScope software:

• Starting the Recipe Menu:  Section 9.1

• Creating a Recipe:  Section 9.2

• Running a Recipe:  Section 9.3

• Meta tags:  Section 9.4

• Recipe Functions:  Section 9.5

• Example 1: Teach and Run a Basic Recipe:  Section 9.6

Additional information about the Recipes function, including several example recipes, can be found 
in The Recipes Cookbook, Bruker part number 004-1021-000.
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9.1 Starting the Recipe Menu

Start the Recipe view by clicking TOOLS > RECIPES in the NanoScope toolbar. See Figure 9.1a.

Figure 9.1a   Start Recipes

A Recipes window will open.

9.1.1 Menu Bar Items

The menu bar includes:

• File—Accesses menu selections for opening and saving and recipe (.rcx) files.

• Edit—Allows the user to add or delete steps in the recipe.

• Launch—Allows the user to run a recipe.

• About—Provides access to online help “about” information.
2 NanoScope Software 8.10 User Guide Rev. D



Recipes
Creating a Recipe
Table 9.1a   Recipe Menu Bar Items

9.2 Creating a Recipe

A new, blank recipe, “My Recipe,” is created when the Recipe window is opened. The FILE > NEW 
RECIPE clears the current recipe and allows you to create a new recipe. FILE > OPEN RECIPE 
clears the existing recipe (if saved) and opens a previously saved recipe.

The Edit > New function allows you to add recipe steps below a selected step. Right-clicking on a 
step also provides access to the Edit functions. Only functions that are allowed can be added. Other 
functions are grayed out. Recipe step order can be changed by dragging steps. Step order is 
enforced, i.e. moving a step to a logically impossible location is not allowed. Table 9.2a shows a list 
of allowable parent functions and Table 9.2b shows a list of allowed child functions.

File

New Recipe Clears the existing recipe and starts a new recipe.

Open Recipe Opens a window to allow you to select an existing recipe.

Save Recipe Saves the current recipe to disk.

Save Recipe As Saves the current recipe to disk under a new file name.

Edit

New Inserts a step below the current step.

Delete Deletes the selected step.

Cut Deletes the selected step and copies it to the clipboard.

Copy Copies the selected step to the clipboard.

Paste Pastes the contents of the clipboard below the selected step.

Professor Walks you through configuring the selected step.

Move To Moves the stage to the designated position.

Re-Teach Alignments Allows user to redefine alignments.

Launch
Open & Run Opens a window, allowing you to select a recipe and then runs it.

Run Current Runs the current recipe.

About
Help Opens this document.

About Recipe Plug-In Opens the About Recipe window.
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Table 9.2a   Allowed Parent Functions

Note: Root is displayed as My Recipe.

Function Allowed Parent Functions

Alignment Load Sample, Real-time

Auto Tune Alignment, Auto Tune, Image Analysis, Image Set, Load Sample, Real Time, Report, Site, Site Order 

Capture Image Measurement

Image Analysis Alignment, Site, Site Order, Nanoscript, Real-time, Root

Image Export Image Analysis, Image Capture, Image Set

Image Set Alignment, Auto Tune, Load Sample, Measurement, Real-time, Root, Site, Site Order

Load Sample Real-time

Measurement Site

Move To Alignment

Nanoscript Alignment, Site, Site Order, Image Analysis, Root, Real Time 

Real-time Root

Report Alignment, Site, Nanoscript, Image Analysis, Real-time, Root 

Site Alignment 

Site Order Alignment 
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Table 9.2b   Allowed Child Functions

Note: Root may have only one Real Time child. Site may have only one Measurement 
child.

You can browse for files by clicking the file browse button, shown in Figure 9.2a, that appears on 
the right when you select a file name.

Function Allowed Child Functions

Alignment/Origin Auto Tune, Image Set, Move To, Report, Site, Site Order

Auto Tune Auto Tune, Image Set, Report

Image Analysis Any Offline function, Image Export, Report

Image Capture Auto Tune, Any Offline function, Image Export

Image Export Image Export, Report

Image Set (offline) Image Analysis, Report

Load Sample Alignment/Origin, Auto Tune, Image Export, Image Set, Report

Measurement Auto Tune, Capture Image, Image, Image Analysis, Image Set, Report

Nanoscript Auto Tune, Image Set, Nanoscript, Report

Real-time Alignment/Origin, Auto Tune, Image Analysis, Image Export, Image Set, Load 
Sample, Report

Root (My Recipe) Image Analysis, Image Export, Image Set, Real-time, Report

Report No children allowed

Site Auto Tune, Image Analysis, Image Set, Measurement, Nanoscript, Report

Site Order Auto Tune, Image Analysis, Image Set, Report, Site
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Figure 9.2a   File Browse Button

All recipe steps are given a NAME which you can override by typing in the NAME field.

All recipe steps have a NOTES field which allows you to insert comments.

Many recipe steps have a PROFESSOR associated with them. Click PROFESSOR to launch an 
assistance wizard that guides you through programming this recipe step. The PROFESSOR generally 
provides full access to the NanoScope software and interface for a given step.

You may delete a step by highlighting that step and selecting EDIT > DELETE or right-clicking and 
selecting DELETE.

You may save you recipe with the FILE > SAVE RECIPE or FILE > SAVE RECIPE AS commands.

9.3 Running a Recipe

Click Launch > Open & Run or Run Current to run the current open recipe. This opens the 

Recipe Runner window, shown in Figure 9.3a. Click the RUN icon  in the Recipe Runner 

window to start running the recipe.
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Figure 9.3a   Recipe Runner Window

You start the recipe from any position by:

• Moving the SLIDER CONTROL to the desired position.

• Highlighting (by clicking) the desired step.

Click the PAUSE icon  in the Recipe Runner window to pause the running of the recipe.

Click the STOP icon  in the Recipe Runner window to stop running the recipe.

The Log window displays the recipe status.

9.3.1 Report files

A Report step may be inserted anywhere in a recipe and reports the activity of all parent nodes. 
Information in the report files includes all input and output parameters as well as run status 
(Incomplete, Pass or Fail). If programmed, a Report xml file will be generated. The xml file can be 
used as a data feed to generate multiple report formats. Use XSL Transformations (XSLT) — 
http://www.w3.org/TR/xslt to create a formatted output file from this xml file. Several default 

Run

Pause

Stop

Slider control

Highlighted step
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XSLT files (html and text) are provided (in ..\plugins\recipes\stylesheets\). You can also make your 
own xls translation file if you’re an advanced user to go from XML to any other text format. You 
can use the report file (or translated version) to integrate recipe output information with custom 
post processing software.

9.4 Meta tags

Meta tags can be used in all parameter fields that specify an output file name to be written and can 
also be used in the notes parameter field for all recipe functions. Export text tag parameters also 
support meta tags. For example, a time stamp meta tag can be entered into the name of a file to be 
captured. "MyFileName<TimeStampMonth><TimeStampDay>.000" would drop the month and 
day into a captured filename. Other recipe or microscope configuration data can also be used. For 
example, you could use the <LocX> and/or <LocY> tags to include the sample site location in your 
filename.

The most local version of the parameter is always used. This means that if the specified meta tag 
does not exist within the current recipe function, the meta tag parser will traverse from parent to 
grandparent function until the parameter is found. In this way, a notes parameter for a captured 
image can contain information about the microscope configuration.

9.4.1 Special Meta Tags

Time Stamp Meta Tags

Parent Function Reference Meta Tags

Time Stamp Meta Tags

<TimeStampMonth>

<TimeStampMonthName>

<TimeStampDay>

<TimeStampYear>

<TimeStampHour>

<TimeStampMinute>

<TimeStampSecond>

Time Stamp Meta Tags

<ParentFileName>

<ParentName>
8 NanoScope Software 8.10 User Guide Rev. D



Recipes
Recipe Functions
Analysis nodes that produce a modified image can use <ParentFileName> in conjunction with the 
file overwrite option to overwrite the input file. <ParentName> is used to reference the <Name> 
parameter of the local function’s parent function.

9.5 Recipe Functions

All Recipe Nodes contain NAME and NOTES fields which are for personal notation only and are not 
used for logical execution of the recipe.
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9.5.1 Alignment/Origin

Defines an origin and a sample deskew angle from which the coordinates of all subsequent child 
site nodes are based. 

Alignment Mode Origin Only, Origin using X deskew, Origin using Y deskew.

Origin X X-axis origin location in absolute stage units.

Origin Y Y-axis origin location in absolute stage units.

Origin Z Z-axis origin location in absolute stage units.

Speed Speed at which the stage should move in percent of maximum speed.

Deskew Angle Used to deskew the coordinate system defined by the above origin. In other words, all 
subsequent child sites will be shifted by the origin values, and rotated by the deskew 
angle.

Deskew Pt 1 - X X location of the first point used to calculate the deskew angle.

Deskew Pt 1 - Y Y location of the first point used to calculate the deskew angle.

Deskew Pt 2 - X X location of the second point used to calculate the deskew angle.

Deskew Pt 2 - Y Y location of the second point used to calculate the deskew angle.

Move To Moves the stage to the designated position.

Professor Yes

Meta Tags

Name <Name>

Notes <Notes>

Alignment Mode <Mode>

Origin X <OriginX>

Origin Y <OriginY>

Origin Z <Origin Z>

Speed <Speed>

Deskew Angle <DeskewAngle>

Deskew Pt 1 - X <DeskewPt1X>

Deskew Pt 1 - Y <DeskewPt1Y>

Deskew Pt 2 - X <DeskewPt2X>

Deskew Pt 2 - X <DeskewPt2Y>
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9.5.2 Auto Tune

Tells the systems to measure and calculate the cantilever drive amplitude and frequency. 

Start Frequency Starting point of the Auto Tune frequency sweep.

End Frequency Ending point of the Auto Tune frequency sweep.

Target Amplitude Targeted output signal amplitude at the photodiode detector. This value should not be 
confused with Drive amplitude, which is the amplitude applied directly to the cantilever 
itself (see Drive amplitude).

Range and Settings: 0.00 to 8.00 V

Note: Dimension Series SPMs, nominal = 500mV
          Small Sample MultiMode SPMs, nominal = 500mV

Peak Offset Percentage of cantilever’s free-air resonant frequency to be automatically offset. Peak off-
set is used to compensate for changes in resonance before engagement due to the tip’s 
interaction with the surface after engagement.

Range and Settings: 0 to 50%; typical value = 0 to 10%

Minimum Q Q is the value defined by the amount of oscillation it takes for a wave to drop to 1/e (e = 
2.718) of its amplitude value (i.e. a wave with an amplitude of ten would have a Q of 10/
e, or 3.6788). Minimum Q establishes a minimum “width of peak” value allowed by the 
AutoTune function.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

Start Frequency <StartFreq>

End Frequency <EndFreq>

Target Amplitude <TargetAmplitude>

Peak Offset <PeakOffset>

Minimum Q <MinimumQ>
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9.5.3 Capture Image

Captures and saves an image to disk in nanoscope format. This image can be exported as a BMP, 
JPEG, or TIFF file. Captured images may be parent objects of analysis nodes so that the analysis 
takes place immediately after the data has been captured. 

9.5.4 Image Analysis

Analysis nodes are children of CAPTURE IMAGE or IMAGE SET. In combination with image parent 
nodes and report nodes as children, they are capable of producing numeric analysis results and/or 
resulting images. Analysis nodes can also be child nodes of other analysis nodes when analysis of a 

Capture File Name Name of file to be captured. A full path may be specified, but if a complete path is not 
specified the "default capture path" (displayed in the Properties window of the My Recipe 
node) is used.

Overwrite Existing File Specifies if the resulting image should overwrite an existing image file of the same name. 
If NO, a new, sequential file will be created.

Auto File Export DISABLED or the type of file to which the captured nanoscope image is exported.

Export Channel The EXPORT CHANNEL field specifies which channel should be exported.

Note: BMP, JPEG, and TIFF formats can not contain information about more than 1 
channel. 

Export Text Tags This field is used to put notes in the "notes" tag for TIFF files.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

Capture File Name <FileName>

Overwrite Existing File <FileOverwrite>

Auto File Export <FileExportType>

Export Channel <FileExportChannel>

Export Text Tags <FileExportTextTags>
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filtered image (by another analysis node) is desired. E.g. if you want to perform a roughness 
analysis of images that have been flattened, you would configure your image tree as follows:  

Data Channel Selects which channel from the parent Image object to use for analysis.

Output Image Name Name of output image. A full path may be specified, but if a complete path is not speci-
fied the "default capture path" (displayed in the Properties window of the My Recipe 
node) is used.

Overwrite Existing File Specifies if the resulting image should overwrite an existing image file of the same name. 
If NO, a new, sequential file will be created.

File Export Channel The EXPORT CHANNEL field specifies which channel should be exported.

Note: BMP, JPEG, and TIFF formats can not contain information about more than 1 
channel.

Export Text Tags This field is used to put notes in the "notes" tag for TIFF files.

Additional Fields… Additional fields are stored containing information about the analysis configuration. 
These fields will vary depending on the type of analysis you are doing. These fields are 
editable only through the Professor and the standard image analysis views.

Professor Yes

Meta Tags

Name <Name>

Notes <Notes>

Data Channel <Channel>

Output Image Name <Output File Name>

Overwrite Existing File <FileOverwrite>

Auto File Export <FileExportType>

File Export Channel <FileExportChannel>

Export Text Tags <FileExportTextTags>
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9.5.5 Image Export

Exports an image. 

File Name Name of output file.

Overwrite Existing File Specifies if the resulting image should overwrite an existing image file of the same name. 
If NO, a new, sequential file will be created.

Export Type The file type that will be exported: BMP, JPEG, TIFF.

Export Channel The EXPORT CHANNEL field specifies which channel should be exported.

Note: BMP, JPEG, and TIFF formats can not contain information about more than 1 
channel.

Export Text Tags This field is used to put notes in the "notes" tag for TIFF files.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

File Name <FileName>

Auto File Export <FileExportType>

File Export Channel <FileExportChannel>

Export Text Tags <FileExportTextTags>
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9.5.6 Image Set (offline)

Specifies a set of previously captured files. May also be exported as a BMP, JPEG, or TIFF file 
using the Image EXPORT function. 

9.5.7 Load Sample

Stops the recipe and moves the stage to a specified location so that a new sample can be loaded. An 
option is provided to re-teach all alignment/origin objects so that associated sites will adjust 
appropriately without being re-taught. 

Image List Names of previously captured NanoScope image files. A full path may be specified, but if 
a complete path is not specified the "default capture path" (displayed in the Properties 
window of the My Recipe node) is used.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

Image List <ImageList>

Auto File Export <FileExportType>

File Export Channel <FileExportChannel>

Export Text Tags <FileExportTextTags>

X X-axis stage location for re-load in absolute coordinates.

Y Y-axis stage location for re-load in absolute coordinates.

Z Z-axis stage location for re-load in absolute coordinates.

Speed Speed at which the stage should move in percent of maximum speed.

Re-Teach Alignments/Origin Turns on/off re-teaching of all alignment/origin objects in the recipe before continuing.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

X <LocX>
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9.5.8 Measurement

Stores Real Time parameters used to configure the microscope. At run-time, it will use these 
parameters to engage the probe and scan the sample. Site may have only one measurement step. 

9.5.9 My Recipe

Root node of recipe containing default capture and report folders. 

Y <LocY>

Z <LocZ>

Speed <Speed>

Re-Teach Alignments/Origin <TeachOrigin>

Nanoscope Parameters Lists Lists all parameters used to configure the microscope.

Professor Yes

Meta Tags

Name <Name>

Notes <Notes>

Capture Directory Default path to the directory that is used for storing and reading captured image files 
when a full path is not defined by the CAPTURE FILE NAME.

Report Directory Default path to the directory used to store reports when a full path is not defined by the 
REPORT OUTPUT XML FILE.

Version Contains Recipe plug-in version information (read only)

Professor No

Meta Tags

Name <Name>

Notes <Notes>

Capture Directory <CaptureDirectory>

Report Directory <ReportDirectory>

Version <Version>
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9.5.10 Real-time Configuration

Realtime stores reference information about the microscope hardware that the recipe was written 
for. There may be only one Real Time step in a recipe. 

Controller Specifies the controller.

Microscope Specifies the microscope.

Scanner Specifies the scanner

Vision Specifies the vision system.

Zoom Specifies the optical system.

Professor No

Meta Tags

Controller <Controller>

Microscope <Microscope>

Scanner <Scanner>

Vision <Vision>

Zoom <Zoom>
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9.5.11 Report

Report generates an XML formatted summary of recipe node results. Reports may be placed 
anywhere in the recipe and are used for local or global reporting. The report looks to its parent node 
and reports on all children of its parent, including itself.

All nodes in the recipe contain a "run status" output field that has the values PASS, FAIL, or 
INCOMPLETE. All input fields are copied to the output parameters to be reported with results. 

9.5.12 Site

Site moves the stage to a specified X, Y, Z position relative to its parent alignment/origin. 

Nanoscope Parameters Lists Lists all parameters used to configure the microscope.

Report Output XML File Input file to the stylesheet transformation program.

Stylesheet File Specifies a xls xml transition file.

Formatted Output File Final formatted output file. Does nothing if left blank.

Professor No

Meta Tags

Name <Name>

Notes <Notes>

X X-axis stage location in relative coordinates.

Y Y-axis stage location in relative coordinates.

Z Z-axis stage location in relative coordinates.

Speed Speed at which the stage should move in percent of maximum speed.

Professor Yes

Meta Tags

X <LocX>

Y <LocY>

Z <LocZ>

Speed <Speed>
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9.5.13 Site Order

Site Order uses a comma separated values (CSV) file to re-order the sites at run-time. Sites to be re-
ordered need to be child nodes of this node. 

CSV File Name Path and name of the CSV file.

Number of Columns Specifies the number of columns in the CSV files. The CSV file may contain more col-
umns than are used by the re-order operation. The unused columns will be ignored.

Site Reference Column Specifies which column (1...N) in the CSV file will be used to reference the subsequent 
child site nodes. The data in the column may be a site number (By Index) or contain a case 
sensitive name field value (of the referred site) (By Name). See Site Reference Type, 
below.

Sort Weight Column Specifies which column (1...N) in the CSV file will be used to weight the resulting sort 
order of the sites. This field may contain the resulting site index itself, a calculated float-
ing point value or a percentage.

Image Name Column Specifies which column (1...N) in the CSV file will be used to re-name sub-sequent Image 
capture file names for each site. If data in the specified column is null, an empty string or 
does not exist, this image re-name feature will be ignored. All child capture images will 
be renamed.

Site Reference Type Specifies whether sites in the SITE REFERENCE COLUMN will be referenced by their 
index or by their name field value.

Sort Direction Used to change the direction of the resulting site sort order.

Professor No

Meta Tags

CSV File Name <FileName>

Number of Columns <NumColumns>

Site Reference Column <SiteReferenceColumn>

Sort Weight Column <SortWeightColumn>

Image Name Column <ImageColumn>

Site Reference Type <SiteReferenceOption>

Sort Direction <SortOption>
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9.6 Example 1: Teach and Run a Basic Recipe

9.6.1 Teach a Real-time Recipe

1. Create a basic outline of the recipe.

a. Start the Recipe view by clicking TOOLS > RECIPES in the NanoScope toolbar. See 
Figure 9.6a.

Figure 9.6a   Start Recipes

b. Add a Real-time step using one of the following methods:

• Right-click on MY RECIPE in the Recipes window and click NEW > REAL-TIME.

Or

• Click EDIT > NEW > REAL-TIME.

c. Add an Alignment/Origin step using one of the following methods:

• Right-click on REAL-TIME in the Recipes window and click NEW > ALIGNMENT/
ORIGIN.

Or

• Click EDIT > NEW > ALIGNMENT/ORIGIN.

d. Add an Autotune step using one of the following methods:

• Right-click on ALIGNMENT/ORIGIN in the Recipes window and click NEW > 
AUTOTUNE.
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Or

• Click on ALIGNMENT/ORIGIN and then click EDIT > NEW > AUTOTUNE.

e. Add a Site step using one of the following methods:

• Right-click on ALIGNMENT/ORIGIN in the Recipes window and click NEW > SITE.

Or

• Click on ALIGNMENT/ORIGIN and then click EDIT > NEW > SITE.

f. Add a Measurement step using one of the following methods:

• Right-click on SITE in the Recipes window and click NEW > MEASUREMENT.

Or

• Click on SITE and then click EDIT > NEW > MEASUREMENT.

g. Add a Capture Image step using one of the following methods:

• Right-click on MEASUREMENT in the Recipes window and click NEW > CAPTURE 
IMAGE.

Or

• Click on MEASUREMENT and then click EDIT > NEW > IMAGE CAPTURE.

h. Select FILE > SAVE Recipe AS D:\RECIPES\EXAMPLE1.RCX. See in Figure 9.6b.

Figure 9.6b   Example 1, Basic Outline
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2. Teach Alignment

a. Open the Alignment PROFESSOR using one of the following methods:

• Right-click on ALIGNMENT/ORIGIN in the Example1.rcx window and click 
PROFESSOR.

Or

• Click on ALIGNMENT/ORIGIN and then click the QUICK LINKS: PROFESSOR 
button.

b. Enter the relative stage speed and click NEXT.

c. Select the LEAVE STAGE IN CURRENT LOCATION radio button. Click NEXT.

d. Select the ORIGIN ONLY radio button. Click NEXT.

e. Using the Align window, shown in Figure 9.6c, focus the optics on the tip and click 
NEXT when you are done.

Figure 9.6c   Align Window
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f. Using the NAVIGATE buttons, shown in Figure 9.6d, move the stage to the desired 
origin. Click NEXT.

Figure 9.6d    Navigate Window

g. Click FINISH.

3. Set Auto Tune parameters.

a. Click the Auto Tune step.

b. Set the following properties (TESP probe, for example) in the Properties panel:

• START FREQUENCY: 0 KHZ.

• END FREQUENCY: 400 KHZ.

• TARGET AMPLITUDE: 500 MV.

• PEAK OFFSET: 5.00%.

• MINIMUM Q: 0.
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c. SAVE the RECIPE.

4. Teach Site 1.

a. Open the Site 1 PROFESSOR using one of the following methods:

• Right-click on SITE 1 in the Example1.rcx window and click PROFESSOR.

Or

• Click on SITE 1 and then click the QUICK LINKS: PROFESSOR button.

b. Enter the relative stage speed and click NEXT.

c. Select the LEAVE STAGE IN CURRENT LOCATION radio button. Click NEXT.

d. Using the NAVIGATE buttons, shown in Figure 9.6c, move the stage to the desired 
position. Click NEXT.

e. Click FINISH.

5. Set the Measurement parameters.

a. Open the Measurement PROFESSOR using one of the following methods:

• Right-click on MEASUREMENT in the Example1.rcx window and click 
PROFESSOR.

Or

• Click on MEASUREMENT and then click the QUICK LINKS: PROFESSOR button.

b. Select the LEAVE SYSTEM IN CURRENT STATE radio button. Click NEXT.

c. Configure the scan parameters in the Scan Parameters window.

d. Click FINISH.

e. Verify the parameters in the Properties list in the Professor.

6. Set the Capture Image parameters.

a. Click the Capture Image step.

b. Set the following properties:

• Give a Capture File Name including an appropriate three digit extension. E.g. 
SITE1IMAGE.000.

• Select YES for OVERWRITE EXISTING FILE.
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• AUTO FILE EXPORT: DISABLED.

c. SAVE the RECIPE.

7. Set the default folders:

a. Click the My Recipe step.

b. Set the following properties:

• Capture Directory D:\RECIPES\EXAMPLE1.

• Report Directory D:\RECIPES\EXAMPLE1.

c. Select FILE > SAVE RECIPE.

9.6.2 Run the Real-time Recipe

1. Click LAUNCH > RUN CURRENT to open the Recipe Runner window, shown in Figure 9.6e.

Figure 9.6e   Recipe Runner Window

Run

Pause

Stop

Slider control

Highlighted step
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2.  Click the RUN icon  in the Recipe Runner window to start running the recipe.

3. You may start at any step in the recipe by highlighting (clicking on) that step and clicking 
RUN.

9.6.3 Add an Additional Site

1. Add an additional Site step by cloning Site 1:

• Right-click on the SITE 1 step and click COPY.

Or

• Click on the SITE 1 step and then clicking the EDIT > COPY.

Then

• Right-click on the ALIGNMENT/ORIGIN step and click PASTE.

Or

• Click on the ALIGNMENT/ORIGIN step and then clicking the EDIT > PASTE.

2. Change the settings for the cloned site:

a. Enter SITE 2 for NAME.

b. Open the PROFESSOR.

c. Navigate to the desired Site 2 location.

d. FINISH.

3. Repeat Step 5 and Step 6 in Teach a Real-time Recipe: Section 9.6.1, if necessary.

4. Select FILE > SAVE RECIPE.

9.6.4 Teach an Offline Recipe

1. Create a basic outline of the offline recipe.

a. Add an Image Set step using one of the following methods:

• Right-click on MY RECIPE in the Example1.rcx window and click NEW > IMAGE 
SET (OFFLINE).

Or
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• Click on MY RECIPE and then click EDIT > NEW > IMAGE SET (OFFLINE).

b. Add a Flatten step using one of the following methods:

• Right-click on IMAGE SET 1 in the Example1.rcx window and click NEW > IMAGE 
ANALYSIS > FLATTEN.

Or

• Click on IMAGE SET 1 then click EDIT > NEW > IMAGE ANALYSIS > FLATTEN.

c. Add a Roughness step as a child of the Flatten step using one of the following 
methods:

• Right-click on FLATTEN in the Example1.rcx window and click NEW > IMAGE 
ANALYSIS > ROUGHNESS.

Or

• Click on FLATTEN then click EDIT > NEW > IMAGE ANALYSIS > ROUGHNESS.

d. Add a Report step as a child of the MY RECIPE step using one of the following 
methods:

• Right-click on MY RECIPE in the Example1.rcx window and click NEW > 
REPORT.

Or

• Click on MY RECIPE and then click EDIT > NEW > REPORT.

2. Create the Image List.

a. Select Site1Image.000 in the D:\Recipes directory to add it to the Image List. See Figure 
9.6f.

b. Place the cursor at the end of this and add “, D:\Recipes\Example1\Site2Image.000” 
manually into the Image List textbox because this image does not yet exist and cannot 
be selected from D:\Recipes. The Image List will now read 
“D:\Recipes\Example1\Site1Image.000, D:Recipes\Example1\Site2Image.000.”
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Figure 9.6f   Add Files to the Image List

3. Configure the FLATTEN step.

a. Open the Flatten PROFESSOR using one of the following methods:

• Right-click on FLATTEN in the Example1.rcx window and click PROFESSOR.

Or

• Click on FLATTEN and then click the QUICK LINKS: PROFESSOR button.

b. Make appropriate changes to the input parameters in the Flatten analysis window. 

c. Click NEXT.

d. Click FINISH.

4. Configure the ROUGHNESS step.

a. Open the Roughness PROFESSOR using one of the following methods:

• Right-click on ROUGHNESS in the Example1.rcx window and click PROFESSOR.

Or
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• Click on ROUGHNESS and then click the QUICK LINKS: PROFESSOR button.

b. Make appropriate changes to the input parameters in the Roughness analysis window. 
See Roughness:  Section 6.3 for details.

c. Click NEXT.

d. Click FINISH.

5. Configure the REPORT step.

a. Set the following properties:

• Name: REPORT1.

• Report Output XML File: D:\RECIPES\REPORT1.

6. Select FILE > SAVE RECIPE.
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Appendix A  File Formats
This appendix details file format information for NanoScope software Version 7.20. Customers often 
upgrade to newer software, therefore, this appendix also includes compatibility and conversion information 
for earlier software versions.

Note: For details on earlier file format information, refer to Support Note 330 File Formats.

This appendix includes the following information:

• Overview: Section A.1

• File Compatibility: Section A.2

• Data File Organization: Section A.3

• Converting Data: Section A.4

• Converting Raw Data: Section A.5

• Electrochemistry: Section A.6

• General Format for CIAO Parameter Objects: Section A.7

CAUTION: Before attempting data extraction on files, always make backup 
copies of the originals. If files become damaged due to loss of data, 
they may be irrecoverable.

ATTENTION: Toujours effectuer une copie des fichiers originaux avant d’en 
extraire des données. Si la perte de données endommageait des 
fichiers, ceux-ci pourraient être irrécupérables.

VORSICHT: Machen Sie bitte immer Backup-Files Ihrer Originaldaten, ehe Sie 
versuchen, Datenfiles selbst zu bearbeiten. Wenn Files durch 
Datenverlust beschädigt werden, könnten die Daten 
unwiederbringlich verloren sein.
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A.1 Overview

File formats in the NanoScope software are of concern to users for at least two reasons:

• Compatibility—Processing older files using newer NanoScope software.

• Converting file data—Exporting data into third-party applications such as spreadsheets 
and statistical packages to evaluate data in unique ways.

The ability to extract data from files is for the purpose of applying third-party software packages and 
analyzing data in other formats. This may include displaying data in spreadsheets (e.g., Excel), statistical 
packages and expert systems. Typically, you extract data from the image files, then filter the data according 
to the requirements of their software. This section discusses how data files are organized to assist in 
extracting the file data.

A.2 File Compatibility

Bruker updates file formatting to ensure cross-compatibility of files between different versions of the 
NanoScope software. There are some exceptions.

Most NanoScope software can open files created by earlier versions of NanoScope software. Conversely, 
image files captured and saved by an earlier version of NanoScope software should open on any later 
version of NanoScope software. However, once the files are open and re-saved by a newer version, they are 
no longer usable in older versions of NanoScope software.

IMPORTANT!:       To analyze old files using newer software versions and then to 
return the files to the older software version, make backup copies 
of the files with the old software BEFORE loading them into the 
newer software.

IMPORTANT!:       Les Utilisateurs désirant analyser d’anciens fichiers en utilisant 
une nouvelle version de logiciel, et désirant également les retraiter 
par la suite dans l’ancienne version, doivent effectuer des copies 
(backup) de leurs fichiers AVANT de les charger dans la nouvelle 
version.

WICHTIG!:             Anwender, die alte Datenfiles mit neuerer Software analysieren 
und später die Files wieder mit der alten Software einlesen wollen, 
sollten Backup-Kopien ihrer Files mit der alten Softwareversion 
machen, EHE sie diese mit der neuen Software laden.
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A.3 Data File Organization

Images which are captured by the user are immediately stored in the NanoScope’s capture directory as binary 
files. Depending upon the Number of samples taken, files will vary in size from about 41KB to 52MB per 
channel per image. Regardless of size, all files include: 1) a “header,” containing various parameter settings 
used during the capture of the original image, a Ctrl-Z character to signal the end of the header, and 

“padding,” comprised of random data; and, 2) data, stored two bytes (216) per pixel (2’s complement).

File organization includes the following:

• Header Files: Section A.3.1

• Parameters: Section A.3.2

• Control-Z (Ctrl-Z) Character: Section A.3.3

• Padding: Section A.3.4

• Raw Data: Section A.3.5

A.3.1 Header Files

The first portion of every image file contains a header file. The header file tells the software about the data 
which follows. The header file size depends upon the number of parameters used at the time that data is 
captured. Depending upon the type of file saved and the version of NanoScope software used when saving the 
file, the header may contain more than 2,000 parameters.

Each header is divided into separate lists (beginning with the characters \*). Users typically, manipulate only 
a few of the parameters for each application. See the Parameters section for a few of the most important 
parameters and characters.

The header is also crucial to interpreting the data. The header information provides crucial parameter and 
setting information for converting ASCII file data. The end of the header file reveals where the actual data 
begins. Figure A.3a shows the size and relationship of the data file formats.

Figure A.3a   Single and Two-Image Data File Structure

Two-Image Files

Files with two or more images contain separate parameter lists and image data. Figure A.3b illustrates data 
organization of a two-image files.

Parameters (Image #1)

“Ctrl-Z” Image data (#1)

Padding data

TWO-IMAGE DATA FILE

Header (variable length)

Parameters

“Ctrl-Z”

Image dataPadding data

SINGLE IMAGE DATA FILE

Header (variable length)

Parameters (Image #2)

Image data (#2)
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Figure A.3b    Example of a Two-image Header File 

\*File list
\Version: 0x7100000
\Date: 10:43:31 PM Tue Feb 14 2006
\Start Context OL2BIG
\Data length: 40960

\*Equipment list

\*Scanner list

\*Ciao scan list

\*Fast scan list

\*HSDC scan list

\*Ciao image list
\Data offset: 40960
\Data length: 52428800

\*Ciao image list
\Data offset: 52469760
\Data length: 52428800

^Z

D3F87F311F35E22CE9F55A8D9AE4B74
E9F55A8D6B4B7D111F35E22C297BA3F8
9AE4B74D3F87F31297BA3F81F35E22C

1F35E22C297BA3F89AE4B74D3F87F31
E9F55A8D6B4B7D111F35E22C297BA3F8
D3F87F311F35E22CE9F55A8D9AE4B74

9AE4B74D3F87F31297BA3F81F35E22C
1F35E22C297BA3F89AE4B74D3F87F31
E9F55A8D6B4B7D111F35E22C297BA3F8

Image file 

(common to 

Image #1 

Image #2 

1

2

3

4 Control-Z

Padding data5 (random)

Image #1 data6

Image #2 data7

parameters

both images)

parameters

parameters

Section
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Analysis of the Two-Image Header File

• Section 1 includes parameters common to both images (only a few are shown here). The 
parameters are included within various lists beginning with \*. The type of image and the 
NanoScope software version also affect the lists and parameters. For example, the \Data 
length parameter in the \*File list of this section is generally 40K and includes the entire 
header.

• Section 2 contains parameters which are specific to image #1. In this example, only two are 
shown; however, there may be dozens. The \Data offset parameter is very important because 
it indicates the Nth byte where data for image #1 begins (here, it is 40960). The \Data length 
parameter indicates the length of data for image #1 in bytes (here, it is 52428800). By adding 
the \Data offset and \Data length together, the data offset for image #2 is found.

• Section 3 contains parameters which are specific to image #2. The \Data offset parameter 
here indicates that data for image #2 begins at byte 52469760 and is 52428800 bytes in 
length.

• Section 4 is a Ctrl-Z character which denotes the end of parameter lists.

• Section 5 contains random padding data. This is added to the header to make it a 
predetermined length (specified in the first \Data length parameter at the start of the header) 
and is used to read the file into NanoScope software. Image files containing multiple images 
will have less padding than files containing only one image.

• Section 6 contains image data specific to image #1. In this example, it begins at byte 40960 
and is 52428800 bytes in length. Depending upon whether the image was captured at 128, 
256, 512... samples per scan line, the length of data will vary.

• Section 7 contains image data specific to image #2. In this example, it begins at byte 
52469760 and is 52428800 bytes in length. The last data value in this section of the file 
denotes the end of the file.

A.3.2 Parameters

\* File List—Denotes the beginning of several parameter lists. For example, \*Ciao Image list, 
\*Equipment list, etc. Each image in the file has its own image list (e.g., \*Ciao image list).

\Version—Describes the version of software used.

\Data length—Length of header, Ctrl-Z character and padding in bytes.

\Samples/line—Number of pixels per scan line. This is the same as the Number of samples value on the 
Real-time / Scan Controls panel.

\Scan size—Height and width of the square scan area in nanometers.

\Z atten—Z-axis attenuation value. The total Z-axis range of data may be calculated from this number as 
follows:

Total Z-axis range
Z atten value

65,536
------------------------------- 440=
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The Z attenuation value is divided by 65,536 (steps of resolution for Z scanner piezo), then multiplied times 
the Z-axis scanner voltage range (± 220 Volts) to yield the total Z-axis range of data.

\Data offset—Nth byte in the image file where raw data commences.

\Data length—Length of raw data stream in bytes. Divide this value by 2 to obtain the total number of 
pixels in the image.

\Z scale—Factor used to convert data to indicated units. E.g., for \Z scale: 20000 nm,

\Z sensitivity—Z-axis scanner sensitivity in nanometers per volt. To obtain the maximum Z-axis scanner 
travel, multiply this value by 440.

\Z scale magnify—Multiplier applied to Z-axis height data to render a NanoScope image on the display 
screen. For example, a value of 1.0 would render data on the display screen at the same scale as actual 
features. This value is generally of no use outside the NanoScope software environment.

A.3.3 Control-Z (Ctrl-Z) Character

A Ctrl-Z (ASCII value 26) character is used to show the end of the parameter lists and the beginning of 
padding. Users wishing to organize their data for spreadsheets may search for this character to locate the end 
of the parameter lists.

A.3.4 Padding

After the Ctrl-Z character, a quantity of random data—”padding”—is inserted into the file to make the 
header a fixed length specified in the first \Data length parameter at the start of the header. Padding 
contains no information, and exists only to accommodate various lengths of parameter lists for different 
image files.

A.3.5 Raw Data

Comprising the bulk of every image file is the raw data of the image itself. At the time of Capture, image 
data is stored 16-bits per pixel in the capture directory on the computer’s hard drive. (Data is stored in 2’s 
complement, LSB). The 16 bits accorded each pixel allows a 32K Z-axis resolution.

data (nm)
pixel value

65,536
-------------------------- 20000=
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A.4 Converting Data

Refer to the following sections for preparing file data:

• Preparing Data for Spreadsheets (Summary): Section A.4.1 on Page 427

• Preparing Data for Image Processing (Summary): Section A.4.2 on Page 427

• Converting Data Files into ASCII: Section A.4.3 on Page 427

A.4.1 Preparing Data for Spreadsheets (Summary)

You may load data files into third-party, spreadsheet software (e.g., Excel, Igor Pro, Mathematica, etc.). To 
convert data in to a spreadsheet program, complete the following:

1. Convert the data into ASCII format—for example, by using the File > Export > ASCII command. 
(NOTE: This may increase the size of the file substantially.)

2. Select desired settings (see Converting Data Files into ASCII: Section A.4.3 on Page 427), then 
SAVE.

3. Load the file into a suitable editor where it may be prepared for third-party applications.

4. Load the raw data into the third-party software program and, if needed, condition the data 
according to important header parameters and requirements of third-party software application(s).

5. Analyze or modify the conditioned data as required.

A.4.2 Preparing Data for Image Processing (Summary)

You may convert data files into third-party, image processing software (e.g., Photoshop, CorelDraw). To 
convert the data into image processing software, complete the following:

1. Convert the data into TIFF format—for example, by right-clicking on the image thumbnail in the 
Browse window and selecting EXPORT > TIFF > 8-BIT COLOR, 8-BIT GRAY SCALE or 16-BIT 
GRAY SCALE.

2. Load the TIFF file directly into the third-party, image processing software.

3. Process the image file. This may include cropping the image, filtering the image, adjusting 
contrast, brightness, color, etc.

A.4.3 Converting Data Files into ASCII

When NanoScope image files are captured and stored, they are in 2-byte, binary (LSB—least significant bit) 
form. Although some programs import raw, binary files, most users find they must convert the files into 
ASCII form first to use them. The converted file allows users to read the header information directly and 
works with many third-party programs requiring ASCII formatting. (Some users prefer to download the 
original, raw binary files into their third-party program, while using their ASCII version of the file as a guide 
map.)
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Note: Depending upon the software version used during capture of the image data, the actual file 
format and file size varies. Headers may include more than 2000 parameters, followed by Ctrl-
Z, data padding, and raw data.

Convert captured data in to ASCII format by using the File > Export menu command. To convert files, 
complete the following:

1. Make a backup copy of the file to be converted and save it to a safeguarded archive.

2. Select a directory, then an image file within it, from the file browsing window at the right of the 
NanoScope main window. Right-click in the thumbnail image to open the menu shown in Figure 
A.4a.

Figure A.4a  The ASCII Export Command

3. Click Export > ASCII to open the Export dialog box (see Figure A.4b).

4. Select the data CHANNELs to be exported.

5. Choose the COLUMN format.
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Figure A.4b    The File Export Dialog Box

6. Select the units (nm, V, Deg...) in which to record the data in the new file by checking the 
appropriate boxes. Export the image header, ramp, or time information by selecting those check 
boxes.

Note: In order to convert the ASCII data from binary (LSB) data to useful values (Phase, Frequency, 
Current, etc.), you must save the information in the header.

7. Click Save As..., designate a directory path and filename, and click Save.
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A.5 Converting Raw Data

Before bringing raw data into a third-party application, the user can first convert the data.

Usually, this means simply multiplying all values by a constant to convert them into common measuring 
units. Once converted, the data becomes more meaningful to analyze.

By using parameters in the header, it is possible to convert and analyze data for various purposes. Users 
need only understand how parameters are related to extract the maximum amount of information from their 
files. In the raw data information, each numeric value is relative horizontally and vertically. 

A.5.1 Data Organization

Data is row-ordered starting at the lower left corner. See Figure A.5a.

Figure A.5a   Exported image data organization

A.5.2 Calculating Scaling Values

In order to calculate height data from LSB form (no longer necessary if you export the data in DISPLAY 
Units — see ASCII Export: Section 2.5.6 on Page 60), convert it by using the Z scale value. Recall that 
raw data recorded from each scan is scaled to the maximum resolution of the Z-axis scanner (± 32,768). 
Whether features are related in terms of “height” or “depth” is irrelevant. What matters most is that features 
be accurately represented in meaningful units.

To convert raw data into metric units, use the following relation:

Note: The Z scale value in a parameter list includes the value and the units (for example, \Z scale: 
1.57541 m). In this example, the units of measure are in microns (m).

Calculating X and Y Pixel Width from Raw Data

To obtain the X axis pixel width, use the following relation:

Z height
data point value  Z scale  Sens. Z scan 

216
----------------------------------------------------------------------------------------------------- =

X
Scan size

Samples/line  1–
--------------------------------------------=
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To obtain the Y axis pixel width, use the following relation:

A.5.3 Calculating Raw Data Values

This section details equations to calculate values for analysis (e.g., amplitude, phase, etc.).

Note:  Only one set of values may be found for each Z scale. That is, the Zscale units are different for 
each type of image (Hz for Frequency, or nA for Current), and the Zscale for a Height image (for 
example) may not be used to find values for Phase. 

The equations for converting the LSB data points into various values are as follows:

Height 

Phase:

Frequency

Potential 

Current (nA)

Amplitude (nm)

For LFM Aux data, the torsional deflection of the cantilever in volts (or whatever else, depending, on the 
definition of the input sensitivity) can be calculated by applying the following formula to each point in the 
data file: 

In this formula, the parameter Aux A and In sensitivity aux A can be substituted with the corresponding 
parameters for Aux B, Aux C, and Aux D. In order to get the In sensitivity aux (A,B,C,D) parameters to 

Y
Scan size

Number of Lines  1–
------------------------------------------------------=

Height
data point

65536
------------------------ Z scale height value=

Phase Data point
65536

--------------------------- 
  Z scale phase 180

65536
---------------- 
 ¥¥=

Frequency
Data point

65536
------------------------- 
  Z scale freq

25e
6

2
32

-----------
 
 
 

=

Potential
Data point

65536
------------------------- 
  Z scale pot

2 In 2 max
65536

---------------------------- 
 =

Current
Data point

65536
------------------------- 
  Z scale amplitude

2 In 1 max
65536

---------------------------- 
  In sensitivity=

Amplitude
Data point

65536
------------------------- 
  Z scale amplitude

2 In 1 max
65536

---------------------------- 
  In sensitivity

Detect sens
------------------------------ 
 =

Deflection
Data point

65536
------------------------- 
  Z scale Aux A

2 In 2 max
65536

---------------------------- 
  In sensitivity Aux A=
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appear in the header, you must select Tools > Calibrate > Detector, highlight the parameter, and then press 
enter.

A.5.4 Force Curve File Format Information

When exporting the force curve in ASCII format, it is recommended that the file be exported twice, once 
with the header and once without. The one without the header should be exported in Spreadsheet format 
(comma delineated).

When you import the file without the header into MS Excel each value should come up as a separate entry. 
\Samps/line in the \*Ciao force list displays the number of samples in the retract curve 
followed by the number of samples in the extend curve. \Data length is the number of samples/line *2 
(2 bytes/point) *2 (extend + retract). The scan size in Z is calculated by looking at the \Z Scan size 
value in the \*Ciao force list in the header and the Sens. ZSens in the \*Scanner list. 
Then do the following calculation.

In the header, find the line “\*Ciao force list” and “\Scan Size”. The Scan Size is in 16-bit 
values. Convert to nm by:

In some cases it may be necessary to calculate the force to determine the vertical (Deflection) axis of a 
curve. The following calculation may be used, as long as the microscope is in ContactMode and Input 
Atten is set to 1x.

Note that the above equation only works when calculating force vs. separation. When calculating force vs. 
Z, Z magnify force must be removed from the calculation. When calculating deflection vs. Z, the spring 
constant must also be removed from the calculation. 

When interested only in the deflection of the curve, the calculation below will suffice. Divide by the number 
of samples to get the Z step per data point. This value is also found in the “\*Ciao force image 
list” near the header end. 

Force Data Organization

In later versions, the data changes and is opposite from previous versions of software. For example, the first 
n samples of data includes the Extend curve from the closest approach to the farthest distance. The next n 
data points are the Retract curve data from the closest to farthest distance.

Converting the Force Data to Volts

The actual data is again in 16-bit values for the input signal. Convert to volts by:

Size (nm)
Z Scan size Sens. Zsens

Number of Data points 1– 
----------------------------------------------------------------------=

Value (nm) data point (LSB) Sens. DeflSens Z scale  =

Value (V)
Value (LSB)

65536
------------------------------ (Full Volt Range)=
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The volt range is 20V for Contact Mode when In Atten is 8X. Its 2.5 for 1X In Atten. If you are in 
TappingMode looking at deflection (normal mode using Nanoindentation), it's 5V (see the table below).  

The Detector Sensitivity is under the “\Ciao scan list”, as “\DeflSens” in units of .

Force Curve File Format

To find the Z scan size and steps, refer to the Sample Parameter List for an Image File, Figure A.7a and 
complete the following:

1. Under \*Ciao Force List are the parameters that describe Z:
\@Z scan start: (last number is in volts)
\@Z scan size: (last number is also in volts)

You can convert using the \@Sens. Zscan: which shows the value and units (typically 12.5 nm/V) under 
the \*Scanner list line.

2. Find the number of pixels/line of data is under the \*Ciao force image list (usually last) as:
\Samps/line: nnn [where nnn is the number of pixels in each direction]

Also in the \*Ciao section is the Data Type:
\@4: Image Data: S [data type] “data description”

Data type is usually Deflection or Amplitude and can be “Deflection”, “TM Deflect.” or 
“Amplitude”.

A.5.5 Force Volume File Format Information

The curve data should be right after the image height data. The curve data is the data collected at each Z point 
as in a normal single force curve file. If deflection, volts is given by:

Using the value for deflection in volts (V), it is possible to calculate the deflection in nanometers (nm) using 
the equation:

The way force volume works, it gets tricky to figure which image pixel corresponds to which force curve 
data. The data and force curve are in the same order: bottom to top, left to right. There are three pixel numbers 
that are needed:

• Under “\*[NC]AFM” image list, “\Samps/line” gives the number of image pixels/
line, 128, 256, 512...

Microscope Mode InAtten / Deflection Volt Range

Contact mode 8X 10V

Contact mode 1X 1.25V

TappingMode (normal mode) 5V

V of detector
nm of Z

-------------------------------

Deflection (V)
Data point (LSB)

65536(LSB)
------------------------------------------ 10(V)

Input atten (1 or 8)
---------------------------------------------=

Defl (nm)
Deflection (V)

Detector Sensitivity (V/nm)
-------------------------------------------------------------------=
Rev. D NanoScope Software 8.10 User Guide 433



File Formats
Electrochemistry
• Under “\*Force” image list, “\Samps/line: n m”, where n is the number of 
samples per Force line.

• Under “\*Force cal.” list is the “\force/line: n m” parameter, where n is the 
number of force curves / image line.

Consider a square block of pixels that represents one force curve. Including the data in the bottom left 
corner, a simple analysis allows the identification of which pixel corresponds to which curve. If the number 
of samples/force line is 128 and the number of force curves/image data is 32 and there are 256 pixels/image 
data, then there is a curve every 256/32 or 8 pixels. The next image data line with force curves is the 8th one 
from that line. Since there are 128 samples/force curve, they are 256 pixels or 512 bytes each. Thus, the first 
image pixel matches the first force curve, the 8th pixel matches the second force curve 512 bytes later, etc.

Even though there are 3 data displays during Force Volume (Image, Force plot and FV Image), the FV 
image is NOT SAVED. It is calculated during both the Real-time and Off-line display from the force curve 
data as described above.

A.6 Electrochemistry

A.6.1 EC File Format

The EC file format is:

1. Header: ASCII plus padding to make it 40960 bytes long. Data offset and length of each segment 
are specified. Image parameters are also recorded.

2. Image data body, 2 bytes/datapoint.

3. EC data: Potential vs. Time, 2 bytes/datapoint.

4. EC data: Current vs. Time, 2 bytes/datapoint.

A.6.2 Data Conversion

Potential

Current

Potential Sensitivity and Current Sensitivity can be found in the header file as EPotSens and ICellSens 
respectively. For example:

\@Sens. EPotSens: V 1.000000 V/V

\@Sens. ICellSens: V 100.0000 ~A/V

Potential
data point

65536
------------------------ 20  Potential Sensivity value=

Current
data point

65536
------------------------ 20 Current Sensivity value=
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A.7 General Format for CIAO Parameter Objects

In the file header some parameters start with '\@' instead of simply '\'. This is an indication to the software 
that the data that follows is intended for a CIAO parameter object. After the '@', you might see a number 
followed by a colon before the label. This number is what we call a “group number” and can generally be 
ignored.

Further, after the label and its colon, you will see a single definition character of 'V', 'C', or 'S'.

• V means Value – a parameter that contains a double and a unit of measure, and some scaling 
definitions.

• C means Scale – a parameter that is simply a scaled version of another.

• S means Select – a parameter that describes some selection that has been made.

A.7.1 Value Parameters

The Value (identified by the letter “V”) parameters have the following format:
 [soft-scale] (hard-scale) hard-value.

Example 1: Value parameter format 

LSB

Since the NanoScope is a digital device, all data is numeric. We call this number in its rawest form a LSB 
(i.e., scaling values on ADCs and DACs as Volts per Least-Significant-Bit). The LSB is the digital 
representation of volts or frequency and is a 16 bit integer.

Hard value

The hard value is the analog representation of a measurement. It is simply the value read on the parameter 
panel when you set the Units: to Volts. The hard-value is the value you would read with a voltmeter inside of 
the NanoScope electronics or inside the head. This value is always in volts with the exception of the Drive 
Frequency (which is in Hertz) and some STM parameters (which are in Amps).

A value parameter might be missing a soft-scale or a hard-scale, but must always have a hard-value.

Hard Scale

The hard scale is the conversion factor we use to convert LSBs into hard values. We use the prefix “hard-” in 
hard-scale and hard-value because these numbers are typically defined by the hardware itself and are not 
changeable by the user.

\@1:Z limit: V [Sens. Zsens] (0.006714 V/LSB) 440.0 V

CIAO Parameter Indicator

“Group” Number
(usually ignored)

Parameter Parameter Type

Soft-Scale

Hard-Scale

Hard-Value
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Soft Value

A soft-value is what the user sees on the screen when the Units: are set to Metric.

Soft Scale

The soft-scale is what we use to convert a hard-value into a soft-value. Soft-scales are user defined, or are 
calibration numbers that the user divines. Soft-scales in the parameters are typically not written out — 
rather, another tag appears between the brackets, like [Sens. Zsens]. In that case, you look elsewhere in the 
parameter list for tag and use that parameter's hard-value for the soft-scale.

Note: The name of a soft scale can change from one microscope, controller or software version to the 
next. A common problem occurs when users create programs that look for the soft scale 
directly instead of parsing the value parameter to find the name of the soft scale that must be 
used.

A.7.2 Scale Parameters

The Scale parameters (identified by the letter “C”) have the following format:
 [soft-scale] hard-value.

Example 2: Scale parameter format

• The hard-value is almost always a scalar value.

• The soft-scale always points to another parameter – this parameter is the target of the scaling 
action.

• Most often used for the Z magnify parm to allow user to change scaling of Z scale in Off-
line without actually affecting the real data in the file.

A.7.3 Select Parameters

The Select parameters (identified by the letter “S”) have the following format:
 [Internal-designation for selection] “external-designation for selection”

\@Z magnify: C [2:Z scale] 0.599

CIAO Parameter Indicator

Parameter Parameter Type

Soft-Scale

Hard-Value
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Example 3: Select parameter format

A.7.4 Procedures to Interpret Data in a Height Image

To find the Z scale conversion factors, refer to Figure A.7a to complete the following calculation:

1. Find the Z scale line. Note that the parameter “Sens. Zsens” appears in brackets and specifies 
the soft scale to the user.

2. Locate the [Sens. Zsens] in the Scanner List.

Figure A.7a   Sample Parameter List for an Image File 

The hard scale (e.g., 0.006713765 V/LSB) is the scale at which the file was originally captured. However, to 
help minimize round off errors in the off-line processing, the software automatically scales the image data to 

\@2:Image Data: S [Height] "Height"

CIAO Parameter Indicator

“Group” Number
(usually ignored)

Parameter Parameter Type

Internal-Designation
for Selection

External-Designation
for Selection

.

.

\*File list

\Version: 0x07200000

\Date: 06:47:11 PM Fri Apr 20 2007

\Start context: OL2BIG

\Data length: 40960                                                                                     

\@Sens. Zsens: V 12.50000 nm/V

.

\*Ciao scan list

\Scan Size: 2000 nm                                                                                   //Scan Size

\X Offset: 0 nm

\Y Offset: 0 nm

\Rotate Ang.: 1.5708

\Samps/line: 512                                                                                          // # Pixels in each image line

\Lines: 512                                                                                                   // # of lines

\Y disable: Enabled

\Aspect Ratio: 1:1

\Bidirectional Scan: Disabled

\Scan line shift: 0

\Scan Rate : 0.498246

\@2:Z scale: V [Sens. Zsens] (0.006713765 V/LSB) 5.344157 V

\@2:Z offset: V [Sens. Zsens] (0.006713765 V/LSB) -21.60000 V

\*Ciao image list
\Data offset: 40960                                                                                      // Offset from file start to binary data for this channel 
\Data length: 524288                                                                                   // Length of data in this image channel
\Bytes/pixel: 2
.
.

.
\@Z magnify: C [2:Z scale] 0.5987848
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the full range of the data word. While the hard value of the Z scale is updated, the hard scale is not. 
Therefore, this hard scale should be ignored and we will calculate a corrected hard scale:

Once we know the corrected hard scale, we can convert the LSBs that represent the data points in the image 
to hard or soft values.

Using these formulas, it is possible to deduce all one might want to know about the data. 

Converting Raw Data into Height 

The raw data in the file is a series of signed 16 bit (2 byte) integers. The numbers in the data file are called 
LSBs (and, for our purposes, assigned a unit of ‘LSB’). In order to convert the raw data in the file, use the 
number from the file and multiply it by both the hard-scale and the soft-scale.

For example, using the above parameter list in Figure A.7a, the corrected hard scale would be: 

Now, if we had a value of 54 in the data file, the result would be: 

Note: The same procedure may be used to calculate frequency, current, potential, amplitude data, etc., 
by using the appropriate Z scale. However, each data set requires a specific Z scale. For 
example, the Z scale for potential may not be used to calculate frequency. 

What is the range of the data in the file?

The range of data in the file may be found by multiplying the hard-value by the soft-scale. Using the hard-
value and soft-scale values from the example above: 

How can I calculate the displayed Z scale for use in my own analysis programs?

Data is expanded in the NanoScope file after capture to prevent round-off in the Off-line calculations. The 
expansion procedure changes the Z scale to correspond with the new scale of the expanded data. Yet, in Off-
line, the software displays the data with the original Z scale used to capture it.

You can use Z magnify to discover the displayed Z scale. The modified Z scale is 67 nm. Z magnify (from 
the Sample Parameter List for an Image File, Figure A.7a) tells us there is a scale of 0.5987848 missing. So 
the data on the screen in the NanoScope off-line is displayed at 40 nm. This trick also works if the user 
changed the displayed Z scale in Offline.

corrected hard scale
hard value

65536
-------------------------=

 hard value LSB corrected hard scale=

soft-value soft-scale hard value=

5.344157V

2
8 2 

--------------------------- 5.344157V
65536

--------------------------- 0.00008154536
V

LSB
-----------= =

54LSB  0.00008154536
V

LSB
----------- 

  12.50
nm
V

-------- 
   0.005504nm=

5.344157V 12.50
nm
V

-------- 66.80nm=
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2.1 List of Color Tables

Table 2.1a display a list of the 26 NanoScope color tables with Contrast = 0 and Offset = 0.

Table 2.1a   NanoScope Color Tables

Color Table ID Colors

0

1

2

3

4

5

6

7

8

9

10
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List of Color Tables

44
11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

Color Table ID Colors
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Color Tables
List of Color Tables
Both Contrast and Offset have a major effect on displayed colors. An example is shown for Color 
Table 12 in Figure 2.1.

Figure 2.1a   Effect of Contrast and Offset on displayed color for Color Table 12
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